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What's New in Tableau Desktop and
Web Authoring

Browse summaries of new features for the current release.

Tableau Desktop Release Notes | Known Issues

New in version 2021.2

Connect to and Prepare Data

« Connect to Datorama and Dremio data with new

partner-built connectors on the next page

Scan entire file to build schema for large

JSON files on the next page

Multiple analytics extensions in a site on page 3

Design Views and Analyze Data

Ask Data now available to Viewers on page 3
Guided search in Ask Data on page 3

Use lenses that customize Ask Data for specific
audiences on page 4

Incorporate Ask Data into dashboards on page 5
Share explanations from Explain Data in published
dashboards on page 5

Display web-based images in dashboards on page 6
Create Show/Hide buttons for any dashboard
object on page 7

New protocols supported for URL actions on page 8
Use animations by default on page 8

New spatial area calculation function on page 8
Layer control panel on page 8
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Tableau Desktop Features Now in Tableau Online and

Tableau Server

Create any action in Tableau Online and Tableau
Server, including URL actions on page 10
Condition and Top/Bottom filters now available on
the web on page 10

Create parameter actions on the web on page 9
Create set actions on the web on page 9

Unique Features in Tableau Online and Tableau Server

Organize items in a collection on page 11

Open and edit workbooks in Tableau Desktop from
the web on page 11

Include a target value for your metric on page 11

Add-ons

Tableau Catalog - part of the Data Management
Add-on on page 12

Connect to and Prepare Data

Connect to Datorama and Dremio data with new partner-built connectors

Tableau Desktop now includes two new partner-built connectors:

« Datorama by Salesforce lets you connect Tableau to your Datorama data.
o Dremio by Dremio lets you connect to your Dremio data.

Scan entire file to build schema for large JSON files

If you have a very large JSON file (more than 10,000 rows), you can now use the new “Scan

Entire Document” option to pre-scan all data and build your schema. The speedier option of

selecting schema levels without pre-scanning is also available.
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Multiple analytics extensions in a site

Beginning with version 2021.2, you can now have multiple analytics extensions connections for
each site. This means that organizations with different language or connection requirements
can use analytics extensions on the same Tableau Server site, with different workbooks using
different connections. For details on using analytics extensions, see Pass Expressions with
Analytics Extensions on page 2690. For more information on configuring analytics
extensions for a site, see Configure Connection with Analytics Extensions (Tableau Online
Help) or Configure Connection with Analytics Extensions (Tableau Server Help).

Note: As of 2021.2, Einstein Discovery analytics extensions are still limited to one per site.

Design Views and Analyze Data

Ask Data now available to Viewers

Users with the Viewer license make up the largest number of people analyzing data with
Tableau, and now they can ask questions of data in an intuitive, search-based style just like
Creators and Explorers. For more information, see Automatically Build Views with Ask
Data on page 1109.

Guided search in Ask Data

Arevamped Ask Data search experience shows relevant fields, values, and synonyms as users
type entries. The process quickly guides users who have little understanding of the data
structure, helping them to easily create effective visualizations.
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B

Recommended Visualizations

v  Basic Data Analysis &

average sales by state
total quantity by region

¥ Date and Time
»  Filters

> Viz Type

Use lenses that customize Ask Data for specific audiences

Most people don’t need information from an entire data source but instead want data
visualizations relevant to their job function, like sales, marketing, or support. To optimize Ask
Data for different audiences like these, Tableau Creators and Explorers now author separate
Ask Data lenses, which query a selected subset of fields. (Previously, only data source owners
were able to curate data for Ask Data.)

For the selected fields, authors can specify synonyms for field names and values, reflecting
terms the lens audience uses in common language (for example, "SF" for "San Francisco").
Lens authors then customize the recommended visualizations that appear below the Ask Data
query box, which provide answers to users with a single click.

Lenses can be accessed from multiple places: the All Lenses page at the top level of a Tableau
site, individual data source pages, and Ask Data objects on dashboards (shown below).

For more information, see Create Lenses that Focus Ask Data for Specific Audiences
on page 1126.
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Fads~ €

average Current Price X by State x
Clear Al
% Nofitters

@ | Search to add fields or filters to the visualization -

£ 2021 Mapbax © OpenStreetMag

sheetl | G

Incorporate Ask Data into dashboards

To quickly get up and running with lenses, Tableau dashboard authors can add the new Ask
Data object. Anyone with access to the workbook and connected data sources will then be able

to interact with data and create visualizations in an easy, search-based style.

Share explanations from Explain Data in published dashboards

Explain Data has a reimagined user interface optimized for a broader audience of business
users. Authors (Creators or Explorers with editing permissions) can now enable Explain Data
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for viewers of dashboards and sheets in published workbooks. Viewers can select a mark of
interest in the view and run Explain Data to explore their data more deeply than before.

Access to Explain Data in viewing mode is not enabled by default, so authors will need to
enable this option. For information on how to enable Explain Data in viewing mode, see
Enable Explain Data in viewing mode in published workbooks and dashboards on
page 2075.
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For more information, see Discover Insights Faster with Explain Data on page 2035, Get
Started with Explain Data on page 2037, and Requirements and Considerations for

Using Explain Data on page 2070.

Display web-based images in dashboards

Image objects can now link to web-based images, as an alternative to images inserted in a
workbook. This is particularly advantageous for large images, which load much more quickly
when hosted on the web. (By contrast, inserted images must be downloaded every time a
sheet is opened, slowing performance.) Linked web images also allow you to use animated
GIFs, which Tableau doesn't natively support.

For more information, see Detailed options for Image objects on page 2745.
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Edit Image Object X

Insert Image File Link to Image

| https.//example.com/uploads/globe_image.png |

Options

Fit Image
|_] Center Image

URL Opened When Image Is Clicked

www.tableau.com

Alt Text

Opens Tableau's website

Create Show/Hide buttons for any dashboard object

Previously, Show/Hide buttons were limited to floating layout containers, but now you can
create them for any dashboard object, floating or tiled. For more information, see Show and
hide objects by clicking a button on page 2747.
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New protocols supported for URL actions

You can now target a wider variety of web content that uses these URL prefixes: news, gopher,
tsc, tsl, sms, tel, and file. For more information, see URL Actions on page 1509.

Use animations by default

In 2020.1, we introduced viz animations to help you see changes and recognize patterns in
your data. When you create workbooks after 2021.2, Tableau enables animations for your
vizzes by default. If you prefer, you can disable animations for a sheet or workbook. For more

information about animations, see Format Animations on page 2887.

New spatial area calculation function

In 2020.2, we're introducing the Spatial Area function. Use the Spatial Area function to find the
area of any polygon in a geographic role. For more information, see Spatial Functions on
page 2245.

Layer control panel

Give users more control of geographic data with the Layer control panel. New to 2021.2, Layer
Control is a panel that expands in the view when selected, displaying all the geographic data
layers, and giving you quick access to each marks layer. For more information, see Create
Geographic Layers for Maps on page 1869.
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Marks Layers Example

Layer Control X

Marks

E [+] Community_Cent
5  [¥] Boston_Buildings...
5 Boston_Neighbor..

- %1+ @ b

Tableau Desktop Features Now in Tableau Online and Tableau

Create parameter actions on the web

You can now create parameter actions in both Tableau Online and Tableau Server. When you
create a parameter action, you customize how data is displayed in your viz. And users can
change a parameter value by interacting directly with your viz. For more information, see
Parameter Actions on page 1516.

Create set actions on the web

You can now create set actions in both Tableau Online and Tableau Server. Use sets to define
a subset of data, and then use set actions to control how members in a set compare to other
data in the view. For more information, see Set Actions on page 1540.
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Create any action in Tableau Online and Tableau Server, including URL
actions

Web-authoring now supports URL actions, with a revised, more intuitive layout of URL Target

and Data Value options. For more information, see URL Actions on page 1509.

With this change, you can now author all of the same actions in Tableau Online, Tableau
Server, and Tableau Desktop!

Condition and Top/Bottom filters now available on the web

Until now, when authoring in Tableau Online or Tableau Server, you could only filter
categorical data by selecting a discrete value or by using a custom value list. But now, as of
21.2, you have more advanced filtering options: Condition and Top/Bottom. The Condition
option allows you to define filtering rules with cutoffs, ranges, and more. The Top/Bottom
option allows you to see only the top (or bottom) N results of a dimension, for instance, the top
100 products sold by a company.

Filter [Product Name] >

> General
~ Condition
() None
(®) By field

Profit - Median A

< ¥ 25,000

» Top/Bottom

Summary

Selection: Selected all values
Wildcard:  All

Condition: MEDIAN([Profit]) = 25000
Limit:  Top 100 by SUM({[Sales])

For more information, see Filter Data from Your Views on page 1411.
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Unique Features in Tableau Online and Tableau Server

Organize items in a collection

Collections are like playlists that let you organize your Tableau content in a way that is
meaningful for you or the people you share the collection with. Create a private collection for
easy access to the workbooks, views, and metrics you need for a particular project. Or create a
collection with onboarding resources and share it with new members of your team. For more

information, see Organize Items in a Collection on page 3199.

Jane Johnson's Collection  # < -

Owner Jane Johnson  Modified May 5, 2021, 2248 PM & Private

Sales information

Select All Content Type:  All v SortBy: Date Added(newest) s ]
* —
o — $56.18K
] & 2 AB746%
° — ® — © ® = 4

Superstore T e Superstore Ty e Sales (Consumer) g e

Open and edit workbooks in Tableau Desktop from the web

Use the new Edit in Tableau Desktop action to open a Tableau Server or Tableau Online
workbook in Tableau Desktop, then publish changes when you're finished. This button lets you
use whichever product works best for your task, and eliminates the need to download a

workbook to open and edit in Tableau Desktop. You can publish your workbook back to Tableau

Server or Tableau Online like usual. For more information, see Edit Tableau Views on the
Web on page 3149.

= Showl

| Open and edit this workbook in Tableau Desktop (Ctrl+0)

Include a target value for your metric

Now, when you create a metric, you can specify a target value to compare your metric against.
You might include a target that represents a threshold to stay above or a goal you’re working
toward. This target value will be used as the basis for the comparison shown below the metric
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value, both on the metric card and on the metric details. For more information, see Create
and Troubleshoot Metrics on page 3152.

Sales &

$24.01K

$1.51K above target
Nov 2021

$30K

$10K

0 \

2018 2019 2020 2021

Add-ons

Tableau Catalog - part of the Data Management Add-on

Add Field Descriptions - You can add descriptions for fields in a published data source that
then display in the Description column on the data source page Lineage tab. You can also see
the description on the Data tab when you build a visualization. For more information, see
Manage Web Content on page 3205.

Data Quality Warning Updates

« Formatted text support for warning messages - When you create or edit a data
quality warning message, you can format the text with bold, underline, and italics, and
include alink or an image. For more information, see "How to set a quality warning" in
the Tableau Server or Tableau Online Help.
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o Message required for warnings - When you create a data quality warning, you're now
required to enter a message to display to users. (This doesn't apply to warnings gen-
erated when you set Tableau to monitor for extract refresh or flow failures.) For more
information, see "How to set a quality warning" in the Tableau Server or Tableau Online
Help.

Inherited descriptions appear in Tableau Desktop - When a description for a field exists
upstream from the field, it now appears in Tableau Desktop with information about where the
description is inherited from. For more information, see Manage Web Content on page 3205.

Full table name appears - The table's full name has been added to the table page.

Filter by tags - You can now filter databases, files, and tables by tags in the Connect To dialog
box.

Filter by embedded or non-embedded - On the External Assets page, you can filter
databases, files, and tables by asset category: embedded or non-embedded.

Features Introduced in Previous Versions of
Tableau Desktop and Web Authoring

Browse summaries of features for previously released versions.

All Tableau Desktop Release Notes | All Known Issues

Added in previous versions

Version 2021.1

Added in version 2020.1

Install and Deploy Tableau Desktop

Tableau Software Version: 2021.2
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« Zero downtime licensing on the facing page
« Amazon Redshift driver no longer installed auto-
matically on the facing page.

Connect to and Prepare Data

o Getweb authoring support from more Tableau con-
nectors

o Use Tableau connectors with Azure Active Directory
authentication

« Snowflake connector supports virtual data warehouses

o New JDBC driver for SAP HANA connector in Windows
has arrived

» Connect to Anaplan data using certificates

Design Views and Analyze Data

« Integrate predictions from Einstein Discovery into
Tableau on page 16

o Add dashboard extensions directly in Tableau on
page 18

» Regularization and augmentation supported in pre-
dictive modeling functions on page 19

» Create Level of Detail expressions more easily
with Quick LODs on page 19

Prepare, Author, and View Data on the Web

o Quickly access assistance for Ask Data on page 20

o Exclude values of specific fields from query inter-
pretations in Ask Data on page 21

« Get notified when animations are paused for a viz
on page 22

« Create, rearrange, and preview device-specific lay-
outs on the web on page 22

« Drag and drop headers on the web on page 23

« See connected metrics on a view on page 23
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Collaborate and Explore on the Web

+ Keep track of your data with notifications on the
web on page 24

Add-ons

« Tableau Catalog updates - part of the Data Man-
agement Add-on on page 24

Install and Deploy Tableau Desktop

Zero downtime licensing

Starting in Tableau version 2021.1, internet-connected Tableau Desktop and Tableau Prep
Builder users no longer have to manually refresh product keys. Licenses are automatically
refreshed without requiring any action as their subscription approaches expiration. For more
information, see Maintain Licenses for Tableau Desktop and Tableau Prep on

page 3339.

Amazon Redshift driver no longer installed automatically

Starting in Tableau version 2021.1, Tableau no longer automatically installs the Amazon
Redshift driver as part of the product install process. If you need this driver, download it from the
Driver Download page.

Connect to and Prepare Data

Get web authoring support from more Tableau connectors
Tableau web authoring support has expanded to include connectivity using these connectors:

o Amazon Athena

o Apache Drill (available for Tableau Server, but not Tableau Online)
o OData

o SharePoint Lists

o Teradata

For a full list of connectors you can use for web authoring in Tableau Online and Tableau
Server, see Creators: Connect to data on the web.
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Use Tableau connectors with Azure Active Directory authentication

Tableau has enhanced these connectors to include support for authentication via Azure Active
Directory:

o Azure Synapse Analytics (See Azure SQL Synapse Analytics.)

o Azure Data Lake Storage Gen2 (New connector! See Azure Data Lake Storage GenZ2.)
o Azure SQL Database (See Azure SQL Database.)

o Databricks (See Databricks.)

Snowflake connector supports virtual data warehouses

Beginning with Tableau 2021.1, Tableau automatically uses your default Snowflake virtual
warehouse if none is specified. When you create a Snowflake data source, Tableau uses your
virtual warehouse. Later, if you publish that data source or a workbook, Tableau uses the
default Snowflake virtual warehouse of the person who accesses it. (For more details, see
Snowflake.)

New JDBC driver for SAP HANA connector in Windows has arrived

The SAP HANA connector now uses JDBC drivers for Mac, Linux, and Windows. The JDBC
driver for Windows is new in Tableau version 2021.1. JDBC drivers for Mac and Linux were
introduced with Tableau version 2020.2.

Connect to Anaplan data using certificates

Beginning in February 2021, you can choose to connect to your Anaplan data with a certificate
and private key. (For more details, see Anaplan.)

Design Views and Analyze Data

Integrate predictions from Einstein Discovery into Tableau

Previously, you could access Einstein Discovery only in Salesforce. But now you can integrate
predictions directly into Tableau views and dashboards using models deployed by Einstein
Discovery in Salesforce to combine powerful predictive and visual analytics. For related
information in Tableau help, see Integrate Einstein Discovery Predictions in Tableau on
page 2671.

For information on required licenses, access, and permissions in Salesforce and Tableau, see
Requirements for access on page 2672.
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For an introduction to Einstein Discovery in Tableau, see the Einstein Discovery in Tableau
page and demo on tableau.com.

Connect Tableau table calculations to Einstein Discovery predictions

Supported in Tableau Desktop, Tableau Online, and Tableau Server

With Tableau connected to the Einstein Discovery analytics extension, you can embed Einstein
Discovery predictions directly in calculated fields. In Salesforce, use Model Manager to auto-
generate a Tableau table calculation script, and then paste that script into a calculated field for

use in a Tableau workbook.

Create Tableau Table Calculation
W Copy to Clipboard

1e colurmn names inside each ATTRI[ ..
(|} 3f the mae

For more information, see Einstein Discovery on page 2693 in Pass Expressions with
Analytics Extensions on page 2690.

Note: To let users see predictions in published table calculations, Tableau Server
administrators need to enable analytics extensions for the site. For more information, see
Configure Connection with Analytics Extensions in Tableau Server help.

Add Einstein Discovery predictions to Tableau dashboards

Supported in Tableau Desktop, Tableau Online, and Tableau Server

With the new Einstein Discovery dashboard extension, as users select marks in a view, they see
dynamic updates to predictions and suggestions to improve predicted outcomes. Authors
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simply drag the Extension object onto the dashboard canvas, select Einstein Discovery from
the extensions gallery, and then configure the extension in Tableau. For more information, see
Explore Predictions in Tableau with the Einstein Discovery Dashboard Extension on

page 2676.

Transport Supplier
OnTime

Cross Europe
Pack & Ship

Transporter service level

Total Trust

Lion One
Delivery

75%

Likelihood of On Time Delivery 864 selected rows

Top Predictors
© 0.88 Weather forecast is Snowy and Delivery point area
is City center (158 rows)

© 0.68 Transporter service level is Priority Mail Express
(256 rows)

Q 0.62 Weather forecast is Sunny and Delivery point area
is City center (144 rows)

How To Improve This
© 5.45 Change Transpoerter service level to Priority Mail
Express (481 rows)

[~] 1 Change Transport Supplier to Unique Logistic
(220 rows)

Add dashboard extensions directly in Tableau

In the past, adding a dashboard extension required you to open a browser and then download
and navigate to a file. But now you can quickly add extensions directly in Tableau. Simply drag
the Extension object into your dashboard, and then search for and select the desired

extension.

For more information, see Use Dashboard Extensions on page 2839.
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Browse Extensions

Gap Analysis a3
by DataMa

Waterfall and funnel analysis, smart bullet points generation, significance calculations, driver
identification...

(O Custom Viz Actions ®  Semiotic Hierarchy B P105
(O Advanced Analytics memn byStarschema
tom Filter Leverage the brilliance of the Semiotic hierarchy chart library, directly within Tableau!
Cus! @
(O Viz Formatting
() Parameter
O NaturalL o q Q, Write Back Extreme P 100
atural Langua, eneration
- guage 4 Emw by AppsorTableau
Features §
Create. Edit and Delete data directly from your Tableau Dashboards in a secure and governed way.
[ Tableau Public
[ Sandboxed
0 Dataiku AutoML Insights 178
[ My Extensions by Dataiku
Train models on the fly to identity patterns. rank variables by importance, and analyze features in
your data.
::EI CodePad <H | 347
Dashboard Extensions are made by Starschema

awailable through the Extension Gallery
which is subject o the Gallery Torms of
Service.

An embedded code editor that allows you to write scripts and create new data analytics
algorithms,

Regularization and augmentation supported in predictive modeling functions

In 2020.3, we introduced the MODEL_QUANTILE and MODEL_PERCENTILE table calculation
functions, which allow you to leverage the power of a statistical engine to build predictive
models. Now in 2021.1, if you're an advanced user, you'll be able to fine-tune your predictions
with two new arguments in your prediction calculations: lambda (or the “regularization
parameter”’) and augmentation. Lambda is a scalar you can use to adjust the regularization
effect on your model. Augmentation allows you to increase the ability of your models to pick up
non-linear patterns.

For more information, see How Predictive Modeling Functions Work in Tableau on
page 2606 and Regularization and Augmentation in Predictive Modeling on page 2659.

Create Level of Detail expressions more easily with Quick LODs

Create Level of Detail expressions directly in the Data pane using drag-and-drop or context
menus. Quick LODs make it easy to bring a calculation from one table to a different level of
detail in another table. Press Ctrl (Windows) or Command (Mac), and then click and drag a
measure onto a dimension to automatically create an LOD expression. For more information,
see Use a Quick LOD expression on page 2452.
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Prepare, Author, and View Data on the Web

Quickly access assistance for Ask Data

When you first navigate to Ask Data, a dialog of helpful tips appears. Data owners see links to
all resources pictured below, including unique ones for setting up data and analyzing usage.
Data consumers see only the links under "Do More" for Help and the product feedback form,
which sends feature requests directly to our development team at Tableau.

20 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help

Ask Data
Answer your data questions as quickly
as you can think of them.

'sum of Sales| by Category  with Order Date in the last quarter |

For Data Owners Do More

@ Setquuu:h‘-éED (&  Online Help

@ Usage Analytics Gty Give Product Feedback

To later access the tips again, simply click the "i" to the left of the Ask Data text box.

Ask Data tips

For more information, see Automatically Build Views with Ask Data on page 1109.

Exclude values of specific fields from query interpretations in Ask Data

To improve the usability of query interpretations in Ask Data, data source owners can exclude
the values of specific fields from indexing. Though Ask Data doesn't add non-indexed values to
query interpretations, the values still appear in visualization results when relevant. For example,
if you don'tindex values from a "Product" field because they add unnecessary detail to query
interpretations, Ask Data can still display values such as "iPhone 12" in resulting data
visualizations.

For more information, see Exclude values of specific fields from search results on
page 1134.
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[T Index field values

Get notified when animations are paused for a viz

If a viz is particularly complex or uses density marks, it's rendered on the server rather than
your device, disabling animations in the browser. Tableau now notifies you about this and
suggests that you filter out data, which sometimes simplifies the viz enough for animations to

play.

Info: Animations are paused for this complex viz. Try filtering out more data. X

For more information, see Why animations won't play on page 2891.

Create, rearrange, and preview device-specific layouts on the web

You can now preview and customize what your dashboard will look like across different device
types when authoring on the web, including changing the dashboard layout to show differently
i. Previously, customers could see and view device-specific views, but couldn’t edit or create
new layouts. Create desktop, tablet, or phone layout by right-clicking the device preview area
in the Dashboard left pane. For more information, see Create Dashboard Layouts for
Different Device Types on page 2801.
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Drag and drop headers on the web

Create a custom sort order by dragging-and-dropping headers to actively reorder
columns/rows directly within a view on the web, just like in Tableau Desktop. With a sortable
horizontal or vertical header, click to drag and drop the header to a new location within that
header set. For more information, see Sort Data in a Visualization on page 1447.

Sales by Product Category

B Jen Feb Mar Apr May
Furniture 2017 IQM $1,840

2020
Office Supplies 2017

2018

Technology 2017 | $3,143

2015 | 45,620

-

See connected metrics on a view

When you open the metrics pane on a view, you will now see metrics that have been created
from that view. Users with any site role can see connected metrics. Previously, the metrics pane
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was available only for users with a site role of Creator or Explorer (can publish) to create
metrics. For more information, see Create and Troubleshoot Metrics on page 3152.
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Collaborate and Explore with Tableau Online and Tableau Server

Keep track of your data with notifications on the web

Find out when someone comments or shares a view or workbook with you, rightin your
Tableau site. Select the bell icon in the top right corner to see all your notifications (including
updates if you own flows or extracts) and take action. Control where you receive these
notifications in your Account Settings--directly in Tableau, by email, or both. For more
information, see Tour Your Tableau Site on page 3104.

Add-ons

Tableau Catalog updates - part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for Tableau
Server and Tableau Online. For more information about Tableau Catalog, see "About Tableau
Catalog" in the Tableau Server or Tableau Online Help.

The following features are included in this release:

Automated data quality warning - You can set Tableau to monitor for extract refresh
failures and for flow run failures. When a failure occurs, Tableau generates a data quality
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warning that displays to users. For more information, see "Set a Data Quality Warning" in the
Tableau Server or Tableau Online Help.

Quick search results expanded - Quick search results now include tags on external assets.

Version 2020.4

Added in version 2020.4

Connect to and Prepare Data

o Find and use partner-built connectors on the next

page
o Connectto PostgreSQL 12 using a new JDBC connector

Design Views and Analyze Data

« Build maps with multiple data layers: marks layers
for maps on page 27

o Enhancements to dynamic parameters: refreshable
parameter ranges on page 27

o More models supported for predictive modeling
functions on page 28

« Extend date ranges into the future on page 28

o Get web authoring support from more Tableau con-
nectors on page 15

Prepare, Author, and View Data on Tableau Online and
Tableau Server

« Create highlight actions in Tableau Online and
Tableau Server on page 30

o Create fixed sets in Tableau Online or Tableau
Server on page 30
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o Apply filters to worksheets in Tableau Online or
Tableau Server on page 31

o Add labels to your marks in Tableau Online or
Tableau Server on page 32

» Refine date ranges with Ask Data on page 32

« See vizzes as stacked bar charts with Ask Data on
page 33

» Edit synonyms for field values with Ask Data on
page 34

» Image download improvements on page 34

« Use Salesforce data sources for web authoring on
page 29

Collaborate and Explore on Tableau Online and
Tableau Server

 New ways to see and manage custom views on
page 35

» Organize items in a collection (limited preview) on
page 35

Add-ons

o Tableau Catalog updates - part of the Data Man-
agement Add-on on page 35

Install and Deploy Tableau

o Turn off Web Page objects in Tableau Desktop on
page 36
o CPU requirement update on page 36

Connect to and Prepare Data

Find and use partner-built connectors

Tableau has great connectivity that allows you to visualize data from virtually anywhere. In
addition to dozens of built-in connectors for Tableau, you'll find more connectors built by
Tableau partners in the Tableau Extension Gallery. For more information about using partner-
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built connectors, see Use Partner-Built Connector from the Extension Gallery on
page 689.

Connect to PostgreSQL 12 using a new JDBC connector

Now you can connect to PostgreSQL 12 databases from Tableau. A new JDBC driver for
PostgreSQL supports these connections and is included with all Tableau products, except
Tableau Desktop for Mac and Tableau Builder for Mac. (Online support for JDBC and
PostgreSQL 12 connectivity will be rolled out more gradually.)

Design Views and Analyze Data

Build maps with multiple data layers: marks layers for maps

With 2020.4, we are introducing a new way to work with geographic data. Instead of being
limited to two layers of data through a dual axis map, now you can add as many layers of
geographic data as you want. Simply drag your geographic data to the view and drop it on the
"Add Map Layer" control that appears in the view. Each layer can be customized independently
using the marks card, giving you new levels of flexibility in map creation.

For more information, see Create Geographic Layers for Maps on page 1869.

b & | Bulding Geomsy

v [ BestenNeighborhoods
#be eiphborrosd

Enhancements to dynamic parameters: refreshable parameter ranges

In 2020.1, we introduced dynamic parameters, which makes it possible to set a parameter’s
current value or list of values to the result of a view-independent calculation every time the
workbook opens. Now, you can also create dynamic parameters for “range” parameters. This
means that min and max values for a parameter’s range will automatically update every time
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the workbook is opened. Tableau will query all values in a field’s range and users can pick any
value within the range, even if that value is not in the field’s discrete set of values.

For more information, see this blog post on dynamic parameters. Also, see Create
Parameters on page 1218.

More models supported for predictive modeling functions

In 2020.3, we introduced the MODEL_QUANTILE and MODEL_PERCENTILE table
calculation functions. By default, these functions use linear regression to generate predictions
and explore relationships within your data. Now in 2020.4, you'll be able to leverage two more
models: Gaussian process regression and regularized linear regression. With more models
supported, you have greater flexibility and can choose the model that best fits your use case.

For more information, see Choosing a Predictive Model on page 2615 and How
Predictive Modeling Functions Work in Tableau on page 2606.

Extend date ranges into the future

You probably already know that when you’re working with dates, Tableau only shows the
values that are represented in your data. Until now, users have been able to show missing
values to indicate incomplete data in the underlying data source, but this only applies to dates
within the boundaries of the existing data source. In addition, in 2020.3 we introduced the
ability to perform calculations on missing values when you select Analysis > Infer
Properties from Missing Values.

In 2020.4, we've added a simple menu option that lets you easily generate and display marks
beyond the existing date range. To do this, simply open the context menu of a continuous
(green) date pill, and select Extend Date Range.

Extend Date Range X

Extend the date range to show values for forecasted and calculated fields.

Length of additional time

Length of time Unit of time
16 - MONTH v

To see an example of this, check out Predictive Modeling Functions in Time Series
Visualizations on page 2649.

28 Version: 2021.2 Tableau Software


https://www.tableau.com/about/blog/2020/2/say-hello-dynamic-parameters?_ga=2.61001320.558122311.1600204837-1542226812.1600204837
https://help.tableau.com/current/pro/desktop/en-us/missing_values.htm
https://help.tableau.com/current/pro/desktop/en-us/missing_values.htm

Tableau Desktop and Web Authoring Help

Get notified when features won't animate in a browser

If a workbook contains features that won't animate in a web browser, such as maps, polygons,
and density marks, you now get notified at the bottom of the Format Animations pane. For more
information, see Unsupported browsers and features on page 2892.

Some animations in this
workbook play enly in
Tableau Desktop. Learn mone

Prepare, Author, and View Data on Tableau Online and Tableau Server

Use Salesforce data sources for web authoring

Creators can author and edit workbooks connected to Salesforce data sources in Tableau
Server and Tableau Online.
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Create highlight actions in Tableau Online and Tableau Server

Now you can create advanced highlight actions while authoring in Tableau Online and Tableau
Server, from both dashboards and individual sheets. For more information, see Create
Advanced Highlight Actions on page 1507.

Create fixed sets in Tableau Online or Tableau Server

In 2020.3, we introduced the ability to create dynamic sets on the web. Now in 2020.4, you can
create fixed sets in Tableau Online and Tableau Server, too—right in the web authoring
environment—with no conditions. To do this, simply open the dimension’s context menu and
select Create > Set.
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For more information on sets in Tableau, see Create Sets on page 1186.

Apply filters to worksheets in Tableau Online or Tableau Server

Until now, when authoring on the web, applying a single filter to multiple sheets has been
cumbersome. As of 2020.4, Tableau Online and Tableau Server customers can now apply a
filter to selected worksheets by using a brand new dialog. In addition, the entire experience is
keyboard accessible. To try it out, go to a filter’s context menu and select Apply to
Worksheets > Selected Worksheets.

Tableau Software Version: 2021.2
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Add labels to your marks in Tableau Online or Tableau Server

You can now choose which marks to label in a visualization while authoring in Tableau Online
or Tableau Server. The same options that are already available in Tableau Desktop are now
available in web authoring. This means you can label all marks, only the minimum and
maximum values, just the line ends, the most recent values, or only the selected or highlighted
marks in the view.

For more information, see Show, Hide, and Format Mark Labels on page 1378.
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Refine date ranges with Ask Data

Now you can precisely adjust date ranges in the user interface. Simply click "between",
"starting”, or "ending" in your questions, and change range type, date detail, and start and end
points.

For more information, see Adjust date filters on page 1118.
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with Order Date between Q1 2015 and Q4 2018 x

Specific Dates Relative Dates Range of Dates

Range Type Date Detail
Between v Quarter

Start Date
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Q12015

See vizzes as stacked bar charts with Ask Data

Stacked bar charts provide a great way to see how different categories contribute to your
overall data. Ask Data automatically displays stacked bar charts with data best visualized that
way. But you can display any query this way by adding "as a stacked bar chart" to your question
or choosing "Stacked Bar" from the viz-type menu.

For more information, see Change the viz type on page 1114.

gl Stacked Bar -
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Edit synonyms for field values with Ask Data

Synonyms ensure that Ask Data returns relevant vizzes, even if users' terminology differs from
field names and values in a data source. Using data roles that apply across multiple data
sources, you could previously edit synonyms only for field names, but now you can edit them
for field values as well.

For more information, see Edit field name or value synonyms for a data role on
page 1144.

Image download improvements

When you download an image in Tableau Server and Tableau Online, selections made in the
Page Setup dialog in Tableau Desktop (such as showing/hiding captions or legends) no longer
apply. For more information, see Download Views and Workbooks on page 3328.
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Collaborate and Explore with Tableau Online and Tableau Server

New ways to see and manage custom views

Quickly access and manage your custom views on Tableau Online or Tableau Server in one
place. When you look at a workbook in Tableau Online or Tableau Server, you can use the new
Custom Views tab to see your saved custom views as well as custom views others have made
visible to others. As the workbook owner or administrator, you can use the Custom Views tab to
see all custom views on the workbook as well as view count and when the custom view was last

accessed. For more information about custom views, see Use Custom Views on page 3224.

Organize items in a collection (limited preview)

Collections are like playlists that let you organize your Tableau content. Create private
collections for easy access to the workbooks, views, and metrics you need for your different
work projects. Or make a public collection with getting started resources for new employees on
your team. Collections are available as a limited preview that your administrator can sign up for
on Tableau Online only. For more information, see Organize Items in a Collection on

page 3199.

Add-ons

Tableau Catalog updates - part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for Tableau
Server and Tableau Online. For more information, see "About Tableau Catalog" in the Tableau
Server or Tableau Online Help.

The following features are included in this release:

Data Quality Warning History admin view - Site administrators can see how data quality
warnings are being used on the site using the pre-built admin view, Data Quality Warning
History. For more information, see "Data Quality Warning History" in Tableau Server or Tableau
Online Help.

See quality warning details in Tableau Desktop - Tableau Desktop users can hover over
the warning icon on the Data tab to see details about the data quality warnings affecting the
data in their workbook. For more information, see "Set a Data Quality Warning" in Tableau
Server or Tableau Online Help.

Metrics appear in lineage and show data quality warnings - Data quality warnings now
appear on metrics affected by a warning. Metrics also appear in the Lineage tool, enabling you
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to see how a metric might be affected by data changes when performing impact analysis. For
more information, see "Embedded asset appears in External Assets" in Tableau Server or
Tableau Online Help.

Install and deploy Tableau

Turn off Web Page objects in Tableau Desktop

If, for security or other reasons, you don't want Web Page objects in dashboards to display
target URLs, you can turn these objects off in several ways:

e During install from the command line, setthe WEBVIEWTOGGLEWEBZONESENABLED
property to 0.

o After installation, use the Windows registry or macOS Terminal app.

 Inthe Tableau Desktop interface, choose Help > Settings and Performance > Set
Dashboard Web View Security, and deselect Enable Web Page Objects.

CPU requirement update

Beginning with version 2020.4, Tableau requires you to have CPUs that support SSE4.2 and
POPCNT instruction sets. These CPUs have been common for more than 10 years and are
installed on most newer computers. Tableau products are also not currently compatible with
Apple Silicon processors.

If you attempt to install or upgrade Tableau on a computer that does not support these
instruction sets or that uses the Apple Silicon processors, the installer will not allow you to
continue.

To see a complete list of supported technologies, see tableau.com/techspecs.

Version 2020.3

Added in version 2020.3

Install and Deploy Tableau

+ Recent workbooks and settings are maintained on
upgrade on page 38
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Connect to and Prepare Data

« Enhancements to relationships, data modeling, and
the Data pane on the next page

» Override feature restrictions for cross-database
joins on page 39

« Combine spatial files with a Union join on page 40

Design Views and Analyze Data

« Create predictive models and forecasts with Pre-
dictive Modeling Functions on page 40

o Specify value for when Parameter Action selection
is cleared on page 41

o Easily refresh your data source for dynamic para-
meters on page 42

 Enhancements to Set Control on page 42

» Download crosstab files using a dashboard object
on page 42

o Compare Fields with the IN operator on page 43

Prepare, Author, and View Data on the Web

o Filter data on your views and data sources in
Tableau Online or Tableau Server on page 43

+ Download crosstab to Excel in Tableau Online or
Tableau Server on page 43

o Accessibility improvements to relative date filters
in Tableau Online or Tableau Server on page 44

o Pick new options for PDF subscriptions on page 47

o Create filter and Go to Sheet actions in Tableau
Online or Tableau Server on page 44

» Precisely refine dates with Ask Data on page 44

+ Display suggested questions in natural language
with Ask Data on page 45

Collaborate and Explore on Tableau Online and Tableau

Tableau Software Version: 2021.2



Tableau Desktop and Web Authoring Help

Server

» Find items shared with you on page 46

« Get notified when animations are paused for a viz
on page 22

« Pick new options for PDF subscriptions on page 47

» Accessibility improvements for organizing your
favorites on page 47

o Use Mapbox or WMS service connections in
Tableau Online or Tableau Server on page 44

Add-ons

o Tableau Catalog updates - part of the Data Man-
agement Add-on on page 48

Install and Deploy Tableau

Recent workbooks and settings are maintained on upgrade

Now when you upgrade Tableau Desktop to the next major release, your recent workbooks
are automatically imported and restored to your Start page along with your recent connections
list and any organization-specific settings on the Discover pane. In previous releases, while
you could still find your workbooks in your My Tableau Repository, your Start page would be
empty.

Connect to and Prepare Data

Enhancements to relationships, data modeling, and the Data pane

In 2020.2, relationships were introduced to Tableau. Relationships are a new, flexible way to
combine data for multi-table analysis in Tableau. Data sources now support multi-table data
models in a new logical layer. Tableau recognizes the separate tables in your data source and
performs aggregations at the native level of detail for each table. To learn more about
relationships and data modeling, see Use relationships to combine data for multi-table
analysis on page 50 in this What's New topic.

In 2020.3, you can create relationships based on calculated fields, and compare fields used for
relationships using operators in the relationship definition.
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Edit Relationship X

How do relationships differ from joins? Learn more

Author Book
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- Close

On the Data Source page, you can now move and replace tables in a data model using drag
and drop.

In the Data pane, afilter has been added to search to make it easier for you to find fields of
interest.

Search 9
Filter by

C: Calculation

D: Dimension

M: Measure

F: Comment

Also, you can now use Explain Data with data sources that contain multiple, related tables.
Cardinality and Referential Integrity settings for relationships must be set up correctly for
Explain Data to analyze multi-table, related data.

Override feature restrictions for cross-database joins

You can improve performance when joining data from a single file connection and a single
database connection by allowing Tableau to perform the join using the database that you are
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connected to instead of Hyper. But certain conditions must be met to use this option.

To enable you to experiment and determine the optimal performance configuration when
using this option, as an administrator, you can now override the file size, join type, and single
file connection limitations and force Tableau to use the live database connection to perform the
join.

For more information, see Join Your Data on page 883.

Combine spatial files with a Union join

With Tableau 2020.3, exploring geographic data is more flexible than ever. You can now
combine spatial files with a Union join, as long as they are in the same data source and single-

table format. For more information, see Union Your Data on page 942.

Design Views and Analyze Data

Create predictive models and forecasts with Predictive Modeling Functions

Using two new table calculation functions, MODEL_QUANTILE and MODEL_PERCENTILE,
you can leverage a powerful statistical engine to make predictions and generate forecasts
from your data, as well as identify unexpected values—all using the familiar table calculation
interface.
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Data can be filtered, aggregated, and transformed at all levels of detail, with inputs and
predictions automatically recalculated to match the data on screen. For more information, see
How Predictive Modeling Functions Work in Tableau. Or, check out this blog post, Generate
predictions in Tableau with predictive modeling functions.

Specify value for when Parameter Action selection is cleared

Now, when using parameter actions, you can specify a parameter value when the selection in
the viz is cleared. Previously, authors had no direct way to indicate a value for the parameter
that the viz would return to during interaction. For more information, see Parameter Actions
on page 1516.
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Clearing the selection will:
O Keep current value
© Set value to

|5,000

Easily refresh your data source for dynamic parameters

Previously, dynamic parameter queries were only evaluated when the workbook was opened
and you connected to the field’s data source for the first time. Now, queries can be evaluated
right from the workbook with the click of a button. In Tableau Desktop, simply press F5 or
select Refresh from the data source’s context menu. In Tableau Online or Tableau Server,
click the Data Source Refresh button in the toolbar. For more information on dynamic
parameters and how to use them, see this blog post.

Enhancements to Set Control

Recall that with a set control, your audience can add or remove set members by interacting
directly with the card in the view. Now, your set control will respect any context filters you have
in your view. This is especially important if you’re an enterprise working with large data sources
who uses context filters to improve performance, and to reduce the scope of the set’s domain
to include only the data of interest. Set controls are also now available in web authoring
environments. For more information on set controls, see Create Sets on page 1186.

Download crosstab files using a dashboard object

With the Download object (previously named the "Export" object), dashboard viewers can now
download selected sheets as crosstab files. Though you can add the Download object while
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authoring in Tableau Desktop, Tableau Online, or Tableau Server, crosstab download is
possible only from a web browser.

For more information, see Add dashboard objects and set their options on page 2743.

Compare Fields with the IN operator

Easily compare lists of values with the new IN logical function. A Boolean calculation, the IN
operator will take two or more fields and return a "true" value if any of the values in either field
are the same. The IN operator combines the features of set intersections with the flexibility and
speed of logical functions. For more information, see Logical Functions on page 2186.

Prepare, Author, and View Data on the Web

Filter data on your views and data sources in Tableau Online or Tableau Server

You can now create, edit, and remove filters for both workbooks and data sources while
authoring in Tableau Online or Tableau Server. These improvements include categorical,
discrete, and relative date filters. To set up a filter on a workbook, drag a field to the filters shelf.

If you have permissions to edit a data source, you can create a data source filter by selecting
the Data Source tab. Under Filters, select Add.

For more information, see Filter Data from Your Views on page 1411 and Filter Data from
Data Sources on page 1006

Download crosstab to Excel in Tableau Online or Tableau Server

You can now download views to .xlIsx file format when using Tableau Online and Tableau
Server. This download option retains numerical formatting, including international separator
characters. For more information, see Download Views and Workbooks on page 3328.
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Download Crosstab pod

Select a sheet from this dashboard

Sale Map Sales by Prod... Salesby Seg..  Total Sales

Select Format

() Excel () csv

Use Mapbox or WMS service connections in Tableau Online or Tableau Server

As of Tableau 2020.3, you can now publish a workbook with a Mapbox or WMS server
connection. For more information, see Use Mapbox Maps on page 1993 or Use Web Map
Service (WMS) Servers on page 1996.

Accessibility improvements to relative date filters in Tableau Online or Tableau
Server

Now, relative date filters are both keyboard accessible and screen reader compatible when in
web authoring environments. You can find more information on accessibility in Tableau here.

Create filter and Go to Sheet actions in Tableau Online or Tableau Server

For the first time, you can create actions while authoring in Tableau Online and Tableau
Server. Filter and Go to Sheet actions are now available from both dashboards and individual
sheets. In web-authoring mode, filtering on selected fields has been greatly streamlined,
letting you specify source and target fields without opening a separate dialog box.

For more information, see Filter Actions on page 1491 and Navigate from one view to
another view, dashboard, or story on page 1571.

Precisely refine dates with Ask Data

You can now refine existing queries to show specific dates. Time Period options show one
continuous date range; Date Value options show ranges that can repeat in multiple time
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periods. (For example, to see combined sales performance for Q1 across multiple years, under
Date Value, choose Quarters.)

For more information, see Adjust date filters on page 1118.

Order Date inQl x

Specific Dates Relative Dates Range of Dates

Date Detail
Quarters £ Search

Time Period |ied

Year 2020
Quarter Q12020
Month May 2020
Week Week 5, 2020
Day May 8, 2020

Date Value
Quarters Q1
Months
Weekdays
Month and Day
Week Numbers
Day Numbers

Display suggested questions in natural language with Ask Data

If you're a data source owner or Tableau administrator, you can now display suggested
questions in language familiar to your users, rather than as formal queries. Users can either
click the displayed text or enter it in the “Ask Data...” box.

For more information, see Optimize Data for Ask Data on page 1132.
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Suggested Question X

Text to Display

Rising stocks X
Matching Result
sum of Daily Change % by Stock Ticker X

Cancel Save

Collaborate and Explore on Tableau Online and Tableau Server

Find items shared with you

When an item is shared with you, it's added to your Shared with Me page. This makes it easy to
find shared items later, without needing to search your inbox or request another link. For more
information, see Share Web Content on page 3243.

Shared with Me
=
& Select All Content Type: ANl =

Q towa Type Name Shared Versions  Actions Shared By i Date Shared Owner
¥1 Favorites 0 % [E  Worldindicators o Jane Johnson 3secondsago  Fred Suzuki
© Recents

O % B Statistics 0 Jane Johnson 15secondsago  Laura Rodriguez
42 SharedwithMe & ~

O % [  Customers T o Jane Johnson Wmintesago  Susan Nguyen
¢ Recommendations

B3 Collections

Get subscriptions when data refreshes

You can now set the frequency of email subscriptions to only send when data refreshes.
Subscriptions let you receive email snapshots of a view or workbook at a frequency and
schedule you choose. Setting the frequency to When Data Refreshes means you’ll know that
the snapshot in your email contains the latest data. For more information, see Create a
Subscription to a View or Workbook on page 3249..

46 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help

Pick new options for PDF subscriptions

You can now choose the page size and orientation for PDF attachments when you create or
modify a subscription to a view or workbook in Tableau Online or Tableau Server. For more
information, see Create a Subscription to a View or Workbook on page 3249.

Paper Size Orientation
Letter Portrait

Portrait
Landscape

Accessibility improvements for organizing your favorites

You can now organize your favorites using a keyboard to perform drag and drop interactions.
For more information, see Keyboard Accessibility for Tableau on the Web on page 3164.
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Add-ons

Tableau Catalog updates - part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for Tableau
Server and Tableau Online. For more information about Tableau Catalog, see "About Tableau
Catalog" in the Tableau Server or Tableau Online Help.

The following features are included in this release:

See data quality warnings in Tableau Desktop - WWhen you open a workbook in Tableau
Desktop that has a data quality warning, the warning icon (either a blue circle or a yellow
triangle with an exclamation point) appears on the Data tab on the sheet page of the workbook.
For more information, see "Set a Data Quality Warning" in Tableau Server or Tableau Online
Help.

'Sensitive data' warning type added - You can use this new warning type to set a data
quality warning for sensitive data in your organization. For more information, see "Set a Data
Quality Warning" in Tableau Server or Tableau Online Help.

Embedded assets are listed in External Assets - You can now see embedded assets
listed in the External Assets page. For more information, see "Embedded asset appears in
External Assets" in Tableau Server or Tableau Online Help.

Tag external assets - Add tags to databases, tables, and columns, which enables you to,
among other things, tag tables and columns with personally identifiable information (PII). For
more information, see Use Tags on page 3180.

Version 2020.2

Added in version 2020.2

Connect to and Prepare Data

« Use relationships to combine data for multi-table
analysis on page 50

o Configure proxy for connection to Snowflake on
page 51

48 Version: 2021.2 Tableau Software


https://help.tableau.com/current/server/en-us/dm_catalog_overview.htm
https://help.tableau.com/current/online/en-us/dm_catalog_overview.htm
https://help.tableau.com/current/server/en-us/dm_dqw.htm
https://help.tableau.com/current/online/en-us/dm_dqw.htm
https://help.tableau.com/current/server/en-us/dm_dqw.htm
https://help.tableau.com/current/online/en-us/dm_dqw.htm
https://help.tableau.com/current/server/en-us/dm_lineage.htm#embedded-asset-appears-in-external-assets
https://help.tableau.com/current/online/en-us/dm_lineage.htm#embedded-asset-appears-in-external-assets

Tableau Desktop and Web Authoring Help

o Connect to Azure Synapse Analytics (new con-
nector name) on page 51

o Connect to Esri ArcGSI Server on page 51

« Connect to spatial fields in Oracle on page 51

Design Views and Analyze Data

o Add a Set Control to let users quickly modify the
members of a set on page 52

o Add or remove values from a set by interacting dir-
ectly with the viz on page 52

o Control the fields used for analysis by Explain Data
on page 53

Prepare, Author, and View Data on the Web

o Upload and open workbooks in a browser on
page 54

o Customize suggested questions for Ask Data on
page 55

o Add synonyms for multiple data sources with Ask
Data on page 55

» Organize your favorite content on page 56

» Create metrics to track your data on page 56

Collaborate with Tableau Online and Tableau Server

+ Dashboard download to crosstab improvements on
page 57

 Enhancements to editing Legends and Tooltips on
page 57

Add-ons

o Tableau Catalog updates - part of the Data Man-
agement Add-on on page 57
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Connect to and Prepare Data

Use relationships to combine data for multi-table analysis

Relationships are a new, flexible way to combine data for multi-table analysis in Tableau. Data
sources now support multi-table data models in a new logical layer. Tableau recognizes the
separate tables in your data source and performs aggregations at the native level of detail for
each table.

Creators can combine tables using relationships. Using relationships between logical tables
makes it easier to explore and analyze multi-table data at the right level of detail, without
having to write specialized calculations to control aggregations like averages and totals.

You do not need to specify join types for relationships; during analysis Tableau automatically
selects the appropriate join types based on the fields and context of analysis in the worksheet.

€2 8- Bookshop

Connections

Baokshop

Sheats o

Use Data Interpreter

Duata Interpreber might be able to
clean your Microzaft Excel Dfag tables here

workbook
Author
M Award
[§ Book i)
R Checkouts
BB Edition
M Info
i Publisher
BB Ratings
B SalesQ1
[l SalesQ2

Sort fields = Data source order * Show aliases Show hidden fields = rows

25 Mew Union

Example of a data source that uses relationships between tables. Tables in the logical layer act like
containers for tables in the physical layer of the data model.

In support of multi-table analysis, several parts of the Tableau interface have changed. The
Data Source page (canvas, data grid), View Data window, and the Data pane in the worksheet
have all been updated to support a multi-table analysis experience. For more information, see
Changes to different parts of the interface.
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Note: View Data column order has changed in Tableau 2020.2 and later. This change is
required to support relationships and logical tables. For details, see View Data column
order changes in Tableau 2020.2 and later.

For more information about relationships and changes to data sources, see these topics:

» What's Changed with Data Sources and Analysis in 2020.2

« Questions about Relationships, the Data Model, and Data Sources in 2020.2
o The Tableau Data Model

« Relate Your Data and Optimize Relationships Using Performance Options

« How Analysis Works for Multi-table Data Sources that Use Relationships

» Troubleshooting Multi-table Analysis

« Walkthrough: Don't Be Scared of Relationships

Watch a video: For an overview of data source enhancements and an introduction to using
relationships in Tableau, see this 5-minute video.

Learn more about how relationship queries work in this Tableau blog post: Relationships, part
1: Introducing new data modeling in Tableau.

Configure proxy for connection to Snowflake

You can use the custom driver parameters field to configure a connection through a proxy for
Snowflake. See Snowflake on page 641.

Connect to Azure Synapse Analytics (new connector name)

Microsoft renamed their product, and the connector for Tableau did too. The Azure SQL Data
Warehouse connector is now called Azure Synapse Analytics. See Azure SQL Synapse
Analytics on page 480.

Connect to Esri ArcGSI Server

Now you can connect Tableau to an Esri ArcGIS Server. See Esri ArcGIS Server on
page 498.

Connect to spatial fields in Oracle

You can now connect to spatial data fields in an Oracle data source. For more information, see
Connect to Spatial Data in a Database on page 1799.
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Design Views and Analyze Data

Add a Set Control to let users quickly modify the members of a set

With a Set Control, your audience can select the members of a set without necessitating edit
mode. Users can simply add or remove set members by interacting directly with the card in the
view. Coupled with Set Actions, you have two powerful, complementary features that make it
easy to visualize the set you're interested in.

File Data Worksheet Dashboard Story Analysis Map Format  Server  Window  Help

# € o R G G-C- - k- B 2IE | L0 T & E
Data Analytics # || Pages iii Columns Longitude (generated)
(& COPY Global 5... = Rows
Search L E v Filters f
Try it yourself

Tables
@ Country IE‘
@ funcountries Marks
@ selected countries +

%K Map b
abe  Measure Mames
4 Shipping Cost H &
® Lafitude (generated) | | |Color| | Size | |Label
& Longitude (geners... KX ]
=# MNumber of Records Detail | | Tocktip|
#  Orders (Cournt)
# Measure Valuves

For more information, see Create Sets, or check out this blog post, Powerful analytics in a
user-friendly package with the set control.

Add or remove values from a set by interacting directly with the viz

Now, using Set Actions, you and your audience can use the viz itself to incrementally add
values to or remove values from a set. Simply interact with the viz and choose which marks to
include or exclude. Coupled with the new Set Control feature, you have two powerful ways to
gain deeper insights into your data.
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For more information, see Set Actions.

Control the fields used for analysis by Explain Data

You can now specify which fields are modeled during analysis. With the ability to select which
fields are included and excluded from explanations, dashboard authors can hide redundant
results and add fields that are excluded by default.
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= Rows SUM(Sales)

Filters

Sales by Category

Category

Marks
1all Automnatic
n & || o
Calor Size || Label

Q

ado
Detail  Tootip

Sales

Category: Technology
$1,076,381

For more information, see Discover Insights Faster with Explain Data on page 2035 in
Discover Insights Faster with Explain Data on page 2035.

Prepare, Author, and View Data on the Web

Upload and open workbooks in a browser

Users can now upload a Tableau workbook to your Tableau site without publishing through
Tableau Desktop, the REST API, or TabCmd. In a Tableau site, users with a Creator or
Explorer (can publish) site role can select New > Upload Workbook to upload a .twb or .twbx
file (up to 50 MB) to a project. For more information, see Upload Workbooks to a Tableau

Site on page 3146.

> Project
[v} Workbook

Workbook Upload
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Customize suggested questions for Ask Data

Data source owners and Tableau administrators can customize suggested questions for a data
source, tailoring them to the needs of users in your organization. For more information, see
Optimize Data for Ask Data on page 1132.

Add synonyms for multiple data sources with Ask Data

When a field or value has similar usage throughout your organization, you can use data roles to
apply the same synonyms across multiple data sources. For example, data roles are a great
choice if every subsidiary uses the same names for business departments, or if product lines
have a consistent set of sub-products.

Using data roles for synonyms saves you a lot of time, because you can manage them centrally
in Tableau Online or Tableau Server. From Ask Data, you can publish new data roles and apply
existing ones created in Ask Data or Tableau Prep.

For more information, see Add synonyms for multiple data sources on page 1142.
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Field Details b4
Industry
Abe String Industry synonyms

wheelee applied this data role. Their permissions are
used to inherit synonyms.

View Data Role
Apply a Different Data Role...
Remove Data Role

Publish Data Role...

Make this field's synonyms inheritable by other data
sources

Organize your favorite content

Drag and drop cards to create a custom sorting order for your favorites. This option is available
when interacting with your favorites in grid view on Tableau Online or Tableau Server. For
more information, see Mark Favorites on page 3195.

Content Type:  All v SortBy: Custom - How

World Indicators * - College o

Create metrics to track your data

Metrics help you track changes to your data. You can create metrics from a view on Tableau
Online or Tableau Server. Use metrics to monitor key numbers, like daily sales. For more
information, see Create and Troubleshoot Metrics on page 3152.
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Collaborate with Tableau Online and Tableau Server

Dashboard download to crosstab improvements

You can now download to crosstab for dashboards, without selecting a sheet first. Before, the
button was disabled until you selected a sheet to export to a .csv file. Now, you can select
Download -> Crosstab to select the appropriate sheet from a list of options. For more
information on exporting to crosstab, see Export Data from Tableau Desktop on page 3034.

Enhancements to editing Legends and Tooltips

Now with Tableau 2020.2, resizing and changing the placement of your Tooltips will persist
even when you log out. For more information, see Format Titles, Captions, Tooltips, and
Legends on page 2937.

Add-ons

Tableau Catalog updates - part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for Tableau
Server and Tableau Online. For more information about Tableau Catalog, see "About Tableau
Catalog" in the Tableau Server or Tableau Online Help.

The following features are included in this release:

Raise the visibility of important warnings - You can set a data quality warning to be highly
visible, so that users of a visualization that's affected by the warning see a notification, and the
warning displays in a more prominent yellow color elsewhere in Tableau. For more information,
see "Set a Data Quality Warning" in Tableau Server or Tableau Online Help, and "Use Data
Details to see visualization information" in Explore and Inspect Data in a View on

page 2707.
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Dashboards appear in the Lineage pane - When you select the Dashboards item in the
lineage, you can see a list of downstream dashboards. For more information, see "Use
Lineage for Impact Analysis" in Tableau Server or Tableau Online Help.

Filter external assets on Certified and data quality warnings - In addition to using
search to narrow down your choices on External Assets, you can now filter databases, files,
and tables by Certified and by data quality warnings.

More filters when connecting - When you connect to data, you can filter databases and
table on connection type.

Version 2020.1

Added in version 2020.1

Install and Deploy Tableau

o Customize the Discover pane on the facing page
o Support for login-based license management on
page 60

Connect to and Prepare Data
« Salesforce connector has updates on page 60
Design Views and Analyze Data

» Refresh parameters automatically with dynamic
parameters on page 61

» Visualize area on a map with the Buffer function on
page 61

o Animate mark transitions on page 62

o Export dashboards to PDF, PowerPoint, or images

on page 63
» View status in Explain Data on page 63

Prepare, Author, and View Data on the Web
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o Automatically add phone layouts to new dash-
boards on page 64
o Improved Tooltip formatting on the Web on page 64

Add-ons

« Tableau Catalog updates - part of the Data Man-
agement Add-on on page 65

Install and Deploy Tableau

Customize the Discover pane

Now you can customize the Discover pane that shows on the Start page in Tableau Desktop to
show your custom content instead of the links, blog posts and Tableau news that shows by
default. Simply create your own web page hosted on a webserver that you provide and then use
the new DI SCOVERPANEURL install property to point to it. When you launch Tableau Desktop
your own custom content will show instead. To help you get started quickly, Tableau Desktop
provides a template that models the same layout as the Tableau provided Discover pane.
Simply download the template and replace the links with your custom content.

Use this feature to provide links and information to content that is specific to your organization to
make it easier for your users to get started using Tableau quickly.

Install or
Upgrade
Tableau
Desktopand
Tableau Prep
Builder

1 A O DO
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To configure Tableau Desktop to show your custom discover pane content, during install from
the command line (Windows), include the property
DISCOVERPANEURL="https://yourwebpageURL". If you wantto update the discover
pane content after installation is complete, add the Di scoverPane key with the
DiscoverPaneURL set to your custom URL to the registry (Windows) orinthe .plist file
(MacOS) for each computer where Tableau Desktop is installed.

Note: This feature is currently only available for Tableau Desktop.

For more information, see Installer properties or Change Installation Settings after Installation
in the Tableau Desktop and Tableau Prep Deployment Guide.

Support for login-based license management

Login-based license management, helps you manage licensing for users with Creator roles on
Tableau Server and Tableau Online. Users with Explorer or Viewer roles cannot use this
feature. If you're using Role Based Subscriptions with Tableau Server or Tableau Online, you
can simplify your license management using login-based license management to eliminate
separate Tableau Desktop and Tableau Prep Builder product keys. You only need to manage
one or more product keys for on-premises Tableau Server, or in the case of Tableau Online,
you don’t need to manage any product keys at all.

Connect to and Prepare Data

Salesforce connector has updates

We’'ve refreshed our Salesforce connector to provide faster performance, greater flexibility,
and even more data to play with. First, we changed the way we connect to Salesforce data; the
connector now dynamically switches APIs depending on how large your dataset is, greatly
increasing performance. Also, the Salesforce connector now supports using the SOQL
language in the same way that Custom SQL can be used today, adding flexibility to your
analysis. Finally, you will now be able to connect to additional data objects like Salesforce
Activity History and Campaign Influence, giving you even more data to see and understand in
Tableau.
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Design Views and Analyze Data

Refresh parameters automatically with dynamic parameters

Now you can set a parameter’s current value to be the result of a single-value, view-
independent calculation. In addition, you can refresh a parameter's list of values (or domain)
based on a data source column. This means that each time the workbook is opened and
Tableau connects to the data source referenced by the parameter, every place in the workbook
that references the parameter will use the latest value or domain.

le Housing Market

Average House Price

' $728,819

F

Year over Year Change
-3.2% V

Reference Date
August 2019

(

For more information, see this blog post on . Also, see Create

Parameters on page 1218.

Visualize area on a map with the Buffer function

Finding the area around a point once required complicated calculations that were not
guaranteed to be accurate. With the new Buffer function, we can define the exact distance from
a point we want to visualize. This area will accurately reflect the actual area of a map, even
when viewing points distorted by the map projection. For more information, see Spatial

Functions on page 2245.
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Buffer Distance
Buffer Example

O <>
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Animate mark transitions

Animate visualizations to better highlight changing patterns in your data, reveal spikes and
outliers, and see how data points cluster and separate.

Animations visually transition between filter, sort, and zoom settings, different pages, and
changes to filter, parameter, and set actions. As visualizations animate in response to these
changes, viewers can more clearly see how data differs, helping them make better informed

decisions. For more information, see Format Animations on page 2887.
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Export dashboards to PDF, PowerPoint, orimages

The new Export object lets your audience quickly create a PDF file, PowerPoint slide, or PNG
image of a dashboard. Style and formatting options are similar to Navigation objects (previously
known as “Button” objects). You can choose to display text or an image, specify custom border
and background colors, and provide informational tooltips.

Export to POF

For more information, see Add dashboard objects and set their options on page 2743.

View status in Explain Data

The Explain Data window now includes a status bar that provides explanation alerts, messages,
and a summary of investigated fields. You should also experience improved performance when
using Explain Data on wide data sets (> 500 columns). Also, the Explain Data window can now
be resized.
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Explain Data X

Canada goose
SUM(Cost: Total $)

Sum of Cost: Total $ 131,320,947 is higher than expected. Possible explanations:

sbe Birds Struck The selected mark Canada goose has an interesting distribution

The higher value is partially explained by the of values for Birds Struck.

distribution of values for Birds Struck.
Distribution of records by Birds Struck

Birds Struck i)

A Single Extreme Value B _
A single record with a value of 41,071,585 is I
increasing the sum of Cost: Total $. 2-10

111001

Null |
0 2% A40% 60% 80% =

43 of 61 fields considerﬁ O]

For more information, see Discover Insights Faster with Explain Data on page 2035 and
Analyzed Fields in Explain Data on page 2088.

Prepare, Author, and View Data on the Web

Automatically add phone layouts to new dashboards

The web authoring environment now includes the command, Dashboard > Add Phone
Layouts to New Dashboards, which is selected by default. In most cases, the automatically
generated phone layout will be ideal for smaller screens, but you can always edit it in Tableau
Desktop. For more information, see Create Dashboard Layouts for Different Device
Types on page 2801.

Improved Tooltip formatting on the Web

Formatting your work on the web just got easier with the improvements to Tooltip formatting.
Now you can include Viz in Tooltip and custom indents when you format your workbooks in the
web authoring environment. For more information, see Create Views in Tooltips (Viz in
Tooltip) on page 1475.
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Add-ons

Tableau Catalog updates - part of the Data Management Add-on

Tableau Catalog is included in the separately licensed Data Management Add-on for Tableau
Server and Tableau Online. For more information about Tableau Catalog, see "About Tableau
Catalog" in the Tableau Server or Tableau Online Help.

The following features are included in this release:

Added connectors - Connect to more data from external assets. We've added support for the
following connectors: Google Big Query, Google Drive, Google Sheets, Box, Dropbox, and
OneDirive.

Create workbooks - Create a workbook from the External Assets page or from a database or
table page for Catalog-supported connections. For more information, see "Tableau Catalog
users create workbooks from external assets" in Creators: Get Started with Web
Authoring on page 3119.

Filter on Certified and data quality warnings - Filter data sources, databases, files, and
tables by Certified, filter data sources by connections, and filter databases and tables by data
quality warnings. For more information, see "Open the Connect to Data page" in Creators:
Connect to data on the web on page 3135, or "Connect from Tableau Desktop" in Connect
to Data by Using Tableau Server or Tableau Online on page 445.

Enhanced Data Details pane -

o See a sparkline with the number of times a sheet or dashboard was viewed over the last
12 weeks.

« Easily see that there are Warnings on a view.

o Expand afield to see its metadata, such as a description or calculation.

o When afield in a workbook inherits its description, see where the description comes from.

For more information, see "Use Data Details to see visualization information" in Explore
and Inspect Data in a View on page 2707.

Version 2019.4

Added in version 2019.4
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Install and Deploy Tableau

« Share usage data with Tableau on the facing page
o Default database drivers no longer automatically
installed for MacOS on page 68

Connect to and Prepare Data

o Support added for six data connectors on page 68

o Support added for connector plugins on page 68

» Convert an SAP HANA level hierarchy in Tableau
on page 68

Design Views and Analyze Data

o Author tables with up to 50 columns and scroll
horizontally on page 69

» More data considered by Explain Data on page 69

e Go from a sheet to related dashboards and stories
on page 70

» Easily identify and select parent layout containers
on page 70

o Automatically add phone layouts to existing dash-
boards on page 71

o Ensure data security with Sandboxed dashboard
extensions on page 71

 Enhancements to Nested Sorting on page 72

o Improved work flow when using WMS or Mapbox
background maps on page 72

o Customize maps on the web with Map Layers on
page 77

Prepare, Author, and View Data on the Web

o Discover recommended views on page 72
o Choose from categories of suggestions for Ask
Data on page 73
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Share links to Ask Data vizzes on page 74
Compare differences over time with Ask Data on

page 74

See optimized sheets on phones on page 75
« Edit Tooltips on the web on page 77

Collaborate with Tableau Online and Tableau Server

o Share content quickly via your Tableau site on
page 78
* Request access to content on page 79

o Accessibility improvements for Viewers in Tableau

Online and Tableau Server on page 80

Install and Deploy Tableau

Share usage data with Tableau

Tableau collects data that helps us learn how our products are being used so we can improve
existing features and develop new ones. All usage data is collected and handled according to
the Tableau Privacy Policy. But you can opt out if you don't want to participate.

The opt out option has changed. Usage data collection is enabled by default. If you don't want to

participate, select the Don't send product usage data check box from the installer or
Customize installer (MacOS) dialog or from the Help menu after installation.

Help
Get Started
COniline H elp

Get Support

Choase Lamguage b
Settings and Performance  * " Enable Recommendations
Manage Proglbect Keys... " Disable incompatible featuras
Manage Analytics Extansion Connaction

About Tableay Prep Buslder
Dan't sand praduct utsge dats (reguires restart)

For more information, see Turn off usage reporting in the Tableau Desktop and Tableau Prep

Deployment Guide.
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Default database drivers no longer automatically installed for MacOS

When installing Tableau Desktop on Mac, we only install the PostgreSQL database driver
automatically. If you need other drivers to connect to your data, you can install them from the
Driver Download page.

In=tall an “Macintozh HD®
Action Bire
& Intreduetion | Tableau Deskion application Uppracs 1508
& Liconso T Create & desinop shoricut Skin Zero KB
7 Darfr send prechect cange dats Skip Tara KB
- B Erubls satensicas ingeall Tarn RE
. B Erubis netwark-anatilsd extentiont Iraeadl Zara KB
& Ingtaily B PopsgreSon databate drivr Upgracs T8 ME
& Summary
: LEGH N Remanieg: M%7 GO
Tableau
Deskto

Connect to and Prepare Data

Support added for six data connectors

Use the following connectors to connect Tableau to your data:

« Alibaba AnalyticDB for MySQL on page 453
o Alibaba Data Lake Analytics on page 455

o Alibaba MaxCompute on page 457

o Kyvos on page 547

« Linkedln Sales Navigator on page 549

e Qubole Presto on page 601

Support added for connector plugins

You can connect to data using connectors created with the Tableau Connector SDK. For more
information, see Connectors Built with the Tableau Connector SDK on page 690 For
information about the Tableau Connector SDK, see the Tableau Connector SDK on GitHub.

Convert an SAP HANA level hierarchy in Tableau

When you connect Tableau to an SAP HANA calculation view with a level hierarchy, the
structure of the SAP HANA level hierarchy appears in the Data pane. If you want to modify the
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SAP HANA level hierarchy in Tableau, you need to convert it to a user hierarchy. For more
information, see Convert an SAP HANA level hierarchy to a user hierarchy on page 612.

Design Views and Analyze Data

Author tables with up to 50 columns and scroll horizontally

Now you can author wide tables with up to 50 columns. In addition, wide tables with discrete
fields can now be scrolled horizontally.

To change the maximum number of row and horizontal row labels, authors must use the Table
Options dialog box in Tableau Desktop.

Maximum levels of row labels

Maximum levels of horizontal row Isbels

For more details, see Define Table Structure on page 2966. Also, see this post on 50-column
tables from Tableau Public Ambassador Marc Reid on the datavis.blog.

More data considered by Explain Data

Explain Data now analyzes unvisualized measures in your data source that might impact the
value of a mark. Explanations show the relationship between the target measure and the
unvisualized measure for all marks in the source visualization.

Calculated fields with aggregation type AGG (such as ratio calculations) can now be analyzed.
For all unvisualized dimension and measure explanations, unvisualized calculated fields are
considered as candidates for explanations.
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Go from a sheet to related dashboards and stories

To quickly go to dashboards and stories a sheet appears in, right-click the sheet tab and open
the new Used in menu. Think of this as a companion to the Go to Sheet command available
from dashboards and stories. Using the two features together, you can quickly optimize sheet

designs and data to better fit dashboard layouts and story points.

For more information, see Navigate between sheets, dashboards, and stories on
page 2837.

Easily identify and select parent layout containers

From the menu for each dashboard object, customized names for parent layout containers
now appear, letting you easily identify and select them.
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For more information, see Group items using layout containers on page 2757.

Automatically add phone layouts to existing dashboards

To automatically create phone layouts whenever you open old dashboards that lack them,
choose Dashboard > Add Phone Layouts to Existing Dashboards.

For more information, see Automatically add phone layouts on page 2803.

Ensure data security with Sandboxed dashboard extensions

New Sandboxed dashboard extensions run in a protected environment without access to any
other resource or service on the web. As an author, you can quickly incorporate Sandboxed
extensions into dashboards because they don't require approval from your Tableau
administrator.

To see all the available Sandboxed extensions, go to extensiongallery.tableau.com.

For more information, see Use Dashboard Extensions on page 2839.
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Enhancements to Nested Sorting

Perform a Nested Sort on discrete measures and dimensions with the same ease you've come
to expect from Tableau Desktop's Nested Sort feature.

Improved work flow when using WMS or Mapbox background maps

Add Mapbox or Web Map Service background maps to your visualization with the new,
streamlined maps dialog. Each background map is now accessible directly from the
Background Maps menu.

Add Mapbox Map...
Add WMS Map...

For more information, see Use Web Map Service (WMS) Servers on page 1996 or Use
Mapbox Maps on page 1993.

Prepare, Author, and View Data on the Web

Discover recommended views

The new Recommendations page on Tableau Server and Tableau Online recommends views
for you to explore. Recommendations help you find useful content on your site that you might
not otherwise encounter. For more information, see Discover Recommended Views on
Your Tableau Site on page 3231.
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Choose from categories of suggestions for Ask Data

To help you quickly answer questions with Ask Data, we've grouped suggestions into four
categories: Basic Data Analysis, Date and Time, Filters, and Viz Types. These suggestions
make a great starting point for your analysis, which you can easily later revise as needed.
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Questions To Ask Learn More

» Basic Data Analysis
~ Date and Time
by Order Date's month
Order Date in the last 5 years
Order Date between January 03, 2014 and December 30, 2017
year over year % difference in sum of Sales over Order Date

latest Order Date

» Filters

» Wiz Type

For more information, see Automatically Build Views with Ask Data on page 1109.

Share links to Ask Data vizzes

You can quickly share Ask Data vizzes without even saving a sheet. Simply click the link icon

above the query box, and copy a link viewable by anyone with access to the data source.

Compare differences over time with Ask Data

Ask Data now lets you compare time periods with phrases like “year over year”, “quarter over
quarter”, or similar comparisons by month, week, or day. Differences can be expressed in
either absolute figures or as a percentage.
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For more information, see Compare differences over time on page 1119.

year over year difference

See optimized sheets on phones

When you view individual sheets on a mobile phone, Tableau automatically displays a vertical
arrangement of filters, legends, and other cards.
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College Admissions

Explore the distribution of SAT scores in different colleges
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Edit Tooltips on the web

You can now format, edit, and use tooltips when editing your workbooks on the web using the
same process you've learned in Tableau Desktop.

Tableau Book - w0 v [8][z][u] W [E]E =] [meern-]|[X] |
'-A"'I"'l"':"'2"'I"'3"'I"I4"'I"I5"'|

Category <Category>

Customear Name <Customer Name>

Segment <Segment>

Sub-Category: <Sub-Category>
Profiz. <SUM(Profit)>
Sales: «SUM(Sales)>

| Show tacltips  Responsive - Show toaltips instantly
| Include command buttons
| Allow selection by category

[ Reset ][ Preview ] ] OK |[ Cancel ]_:;

For more information, see Format Titles, Captions, Tooltips, and Legends on page 2937.

Customize maps on the web with Map Layers

Map layers allow you to customize the appearance of your map using Tableau's web editing
features.
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For more information, see Customize How Your Map Looks on page 1965.

Collaborate with Tableau Online and Tableau Server

Share content quickly via your Tableau site

New sharing functionality lets you share content with others via your Tableau site—no need to
compose a separate email. Additionally, if you make modifications to a view, by selecting filters
or marks, those changes will now be captured when you share. For more information, see

Share Web Content on page 3243.
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Share Workbook -

[Z] Superstore
Only perdple with perrmession can sae this waorkbook
Share with people

Jane Johnson X

Message (optional)

G

Request access to content

You can now request access to content that you don't have permission to see a project,
workbook, or view. When someone requests access, Tableau routes an email to the person
who controls permissions for that content. For example, if a requested workbook is in a project
where permissions are controlled at the project level (locked projects), the project owner
receives an email with information about the request, a link to the requested content, and
instructions about how to grant access or manage permissions.

For more information on access options, see Manage Web Content on page 3205

Page unavailable

To see this page, request access from the owner.

Request Access

Explore other content
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Accessibility improvements for Viewers in Tableau Online and Tableau Server

When you select a link to a view or workbook in Tableau Online or Tableau Server, you can use

a screen reader or keyboard to navigate toolbar menus for collaboration, interact with an

accessible view, or use the "Skip to Content" option to skip past the navigation panel and

toolbar and jump straight to the view. This update also adds a focus indicator for keyboard

navigation. Previously, views needed to be embedded for the experience to be accessible at

this level. For more information, see Keyboard Accessibility for Tableau on the Web on

page 3164 or see FAQ: Accessibility for Tableau’s Accessibility Conformance Reports
(VPATSs).

Version 2019.3

Added in version 2019.3

Customize Language

Support added for Italian on page 82

Help Redesign

Provide feedback more easily on page 83

Connect to and Prepare Data

80

Use database connections to perform cross-data-
base joins on page 83

Connect to databases and tables with Tableau
Catalog (Data Management Add-on required) on
page 85

Tableau Server moves up on the Connect pane
with a new Search for Data page on page 85
Connect to spatial files on the web and other spa-
tial connector improvements on page 87

Connect to Databricks on page 87

Improved connections to TabPy on page 87
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Design Views and Analyze Data

+ Explore and inspect views with Explain Data on
page 88

e Quickly switch between the ISO-8601 calendar and
the standard Gregorian calendar on page 89

o Create phone layouts with a streamlined workflow
on page 88

+ More aggregations available for parameter actions
on page 90

 Use MAKEPOINT to convert projected coordinates
into latitude/longitude on page 90

e Use DISTANCE to measure between points on a
map on page 91

Prepare, Author, and View Data on the Web

« Connect to databases and tables with Tableau Cata-
log when web authoring (Data Management Add-on
required) on page 91

« Embed Ask Data into web pages on page 92

« Adjust relative date filters with Ask Data on page 92

« Show top and bottom outliers in context with Ask
Data on page 93

o Add dashboard extensions directly in Tableau on
page 18

o Search your Tableau site with improved results on
page 94

o Set context filters on page 95

Save and Publish Data Sources and Workbooks

+ Receive subscriptions as PDF attachments on
page 96

o Create a PowerPoint file from selected workbook
sheets on page 96
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Collaborate with Tableau Online and Tableau Server

o Share more content types on page 97

Support added for Italian

Tableau has added support for Italian. You can now set Tableau to display the user interface in
one of eleven languages:

o Chinese (Simplified)

o Chinese (Traditional)
o English (United Kingdom)
o English (United States)
o French

o German

o ltalian

« Japanese

o Korean

o Portuguese

« Spanish

For more information, see Set your display language for Tableau Desktop or Change

language and locale for Tableau Online and Tableau Server.

In addition to supporting Italian in all Tableau products, the help is also available in these
languages. To read the help in your preferred language, navigate to the bottom of the main
Tableau Help page, and select the language from the footer.

English «
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Help Design

Provide feedback more easily

Ablue Send feedback icon is displayed in the bottom right corner of every Help page to make it
easier for you to send feedback about the content in a topic. Click the icon to let us know if a
topic is helpful to you, and also to comment on what needs improvement.

Tableau Desktop and Web Authoring Help

Connect to and Prepare Data

Before you begin vour analysis, vou must connect to your data and then set up the data
source. There are many optional configurations that you can make on the Data Source

page that Tableau uses to interpret and interact with your data.
The topics in this section describe how to connect to your data and use these
configurations in order to optimize your data source for analysis.
b

Connect to and Prepare Data

Use database connections to perform cross-database joins

In past releases when performing cross-database joins between a file and a database, Tableau
would pull all the data from the data sources into Hyper and perform the join there. Depending
on the size of your data sets, this operation could take some time.

Now, to improve performance you can choose to allow Tableau to perform the join using the
database that you are connected to instead. If you choose this option, Tableau decides which
option is faster (Hyper or the connected database). If Tableau uses the connected database to
perform the join, data from the file data source is copied into temporary tables in the connected
database. Before selecting this option, make sure your database is from a trusted source.

To see this new option, in the Data Source tab, add one connection from a supported file type
and one connection from a supported data source. The following file types and data sources
and are supported for this release:
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File types:

o Microsoft Excel
« PDF
o Textfiles (.csv, .txt, .tsv or .tab)

Data sources:

o Microsoft SQL Server
o Oracle

o PostgreSQL

o Vertica

The Cross-database join option displays in the top right corner of the canvas. To change
how cross-database joins are performed, click Edit.

£+ Multiple Connections rest-databane n - Connection
Using Tablaasg Ed® @) Liew Extract

| retuens_pew —{W] Proda

In the Cross-Database Join dialog, select the option you want to use.

Cross-Database Join *

Improve performance. Choose where the join process happens when joining
data from multiple sources. Learn more €

Select one of the following to continue:

(@) Use Tableau or existing databases (@0
Data from your file connection may be moved to your live database
connection. This option may be faster.

() Use Tableau only (default)

The selected option displays in the canvas. You can change your selection at any time. This
option is available in Tableau Desktop and for web editing in Tableau Server.
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For more information about configuring cross-database join processing options, see Join Your
Data on page 883.

Connect to databases and tables with Tableau Catalog (Data Management Add-on
required)

Tableau Catalog is available as part of the Data Management Add-on for Tableau Server and
Tableau Online. When Tableau Catalog is enabled in your environment, in addition to
connecting to published data sources on Tableau Server and Tableau Online, you can connect
to databases and tables from Search for Data on Tableau Desktop. For more information, see
Connect to Data by Using Tableau Server or Tableau Online on page 445. For
information about Tableau Catalog, see "About Tableau Catalog" in the Tableau Server or
Tableau Online Help.

Tableau Server moves up on the Connect pane with a new Search for Data page

In the Connect pane on Tableau Desktop, Tableau Server moves to the top of the pane,
under Search for Data. Select Tableau Server to connect to Tableau Online or Tableau
Server.
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onnect

ch for Data

Tableau Server

When you connect to Tableau Server 2019.3 or later, on the Search for Data page you can
search for and select a published data source to connect to. When you have Tableau Catalog
enabled in your environment (Data Management Add-on required), you can also search for
and connect to databases and tables.
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search for Data

Hoame & Workbosks  Love/Last Datract Connecti T

For more information, see Connect to Data by Using Tableau Server or Tableau Online
on page 445. For information about Tableau Catalog, see "About Tableau Catalog" in the
Tableau Server or Tableau Online Help.

Connect to spatial files on the web and other spatial connector improvements

Connect to spatial files when authoring on the web in Tableau Server or Tableau Online. As a
Creator, you can upload spatial file formats that only require one file (.kml, .geojson, .topojson,
and Esri shapefiles packaged in a .zip and Esri File Geodatabases with the extension .gdb.zip)
in the Files tab when you create a new workbook and connect to data. In Tableau Desktop, you
can now connect to shapefiles in a .zip folder and Esri File Geodatabase folders. For more
information, see Creators: Connect to data on the web on page 3135 on the Web and
Create Tableau Maps from Spatial Files on page 1855.

Connect to Databricks

Use the Databricks connector to connect Tableau to your Databricks database. For more
information, see Databricks on page 488.

Improved connections to TabPy

Customers can enable basic authentication for TabPy, requiring usernames and passwords for
connections. Logging improvements allow for more granular tracking of which users executed
what code. For more information, see Pass Expressions with Analytics Extensions on
page 2690.
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Design Views and Analyze Data

Explore and inspect views with Explain Data

Inspect, uncover, and dig deeper into marks in a viz using Explain Data. Explain Data gives you
a new window into your data by proposing statistical explanations for a selected mark,
including potentially related data from the data source that isn't used in the current view.

Creators and Explorers with editing permissions can use Explain Data when editing a view in
Desktop, or editing a view on the web in Tableau Online or Tableau Server.

Explanations give you information and visualizations on the data points that might be affecting
the mark value. You can then open visualizations for further exploration. For more information,
see Discover Insights Faster with Explain Data on page 2035.
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Create phone layouts with a streamlined workflow

To always create phone layouts for a workbook, select Dashboard > Add Phone Layouts to
New Dashboards. (This command was previously labeled "Auto-Generate Phone Layouts".)

Click the new lock icon to quickly toggle between automatic H and manual El Phone layouts,

which you can also select via the pop-up menu:

o Auto-Generate Layout automatically synchronizes any changes to the Default dash-
board, saving you time.
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o Edit Layout creates a layout that's fully independent from the Default dashboard, letting
you manually add and arrange items.

If you've chosen to edit a phone layout, select Optimize Layout to quickly optimize the
placement of filters, remove white space, and more. (This command was previously
labeled "Rearrange Layout".)

For more information, see Create Dashboard Layouts for Different Device Types on
page 2801.

Quickly switch between the ISO-8601 calendar and the standard Gregorian cal-
endar

With Tableau 2019.3, you can now change between using the week-based ISO-8601 calendar
and the standard Gregorian calendar from the Date Properties dialog.
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Date Properties [Sample - Superstore] x Date Properties [Sample - Superstore] X
Default calendar: | Standard Gregorian ~ | Default calendar: | 1S0-8601 Week-Based ~
Week start: |Sur1da\-I w | Week start: Monday

Fiscal year start: |Jar1l.|an-I ~ |

Date format: |.|'-\utomaﬁc ~ |

Date format is determined by your system
settings.

| OK, || Cancel | | OK, || Cancel |

The ISO-8601 week-based calendar can be used to create 4-4-5 Quarters, a way of splitting
each quarter into segments of 4, 4, and 5 weeks, a popular system in financial and retail
reporting.

For more information, see ISO-8601 Week-Based Calendar on page 1273.
More aggregations available for parameter actions

Parameter actions now support concatenation, first quartile, and third quartile aggregations.
Also, you can now create parameters while creating and editing a parameter action.

outa | dnsiyics + e i oo
G Education Academic Year = Rows SUM(D)
Dimensions 11f © » | College
abc College Sendes College Admissions
Abe Ethnicity Explore the distribution of SAT scores in different colleges
e Gender Marks . h,272 avg Score 1612 11,936
A Major Sl ! H |
H B L]

abe  Measure Names O Circle - ] %

= = - :

. & : ctions =

Color || Size | | Lal

A ] Actions let you create b data, dashboard objects, other workbook sheets, and the

web,

Measures Detail | Tooltip f 7

- | Name: Run On Source Fiekis
w SELITED *: G o selecton's Fratq Salact Colage Selection's Frst Quartie
# Math o2 NI |- Selection’s Third @ Select College Selection's Third Quartie h
4 TolalScore o QEEDE |
i True Average =Y Aveversan W
i Verbal |

“ =Y avcowriting S N
# Writing — . — — /
# Measure Values | Add Acton > | Edit... Remaove
College

[ show actions for all sheets in this workbock o
B &res 2 Sciences -
M s

Parameters.
# Selection's First Qu..
# Selection's Third Q...

SAT Score

H Putlic Health

Use MAKEPOINT to convert projected coordinates into latitude/longitude

Convert projected coordinates into latitude and longitude values for use in spatial analysis and
spatial joins. When created on live data sources, this function allows you to join your data with
other spatial files using a calculated field, making it easy to create a data source for spatial
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analysis. For more information, see Spatial Functions on page 2245 and Join Spatial Files
in Tableau on page 1815.

Use DISTANCE to measure between points on a map

Calculate the distance between two related points on your map using the spatial function
Distance. You can specify kilometers, miles, meters, or feet as the unit of measurement. This
function can only be created with a live data source. For more information, see Spatial
Functions on page 2245.

stination: Los Angeles l
i
Chicago
ce: 1,749

& 2019 Mapbox & OpenStreetMap

Prepare, Author, and View Data on the Web

Connect to databases and tables with Tableau Catalog when web authoring (Data
Management Add-on required)

Tableau Catalog is available in the Data Management Add-on to Tableau Online and Tableau
Server. When Tableau Catalog is enabled in your environment, in addition to navigating and
connecting to published data sources from the On this site tab, you can connect to more kinds
of data, like databases and tables. For more information, see Creators: Connect to data on
the web on page 3135. For more information about Tableau Catalog, see "About Tableau
Catalog" in the Tableau Server or Tableau Online Help.
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Embed Ask Data into web pages

After you ask a question with Ask Data, an Embed Code icon appears in the toolbar. Click it to
copy code you can incorporate into any web page.

When web pages with Ask Data embedded in them load, Ask Data opens the data source
without a viz, waiting for users to ask a question.

To see Ask Data embedded in a web page, users must have a Tableau license and permission
to connect to the data source.

For more information, see Embed an Ask Data lens in a web page on page 1122.

Adjust relative date filters with Ask Data

To adjust a relative date filter with Ask Data, click words like “last”, “previous”, “next”, or
“following”. For more information, see Change fields, filters, and displayed data on
page 1115.

with Ship Date in the last 3 years X

1/1/2017 to 12/31/2019

Year

(O Previous year (® Last 3

(O This year (O Next =

() Following year
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Show top and bottom outliers in context with Ask Data

When you specify numerical limits like “top 5 countries”, Ask Data now shows those outliers in
the context of the complete list for a dimension.

For more information, see Numerical limits (top and bottom values) on page 1125.

sum of Internet Usage by Country, top 5 Countries by sum of Internet Usage Clear All

|Adjust your question or clear all to start over ‘

[E& Bar Chart -

Country In/ Qut of Top Values

icetand | M
Norvizy | B ou
sweden [
R ——————————————
Netherianas [
Finland |
korea, Rep. [N
switzeriand [
Canada [
germuda [
tuxembourg I
united Kingcom |
New zealand [
Faeroe Islancs [N
tieentenstein [INNEG_G_——
United States [

Add synonyms for field values with Ask Data

If you're a data source owner or Tableau administrator, you previously were limited to adding
synonyms for field names, but now you can add them for field values as well. For more
information, see Add Synonyms for Ask Data on page 1140.
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Field Details bt

Industry

Abc String Data Role -

w85 unigue values B Search
Value Synonyms

Banking Lenders >  Credit Unions x
Food & Beverages

Investment Management  Financial Advisors 3  Stock Analysts =

Insurance
Pharmaceutical RX x
Supermarkets Grocers

Search your Tableau site with improved results

When you search on Tableau Online and Tableau Server, you can now view a full page of
search results. These results are sectioned by type, and you can filter and sort the results for
increased precision. For more information, see Search Your Tableau Site on page 3189.
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Search Results
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o

Set context filters

You can now create context filters (Add to Context option in the Filters shelf) and dependent
filters (Only Relevant Values option in a filter control shown in a view).

by df [ 5 r- & T B
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Save and Publish Data Sources and Workbooks

Receive subscriptions as PDF attachments

Subscriptions email you a snapshot of your view or workbook at an interval you set, and now
you can receive these snapshots as PDF attachments. To set up a subscription as a PDF,
select Format > PDF or Image and PDF when creating a subscription in Tableau Online or
Tableau Server. For more information see Create a Subscription to a View or Workbook
on page 3249

& j donot-reply@tableau.com Laura Rodriguez b1

Changing fuel sources

Changing fuel sources.pdf _
| 90 KB
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Create a PowerPoint file from selected workbook sheets

When you want to create a PowerPoint file from your Tableau workbook or dashboard, you can
select which sheets and stories to include. Each selected sheet (or story point if exporting a
story) becomes its own slide in the generated PowerPoint file. For more information, see
Export Views from Tableau Desktop to Another Application on page 3032.
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Download PowerPoint *

Include

This View -
' This View

. Specific sheets from this dashbeoard
Specific sheets from this workbook

Collaborate with Tableau Online and Tableau Server

Share more content types

Get an easy-to-share link for projects, workbooks, data sources, and flows, in addition to views,
which you could previously share. For more information, see Share Web Content on
page 3243.

Finance o

Share... b

Rename. .
Move.,
Permissions..,
Change Crwmer,

Daleti...
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Version 2019.2

Added in version 2019.2

Customize Language

« Select from ten different languages for Tableau on
the facing page

Help Redesign
« Provide feedback more easily on page 101
Connect to and Prepare Data

« Connect to Anaplan data using certificates on
page 16

« Use features added to the Marketo connector on
page 101

» Connect to TabPy external services using SSL on
page 102

Design Views and Analyze Data

« Use parameter actions to set parameter values
interactively on page 102

» Pan, zoom, and explore with vector tile back-
ground maps on page 103

o Customize how your map looks with new map
styles and layers on page 103

» Replace sheets in dashboards on page 105

» Use Tableau connectors with Azure Active Dir-
ectory authentication on page 16

« Show and hide floating containers in dashboards
on page 106

o Customize reference line tooltips on page 106

» Disable the sort icon on page 106
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Prepare, Author, and View Data on the Web

Ask questions in a conversational style with Ask
Data on page 107

Apply simple calculations with Ask Data on

page 107

Create multiple sheets from Ask Data on page 108
See how people are using Ask Data on page 108
Additional enhancements to Ask Data on page 109
Create, edit, and remove parameters in web author-
ing on page 110

Save custom views with the Viewer role on page 110
Use parameters with stored procedures in Tableau
Online and Tableau Server on page 110

See your view's total marks and more in the status
bar on page 111

Drop field menu in web authoring on page 111

Save and Publish Data Sources and Workbooks

Export stories into PowerPoint on page 111

Collaborate with Tableau Online and Tableau Server

Discover the new face of Tableau Server and
Tableau Online on page 112

Subscribe yourself to existing data-driven alerts on
page 114

Customize Language

Select from ten different languages for Tableau

Tableau has added support for two new languages, Chinese (Traditional) and English (United

Kingdom). You can now set Tableau to display the user interface in one of ten languages:

o Chinese (Simplified)

o Chinese (Traditional)

o English (United Kingdom)
o English (United States)
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o French

« German

« Japanese
« Korean

o Portuguese
o Spanish

For more information, see Set your display language for Tableau Desktop or Change
language and locale for Tableau Online and Tableau Server.

In addition to supporting two new languages in all Tableau products, the help is also available
in these languages. To read the help in your preferred language, navigate to the bottom of the

main Tableau Help page, and select the language from the footer.
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Help Design

Provide feedback more easily

Ablue Send feedback icon is displayed in the bottom right corner of every Help page to make it
easier for you to send feedback about the content in a topic. Click the icon to let us know if a
topic is helpful to you, and also to comment on what needs improvement.

Tableau Desktop and Web Authoring Help

Connect to and Prepare Data

Before you begin vour analysis, vou must connect to your data and then set up the data
source. There are many optional configurations that you can make on the Data Source

page that Tableau uses to interpret and interact with your data.
The topics in this section describe how to connect to your data and use these
configurations in order to optimize your data source for analysis.
b

Connect to and Prepare Data

Connect to PostgreSQL + PostGIS and Pivotal Greenplum + PostGIS spatial data

Use Tableau to connect to spatial data in Pivotal Greenplum or PostgreSQL with the PostGIS
extension. With these new spatial connectors, you can use CustomSQL to filter and validate
spatial data, or use RAWSQL_SPATIAL functions to return spatial objects for advanced spatial
analysis. For more information, see Connect to Spatial Data in a Database on page 1799.

Use features added to the Marketo connector
The Marketo connector includes these new features:

o Use of the bulk API to retrieve data for the All Activities, Leads, and Leads by List - <list
name> tables, thereby reducing the number of API calls.

o Support for retrieving the number of API calls made using the Daily APl Usage and
Weekly API Usage tables so that you can monitor your APl usage and not exceed your

quota.
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o Access to all Marketo tables, enabling you to access data that was previously not avail-

able.

For information about the Marketo connector, see Marketo on page 555.

Connect to TabPy external services using SSL

In previous versions, SSL connections to TabPy were not supported. In Tableau Server
2019.2, you can configure SSL connections. Build visualizations using the Python language for
advanced analytics and machine learning in a secure environment. TabPy can be hosted
remotely from Tableau Server, and you can configure SSL connections to protect data in
transit. For more information, see Pass Expressions with Analytics Extensions on

page 2690.

Design Views and Analyze Data

Use parameter actions to set parameter values interactively

Use parameter actions to let your audience change a parameter value through direct
interaction with a viz, such as clicking or selecting a mark. You can use parameter actions to
drive reference lines, calculations, filters, and SQL queries. For more information, see

Parameter Actions on page 1516.

Ref Date

Stock performance over time i
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Parameter actions open up new possibilities for creating summary values and statistics without
using calculations. You can set parameter actions to let users select multiple marks that are
automatically aggregated into a single parameter value. For example, a parameter action
could show the AVG(Sales) or COUNTD(Orders) for currently selected marks.
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Pan, zoom, and explore with vector tile background maps

Maps in Tableau now use vector tiles for quicker geographic data exploring. Maps now appear
sharper and smoother when you pan and zoom, and labels and icons dynamically resize or
reshape to fit your view. The new vector tile maps replace the underlying technology that
powers Tableau background maps for a smoother and crisper experience. The background
cartography for Tableau maps has also been updated.

Mount Vernon

Hackensack

Fort'Lee

Jersey City

New York

Customize how your map looks with new map styles and layers

You can customize how your Tableau map looks with three new built-in map styles: Streets,
Satellite, and Outdoors. Each of these styles includes new map layer options, such as Points of
Interest and Building Footprints, so that you can customize what information your analysis
displays. For more information, see Customize How Your Map Looks on page 1965.
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Create spatial fields and use spatial joins with MakePoint

Turn latitude/longitude values from text files, excel, or other data sources into spatial fields with
the function MakePoint. This function allows you to spatially join your lat/lon data by using a
calculated field; making it easy to aggregate your data. For more information, see Spatial
Functions on page 2245 and Join Spatial Files in Tableau on page 1815.

I get_it_done_pothole_reques. . @ council_districts_datasd.shp
Jain X
<) @ @ @
/ .
Inner Left Right Full Quter
Data Source coundil_districts_datasd...

MAKEPOINT([Lat], [Long]) Intersects Geometry

Create origin-destination maps using MakelLine

Turn related points on your map into origin-destination maps using the spatial function
MakeLine. For more information, see Spatial Functions on page 2245.

104 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help

Flight Paths

& 215 bapbes § OpsnSirela

Replace sheets in dashboards

You can quickly select a dashboard sheet and replace it with another, while retaining any
padding, border, or background color, and your overall layout.

For more information, see Create a dashboard, and add or replace sheets on page 2741.

'|

Use text for navigation buttons in dashboards

Button objects let your audience navigate from one dashboard to another, or to other sheets or
stories. Previously, these buttons could only display images, but now you can instead display
text to indicate a button's destination.

For more information, see Detailed options for Navigation and Download objects on
page 2746.
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Open the flight delays viz

Show and hide floating containers in dashboards

Show/Hide buttons let dashboard viewers toggle the visibility of floating layout containers,
revealing them only when necessary. These buttons are particularly helpful when you want to
temporarily hide groups of filters to reveal more of a visualization.

For more information, see Size and Lay Out Your Dashboard on page 2755.

X msmieseR =

Customize reference line tooltips

Add custom text and fields to reference line tooltips. For more information, see Reference
Lines, Bands, Distributions, and Boxes on page 2502.

Disable the sorticon

You can now disable the sorticon in a view, which allows you to control sorting of the view
before publishing. For more information, see Sort Data in a Visualization on page 1447.
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Prepare, Author, and View Data on the Web

Ask questions in a conversational style with Ask Data

As new questions occur to you in Ask Data, you can quickly revise existing ones in a natural,
conversational style. In the text box reading “Adjust your question or clear all to start
over”, do any of the following:

« Add functions with phrasing like “by country” or “in December”.

» Replace fields by typing “replace [existing field name] with [new field name]’
« Remove fields by typing “remove [field name]”

o Clear the viz by typing “reset” or “clear”.

Search to add fields or filters to the visualization

For more information, see Automatically Build Views with Ask Data on page 1109.

Apply simple calculations with Ask Data

To enhance data analysis, Ask Data supports simple calculations between two measures,
which you can apply using the symbols below:

+ sums the measures
- produces the difference between them
* multiplies

[ divides
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sum of Profit / sum of Sales

For more information, see Apply simple calculations on page 1120.

Create multiple sheets from Ask Data

You can quickly create multiple different vizzes from a data source and then save themin a
new workbook. Below any viz in Ask Data, simply click the Add Sheet icon to the right of
named sheets.

Sheet 1 Sheet 2 (g

For more information, see Embed and Save Vizzes from Ask Data on page 1122.

See how people are using Ask Data

If you're a data source owner or Tableau administrator, Ask Data provides a dashboard that
reveals the most popular queries and fields, the number of visualization results that users
clicked, and other helpful information. Filters let you narrow data down to specific users and
time ranges. These stats help you optimize data sources to increase the success of your
users.
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Ask Data Usage Analytics

567 362

Unique Users User Queries Suggested Results
Usage over Time Top Users Top Fields

.....

usar
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For more information, see Optimize Data for Ask Data on page 1132.

Additional enhancements to Ask Data

« Ask Data now supports Heat Map vizzes, which are great for revealing outliers from many
dimensions and measures.

average Days to Ship Scheduled and sum of Profit

by Customer Name and by Region asaheat map

Region
Customer Name i Central East South West
Zuschuss Donatelli
Zuschuss Carroll
Yoseph Carroll
Yana Sorensen
Xylona Preis
William Brown

« When you hover over continuous measures at left, histograms appear in tooltips, quickly
showing the range of available values.
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R Days to Ship Actual

abc Segment

B3 Ship Date Details

Abc  Ship Mode =H# Number
=abe  Ship Status 8 unique values

© State Formula

Abc Sub-Category

DATEDIFF({ 'day"’, [order Date],[Ship Date])

=4 Days to Ship Actual Value Distribution

=4 Days to Ship Schedul... Minimum 0 | ——

I
i . |

it Ll Maximum 7

=3 Number of Records Average 3.058

4 Profit

o Terms like "Date", "Year", and "Month" are now reserved for use in analytical functions
so should be avoided in field names. For the complete list of reserved terms, see Field
names that Ask Data uses for analytical functions.

« Synonyms for field names can now be changed only by data source owners and
Tableau administrators, providing a more consistent experience for users. For more
information, see Add Synonyms for Ask Data on page 1140.

Create, edit, and remove parameters in web authoring

Now in web authoring, you can create parameters to replace constant values in calculations,
filters, and reference lines. For more information, see Create Parameters on page 1218.

Save custom views with the Viewer role

Previously, creating custom views required a Creator or Explorer license, but now Viewers can
create them too. Anyone with the URL for a custom view can see the filters and other changes
that are applied. However, only public custom views created by Creators and Explorers are
visible to others in the Custom Views dialog box.

For more information, see Use Custom Views on page 3224.

Use parameters with stored procedures in Tableau Online and Tableau Server

When creating a data source in Tableau Online or Tableau Server, you can now add a stored
procedure with parameters to a join. When a stored procedure includes parameters, you'll see
a dialog that displays parameters and their types as defined in the database, and edit those
parameter values. For more information, see Use a Stored Procedure on page 972.
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See your view's total marks and more in the status bar

The status bar in the lower left corner of your browser shows authors information about their

view, including selected marks compares to total marks, rows and columns, and aggregations.

For more information on the status bar, see Status Bar Information.

Drop field menu in web authoring

When creating or editing a view on the web, you can change the aggregation of a field using the
drop field menu. Just right-click+drag (on macOS, left-click+Option+drag) a field on any card or

shelf like rows, columns, or Filters, and select the aggregation type you need. This drops the

field onto the card or shelf with the aggregation you selected.

Drop Field

Which fleld do you want to drop?

Days to Ship Actual

SUM{Days o Ship Actual)
AVG{Days to Ship Actual)
MEDIAM(Days to Ship Actual)

# CNT{Days to Ship Actual)

CHTD{Days to Ship Actual)

E MIN{Days to Ship Actual)

iF  MAX{Days to Ship Actual)

# STDEV(Days to Ship Actual)

STDEVP{Days to Ship Actual)

# VAR(Days to Ship Actual)

Save and Publish Data Sources and Workbooks

VARP({Days to Ship Actual)

ATTR(Days to Ship Actual)

Cancel

Export stories into PowerPoint

Now when you use Export to PowerPoint to export your workbook, each story points becomes

as separate slide in your Tableau-generated PowerPoint file. For more information on exporting
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your workbook into PowerPoint, see Export Views from Tableau Desktop to Another
Application on page 3032.

Collaborate with Tableau Online and Tableau Server

Discover the new face of Tableau Server and Tableau Online

Your Tableau site now makes it easier to get started and locate relevant content with several
new pages and navigation changes.

Quickly access your most important content

When you sign in to Tableau Online or Tableau Server, you'll be greeted by a new Home
page. On Home, you can see visualizations you recently viewed, find your newest favorite
content, and discover what's popular on your site, all in one place. The welcome banner and
actions at the top of the page are tailored to your site role to help you get started.

+F Home

Favorites Seeal

$56.18K

AETAEN

w

Product * o Forecast L Sales (Consumer) x -

Dedicated Favorites and Recents pages give you access to all of your most-important
content. Use the sort and filter options on the right side of each page to find exactly what you
are looking for. Add or remove favorite content at any time by clicking that content's star icon.
Along with the Home page, you can access the Favorites and Recents pages from the left
navigation panel.
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Navigate your site with ease

The new left navigation panel lets you quickly jump between important pages on your site,
including the Explore page, where you can see all the content on your site in one place. The
navigation panel is responsive to screen sizes and can be collapsed to give you optimal space
for browsing.

N

T _0 apsesiee At |
R .
+T Favorites
default b

(A} Home
(7} Explore

v Favorites

View your data with minimal interruption

When you explore or author a visualization in Tableau Online or Tableau Server, the left
navigation panel disappears to give you more space for analysis. The compact header allows
you to navigate through project hierarchy, search the site, and access your favorites as needed.

{ DmaDewils CD AskData [0 View:Original ¢\ Alents [=] Metrics (5 Subscribe | |2} Comments [, Full Screen

Business = Global Indicators A

Birth Rate Bin
W Above 3%
15-3%
W Below 15%
Population Total
o.oM
] Tourism 500.0M
® 1,000.0M

1,350.7Mm
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To learn more about navigating your Tableau site, see Tour Your Tableau Site on
page 3104.

Subscribe yourself to existing data-driven alerts

When you select Alerts in any view, a new panel shows alerts that already exist for the viz you
are viewing. Just select "Add Me" to add yourself to an existing alert. To create an alert that is
visible for others, select Make visible to others when creating the alert. Alerts created prior
to 2019.2 are not visible to others, but can be updated to be. To learn more, see Send Data-
Driven Alerts from Tableau Online or Tableau Server on page 3254.

Alerts hd

Create

Data alert - Changing fuel sources

Actions =
Above or equal to 500
Mever triggered
Data alert - fuel sources below 100 Add Me
Below 100
1 recipient

Version 2019.1

Added in version 2019.1

Help Redesign
« Right-navigation menu on page 116

Connect to and Prepare Data
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Connect to Azure SQL Data Warehouse on the next
page

Connect to Google Ads on the next page

Connect to Google Drive on the next page

Connect to MariaDB on page 117

Use SSL with TIBCO Data Virtualization connector
on page 117

Use new Snowflake connector features on page 117
Use Integrated Authentication with the Denodo con-
nector on page 117

Features Introduced in Previous Versions of
Tableau Desktop and Web Authoring on page 13

Design Views and Analyze Data

Sort on two axes and other nested sorting improve-
ments on page 117

New geocoding data for maps on page 117

Give dashboard items unique names for easier iden-
tification on page 118

Flexibly target web content from dashboards on
page 118

Create phone layouts automatically on page 120

Prepare, Author, and View Data on the Web

Enjoy improved content browsing on page 121

Ask Data to automatically create a viz on page 122
Use new cloud connectors for web authoring on
page 123

Prepare data for web authoring with these improve-
ments on page 123

Pan, zoom, and explore with vector tile background
maps on page 123

See new demographic data in Tableau Online and
Tableau Public on page 124
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o Toggle between desktop and mobile layouts on
page 124
« Filter improvements on page 125

Save and Publish Data Sources and Workbooks

o Export and download workbooks to PowerPoint on
page 125
» Preview device layouts on the web on page 126

Collaborate with Tableau Online and Tableau Server

« Get notified when subscriptions are suspended on
page 127

Help Design

Right-navigation menu

Updates have been made to help you navigate our content, including a new right-hand menu
to quickly scan and select different topics on a page.

Connect to and Prepare Data

Connect to Azure SQL Data Warehouse

Use the Azure SQL Data Warehouse connector to connect Tableau to your Azure SQL Data
Warehouse database. For more information, see Azure SQL Synapse Analytics on
page 480.

Connect to Google Ads

You can now connect Tableau to your Google Ads account. For more information, see
Google Ads on page 505.

Connect to Google Drive

Directly access flat files on your Google Drive using the Google Drive connector. For more
information, see Google Drive on page 520.
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Connect to MariaDB

Use the MariaDB connector to connect Tableau to your MariaDB data. For more information,
see MariaDB on page 554.

Use SSL with TIBCO Data Virtualization connector

You can now connect Tableau to TIBCO Data Virtualization using SSL. For more information,
see TIBCO Data Virtualization on page 660.

Use new Snowflake connector features

The Snowflake connector now supports using OAuth as an authentication method. Support for
Booleans and for Median and Percentile functions has also been added. For information about
connecting Tableau to a Snowflake data warehouse, see Snowflake on page 641.

Use Integrated Authentication with the Denodo connector

You can use Integrated Authentication as an authentication method when connecting Tableau
to Denodo. For more information, see Denodo on page 493.

Maintain case sensitivity when working with Microsoft Excel data

If you need to maintain case sensitivity for your data when performing joins, for example
Japanese data that is Kana-sensitive, you can enable the Maintain Character Case (Excel)
option from the Data menu. When this option is enabled, Tableau uniquely identifies values with
different casing instead of combining them, resulting in a different number of rows.

For more information, see Join Your Data on page 883

Design Views and Analyze Data

Sort on two axes and other nested sorting improvements

With Tableau Desktop 2019.1, the nested sort feature has received a significant upgrade. New
capabilities of nested sort include sorting on two axes, accessing nested sort through the sort
dialog, and selecting a single field to perform a nested sort on. For more information, see Sort
Data in a Visualization on page 1447.

New geocoding data for maps

The geocoding database behind your Tableau map has been updated. While most maps will
appear the same as earlier versions of Tableau, in some cases, the shape of the data may look

Tableau Software Version: 2021.2 117



Tableau Desktop and Web Authoring Help

slightly different, or contain different geocoding data. For information about specific location
data, see Supported Map Data.

Give dashboard items unique names for easier identification

To better distinguish between dashboard items, you can now rename them using the Item
hierarchy area of the Layout pane or the drop-down menu for each object on the canvas.

For more information, see Size, position, reorder, and rename individual dashboard
items on page 2765.

Flexibly target web content from dashboards

For the first time, you can specify the precise target for a URL action, choosing between a new
browser tab or a Web Page object. If a dashboard has multiple Web Page objects, you can
target each of them with a unique URL action, creating visually dynamic designs. And
managing multiple Web Page objects is far easier now that you can rename them.
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URL Target

GI Mew Browser Tab

(@ web Page Object |ﬁm:&anmrremslnnmhon
(") Browser Tab if No Web Page Object Exists

In this example, selecting marks in the view passes latitude and longitude parameters to two
different Web Page objects, each targeted by a unique URL action. (Amazing website images
courtesy of earth.nullschool.net.)
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Ocean Currents

- Wind Patterns

For more information, see Open a web page with a URL action on page 1510 and
Interactively display a web page in a dashboard.

Create phone layouts automatically

By default, optimized phone layouts are now automatically generated whenever you create a
new dashboard. To create them only for specific dashboards, from the Dashboard menu,
deselect Auto-Generate Phone Layouts.

The default Use automatic layout option automatically synchronizes any changes to the
Default dashboard, saving you time. If you choose Edit layout myself, the Phone layout
becomes fully independent, so you'll need to manually add and arrange items to reflect
changes to the Default dashboard.
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| want to:

® Use automatic layout

Edit layout myself

For more information, see Create Dashboard Layouts for Different Device Types on
page 2801.

Prepare, Author, and View Data on the Web

Enjoy improved content browsing

With Tableau Online and Tableau Server 2019.1, you have a new way to browse shared
content. When you open a project, you will be able to see all the content that project contains—
workbooks, views, data sources, flows, and nested projects—in a single grid or list. Locating
content is easier, because you no longer need to navigate separate pages for different content
types. For more information, see Tour Your Tableau Site on page 3104.
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Ask Data to automatically create a viz

Ask Data introduces an entirely new way to interact with your data, letting you type a question
and instantly get a response right in Tableau. Answers come in the form of automatic data
visualizations, with no need to manually drag-and-drop fields or understand the nuances of
your data’s structure.

Ask Data lets you ask sophisticated questions naturally, with support for key analytical
concepts like time series and spatial analysis, and an understanding of conversational phrases

”

like “last year”, “earliest”, and “most popular”.

Ask Data is available for all user roles with direct access to data sources: Creators, Explorers,
and Interactors.

For more information, see Automatically Build Views with Ask Data on page 1109.
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Use new cloud connectors for web authoring

Use the Box, Dropbox, Google Drive, Google BigQuery, and OneDrive connectors to connect
Tableau Online or Tableau Server to your data. For more information, see Creators: Connect
to data on the web on page 3135.

Prepare data for web authoring with these improvements

In 2019.1, authors connecting to a new data source in Tableau Online or Tableau Server can
now Run Initial SQL on page 736, and can Connect to a Custom SQL Query on page 959,
and add a Join Calculation to resolve mismatches between fields in a join.

Pan, zoom, and explore with vector tile background maps

Maps created on or published to Tableau Online or Tableau Public now use vector tiles for
quicker geographic data exploring. Maps now appear sharper and smoother when you pan and
zoom, and labels and icons dynamically resize or reshape to fit your view. The new vector tile
maps replace the underlying technology that powers Tableau background maps for a smoother
and crisper experience. The background cartography for Tableau maps has also been
updated.
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See new demographic data in Tableau Online and Tableau Public

Tableau Online and Tableau Public have a new, different source of demographic data than
Tableau Desktop. If your map uses a demographic data layer in Tableau Desktop, you may
notice some slight differences when that map is published to Tableau Online or Tableau
Public, including the time period and value breaks in a legend. In addition, maps that use the
“Block Group” Data Layer option in Tableau Desktop will be automatically updated to “Census
Tract” when published to Tableau Online or Tableau Public. Six demographic data layers that
appear in Tableau Desktop will be absent when maps are published to Tableau Online or
Tableau Public:

« Population growth projections

« Household growth projections

« Housing units growth projections

« Effective Buying Income (median)

o Year structure built (median)

o Length of Residence (average in years)

Publishing maps from Tableau Desktop to Tableau Server will not result in any discrepancies.

Toggle between desktop and mobile layouts

If Tableau Online or Tableau Server users find a Phone or Tablet layout too limiting, they can
click See Desktop Layout in the toolbar. This toggle button lets users switch back to the
mobile device layout at any time.

124 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help
m Comments [ ] SeeDesktop Layout i3, Full Screen

For more information, see Confirm which layout a device will display on page 2814.

Filter improvements

Use Ctrl-click (control-click on a Mac) to select multiple values in a multi-value filter in the view.
The selected values can be non-contiguous and are indicated with a gray highlight. When the
values are selected, you can then click any one of their check boxes to clear or choose the
values at the same time.

Save and Publish Data Sources and Workbooks

Export and download workbooks to PowerPoint

Export all the views and dashboards in your workbook into PowerPoint with one click. This
option creates a new PowerPoint file with static images of each sheet in your workbook. When
the file is generated from Tableau Online or Tableau Server, the new PowerPoint file provides a
link back to the workbook where you can see the most up-to-date data and interact with it. To
optimize your images for PowerPoint, select Size > PowerPoint (1600x900) in the dashboard
layout. For more information, see Export Views from Tableau Desktop to Another
Application on page 3032.
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Preview device layouts on the web

To see how your designs appear on mobile devices, click Preview device layouts in the
browser when publishing is complete. Then choose a device type above the viz, and a specific
dashboard from the menu at right.

For more information, see Comprehensive Steps to Publish a Workbook on page 3058.
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Preview Device Layouts
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Collaborate with Tableau Online and Tableau Server

Get notified when subscriptions are suspended

When you subscribe to a view or a workbook, you receive an email snapshot of that content at
regular intervals. Now, you'll receive an email notification if something caused your subscription
to fail, with links to resume or delete the failing alert. For more information, see Create a
Subscription to a View or Workbook on page 3249.

Version 2018.3

Added in version 2018.3

Help Redesign

o Search, navigation, and layout improvements on the
next page

Connect to and Prepare Data

« Store extract data in multiple tables on the next page
o New Other Databases (JDBC) connector on
page 129
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Design Views and Analyze Data

« Build density maps and charts on the facing page

» Use set actions to let your audience change set val-
ues on page 130

o Encrypted RServe connections on page 131

» Navigate from dashboards more easily on page 132

o Transparent worksheet backgrounds in dash-
boards on page 133

o Automatically rearrange phone layouts on page 134

Prepare, Author, and View Data on the Web

o Improved content browsing on page 135

o Add image objects to your dashboards on page 135
« Duplicate as Crosstab on page 136

« Create, move, and resize annotations on page 136

Help Redesign

Search, navigation, and layout improvements

Search results within the product help have been expanded to include results for all Tableau
products and help articles. Help layout and navigation, such as table of contents placement
and breadcrumbs, have been updated to create a more consistent cross-product help
experience.

Connect to and Prepare Data

Store extract data in multiple tables

You can configure you extract to have its data stored in multiple tables. Storing your extract
data in multiple tables can potentially improve performance and help reduce the file size. For
more information, see Decide how the extract data should be stored on page 1022.
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New Other Databases (JDBC) connector

Use the Other Databases (JDBC) connector to connect to files or database types not listed
under Connect and that use a database driver thatimplements the JDBC (Java Database
Connectivity) standard. For more information, see Other Databases (JDBC) on page 670.

New supported spatial files

Use the Spatial Files connector to connect to TopoJSON files, Esri File Geodatabase, and multi-
layer KML (Keyhole Markup Language) files using the spatial file connector. For more
information, see Create Tableau Maps from Spatial Files on page 1855.

Design Views and Analyze Data

Build density maps and charts

Create and interact with in Tableau Desktop, Tableau Online, or Tableau Server

Use the density mark to create maps and charts that can help you identify "hot spots" in your
data. The density mark lets users see insights into densely populated data and visualize it as a
smooth surface which can reveal patterns or relative concentrations that might otherwise be
hidden due to overlapping marks. For more information on building density maps and charts,
see Create Heatmaps that Show Trends or Density in Tableau on page 1910, Build with
Density Marks (Heatmap) on page 1600, and Density Marks.
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Use set actions to let your audience change set values

Create in Tableau Desktop for interaction in Tableau Desktop, Tableau Server, or Tableau
Online

Let your audience select what values are in a set by directly interacting with marks on a viz.
You can use set actions to visually drive calculations and create visualizations with multi-
faceted comparative analysis like proportional brushing.

Set actions can be used across multiple sets for more complex interactions. In this example,
sets and calculated fields are working together with set actions for Category and Sub-
Categories to update the viz based on what marks are selected. When a user clicks a category,
its subcategories are displayed. When a user clicks a subcategory, its manufacturers are
displayed. For more information, see Set Actions on page 1540.
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Asymmetric Drill Down

Category Asymmetric Sub-Category

Furniture 4742 000
Office Supplies $719,047
Technology $836,154

[

Set actions must be created in Tableau Desktop to be available for use in Tableau Online and
Tableau Server.

Encrypted RServe connections

Connect to RServe as an external service over an encrypted channel from Tableau Desktop.
Transfer data with an SSL/TLS secured connection for RServe integration. For more
information, see Pass Expressions with Analytics Extensions on page 2690.
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External Service Connection >
Select an External Service

RServe v
Specify a server name and a port

Server: | DavyJonesLocker v | Port: |4812 |

[+] 5ign in with a username and password

Lisername; |Tableau |

Password: ||-|-|-| |

[+] Require S5L
Custom configuration file is spedfied (dick to change)...

Test Connection [ ok | cancel |

Navigate from dashboards more easily

Two new dashboard features make navigating to other sheets much easier. Both maintain
selected filters and marks and let you navigate to sheets published as separate views (without
visible tabs).

« The Button object provides a quick way to navigate from one dashboard to another, or to
other sheets or stories. To reveal a button's destination, add a custom image and
informative tooltip text that appears when users hover over the object.

For more information, see Add dashboard objects and set their options on
page 2743.
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o The Go to Sheet action, which you can create only in Tableau Desktop, lets users
navigate to other dashboards, sheets, or stories when they click on a mark or a tooltip
menu item.
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For more information, see Actions and Dashboards on page 1566.

Transparent worksheet backgrounds in dashboards

To make a worksheet transparent, set its background color to None. Visually integrate
elements across your entire dashboard by combining transparent worksheets with transparent
filters, highlighters, and parameters. For more information, see Visually integrate elements

with transparency on page 2771.
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Airlines serving international destinations nonstop fram
Seattle Tacoma International Airport since 2010.

Automatically rearrange phone layouts

As you adjust dashboard items on a phone layout, click the pop-up menu to the right of Phone,

and select Rearrange layout to optimize the placement of filters, remove white space, and
more.

In the example below, filters are automatically moved higher so phone users don't need to
scroll down to see them.

Dashboard Layout *| DevicePreview  Devicetype « Phone

Default I
~ Phone =

[ Device revew [N
| Delete layout

For more information, see Create Dashboard Layouts for Different Device Types on
page 2801.
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Prepare, Author, and View Data on the Web

Improved content browsing

With Tableau Online and Tableau Server 2018.3, you can get a sneak preview of our
reorganized web authoring environment (Ul). The new Ul enables you to see multiple content
types—views, workbooks, data sources, flows, projects—in one grid or list. For example, you
can now see all contentinside a particular project and its sub-projects.

This new experience intends to make content discovery more intuitive, and it’s the firstin a set
of planned changes that are aimed at improving self-service and governance of your Tableau
content.

To try the new Ul, ask your administrator to enable the site-level setting we’ve provided for it.
For more information, see Preview the Updated Content Browsing Experience in the Tableau
Server 2018.3 Help (this article applies to Tableau Online, too).

After you get access to the new Ul, sign in to our Early Feedback site. There you can share your
thoughts with us and get our regular development updates.

Add image objects to your dashboards

You can now add images to dashboards when authoring on the web. The new Image object lets
you adjust image fit, add a target URL that opens when the image is clicked, and add alt text,
which improves the accessibility of your dashboard for those who use screen readers.

While viewing a dashboard on the web, click Edit. From the Objects section at left, drag Image
to the dashboard on the right.

For more information, see Add dashboard objects and set their options on page 2743.
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Duplicate as Crosstab

To create a new cross-tab sheet based on the data in the current sheet in Tableau Online or
Tableau Server, right-click the sheet tab (control-click on Mac) and select Duplicate as
Crosstab. This inserts a new worksheet into your workbook and populates the sheet with a
cross-tab view of the data from the original worksheet.

Create, move, and resize annotations

Create and delete annotations by right-clicking the view (in a worksheet or dashboard), and
then selecting the type of annotation: point, mark, or area. Click the annotation to select it, then
drag to move it, or click a selection handle to resize it. Right-click the annotation again to edit or
remove the annotation.

Version 2018.2

Added in version 2018.2

Install and Deploy Tableau

 Install Tableau Bridge separately from Tableau
Desktop on page 138

Connect to and Prepare Data

» Join spatial files on page 138
« Enhancements for Intuit QuickBooks Online con-
nector on page 138

Design Views and Analyze Data

« Perform a nested sort with one click on page 138

« Extend functionality with dashboard extensions on
page 139

» Visually align dashboard items with a grid on
page 140
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Precisely position and size floating items with
arrow keys on page 140

See a preview while dragging floating dashboard
items on page 140

Float transparent filters, parameters, and high-
lighters over dashboards on page 141
Automatically optimize dashboard layouts for
mobile devices on page 141

Show negative values on a log axis on page 142
Use ISO 8601 date standard in calculated fields on
page 143

Prepare, Author, and View Data on the Web

Keyboard shortcuts for web authoring on page 143
Create multi-connection data sources and cross-
database joins on page 143

Union your data on the web on page 144

Pivot Data on the web on page 144

Copy data on the web on page 144

Schema search on page 144

Annotation improvements on page 145

Edit Axis button on axes on page 146

Better control over sorting on page 146

Collaborate with Tableau Online and Tableau Server

Include colleagues on data conversations with
@mentions on page 146

Save and Publish Data Sources and Workbooks

Check how your workbook will look in an older ver-
sion on page 147
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Install and Deploy Tableau

Install Tableau Bridge separately from Tableau Desktop

Tableau Bridge is now a stand-alone client that you install separately from Tableau Desktop.
For more information about Tableau Bridge requirements, compatibility with previous versions
of Tableau Desktop, and the installation process, see Install Tableau Bridge in the Tableau
Online Help.

Note: If you install Tableau Bridge on the same computer as Tableau Desktop, you can start
Tableau Bridge from the Server menu like you did in previous versions.

Connect to and Prepare Data

Join spatial files

You can now join two spatial files, spatial database tables (Microsoft SQL Server only), or
spatial fields across two data sources. For more information, see Join Spatial Files in
Tableau on page 1815.

Enhancements for Intuit QuickBooks Online connector

There are several changes and enhancements to the Intuit QuickBooks Online connector that
provide you with more flexibility. New transaction types are included in the Sales and Expenses
Line Items table: Vendor Credit, Credit Memo, Journal Entry, Deposit, Estimate, Bill Payment,
Payment, Purchase Order and Refund Receipt. Additionally, account information has been
added to Credit Memo and Vendor Credit.

Individual transaction tables now have a new field called "Transaction Type" so you can join
other tables to the Sales and Expenses Line ltems table.

Design Views and Analyze Data

Perform a nested sort with one click

You can now use a nested sort operation without having to create calculated fields or combine
dimensions. For more information, see Nested sorts on page 1452
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Extend functionality with dashboard extensions

Extensions increase dashboard functionality with custom objects created by third-party
developers. With extensions, you can add unique features to dashboards or directly integrate
them with applications outside Tableau.

Adding an extension is easy. In Tableau Desktop or the web-authoring mode of Tableau Online
or Tableau Server, simply drag the Extension object to a dashboard. Then click either
Extension Gallery to choose from all available extensions, or My Extensions to select an
extension you previously downloaded. (To directly browse the Extension Gallery, go to
extensiongallery.tableau.com.)
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For more information, see Use Dashboard Extensions on page 2839.

Visually align dashboard items with a grid

To present a visually consistent design, arrange and size dashboard items over a grid. Choose
Dashboard > Show Grid, or quickly toggle the grid on and off by pressing the G key.

Loo I . o

For more information, see Size, position, reorder, and rename individual dashboard
items on page 2765.

Precisely position and size floating items with arrow keys

To precisely position a floating item, press arrow keys to move 1 pixel, or Shift+arrow keys to
move 10 pixels. To resize items, add Alt (Windows) or Option (macOS) to the shortcuts above.

See a preview while dragging floating dashboard items

To give you a clear picture of how moved items will look in a new location, a preview appears
while you drag them.
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Float transparent filters, parameters, and highlighters over dashboards

To visually connect filters, parameters, and highlighters to related data, float these items, which

are now transparent by default. Text always remains fully opaque, maintaining legibility.

Select Region:
(s) (AD)
Midwest
Northeast
South
West

For more information, see Tile or float dashboard items on page 2763.

Automatically optimize dashboard layouts for mobile devices

When you create a device layout, Tableau Desktop now automatically optimizes for the device

type, adjusting the arrangement of dashboard items to best fit a phone or tablet. Often, these
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automatic layouts will address all the needs of your mobile users, but you can always
customize a layout further.

For more information, see Create Dashboard Layouts for Different Device Types on
page 2801.
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Show negative values on a log axis

In Tableau Desktop and web authoring, when you select Logarithmic scale for an axis, you
now have the option to specify Symmetric to display data that contains 0 or negative values
on a log scale axis. For related details, see Change the axis scale to reversed or

logarithmic on page 2908.

142 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help

Sales and Profit by Customer it dois [Profit) %
' General Tick Marks
b
@® Automatic [ Include zero

() Uniform axis range for all rows or columns
O Indepandent axis ranges for each row or column
O Fixed

Autormatsc *  Automatic -

-17.978.9681236 240568866189

Scale
[[] Reversed
Logarithmic
O Positive (& Symmetric
Axis Titles
Title
Profit

Subtitle

Use ISO 8601 date standard in calculated fields

When creating a date calculation, you now have the option to use the ISO 8601 international
standard to resolve the calculation. For more information, see Date Functions on page 2170.

Prepare, Author, and View Data on the Web

Keyboard shortcuts for web authoring

Use keyboard shortcuts to quickly create and edit views on the web. For more information, see
Shortcuts for web authoring.

Create multi-connection data sources and cross-database joins

Add a second connection to your data source and combine tables from different databases
using a cross-database join. Your multi-connection data source can be saved for others in your
organization to use. To learn more about cross-database joins, see Join Your Data on

page 883.
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Union your data on the web

Can create new unions and add to unions from the same connection in Tableau Online and

Tableau Server. To learn more, see Union Your Data on page 942.

Pivot Data on the web

When working with file-based data sources on the web, you can pivot your data from crosstab
format into columnar format. For more information, see Pivot Data from Columns to Rows
on page 988.

Copy data on the web

Copy values in your data grid by selecting the values and then pressing Ctrl+C (Windows) or
Command+C (macOS). Alternatively, to copy values in the metadata grid, select the values,
right-click, and select Copy.

Schema search

Quickly locate data fields in the Data pane using schema search.
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Annotation improvements

Create and delete annotations by right-clicking the view (in a worksheet or dashboard), and
then selecting point or mark annotation. Right-click the annotation again to edit or remove the

annotation.
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Edit Axis button on axes

You now have two ways to open the Edit Axis dialog box. Hover near the top of the axis
(vertical axis) or to the right (horizontal axis) and click the drop-down arrow that appears. Or,
double-click the axis.

Rental Prices: Scatter Plot Rental Prices: Scatter Plot

-

@ Edit Axis...
R

s PP LR R WL | S LR AT

Better control over sorting

You can now access the Sort dialog box by right-clicking a dimension field on the Rows or

Columns shelves in a view.

Collaborate with Tableau Online and Tableau Server

Include colleagues on data conversations with @mentions

To engage people in a conversation about compelling data you find in a view, @mention them
in comments. As you begin to type a name, matching people with Tableau accounts at your
organization appear in a list you can choose from. For more information, see Comment on
Views on page 3259.
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Quickly create data alerts on customized views

If you've changed a view (for example, by adjusting filters), you can now create alerts without
first saving a custom view. For more information, see Send Data-Driven Alerts from
Tableau Online or Tableau Server on page 3254.

Save and Publish Data Sources and Workbooks

Check how your workbook will look in an older version

It's important to know how your workbook will be affected before you export it to an older version
of Tableau. The File > Export As command now gives you a clear picture, telling you if your
workbook will change and which features are unsupported.

Version 2018.1

Added in version 2018.1

Tableau Licensing
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e New JDBC driver for SAP HANA connector in Win-
dows has arrived on page 16

Install and Deploy Tableau

o Register Tableau Desktop from the command line
on the facing page
e Mac OS system requirements on page 150

Connect to and Prepare Data

o Support for remote config files for SAP NetWeaver
Business Warehouse on page 150

e Connect to spatial columns in Microsoft SQL
Server on page 150

 New connector name on page 150

Design Views and Analyze Data

o Apply step lines and jump lines on page 150

« Tips for analytics objects on page 151

 Filter hierarchical data on page 152

o Hide a Viz in Tooltip worksheet on page 153

» Refit saved clusters on page 154

« Synchronize dual axes for different numeric data
types on page 154

« Navigate stories with arrows alone on page 154

o Create dual-axis (layered) maps from generated
and custom latitude and longitude fields on
page 154

Author and View Data on the Web

o Connect to data on the web on page 155

« Prepare your data on the web on page 155

» Resize headers on the web on page 155

o Add an accessible toolbar to an embedded view on

148 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help

page 156
o Other web authoring enhancements on page 156

Collaborate with Tableau Online and Tableau Server

o Quickly analyze cloud-based data with Dashboard
Starters on page 156

o Streamline discussion threads by deleting com-
ments on page 157

Tableau Licensing

New user-based term licenses are now available

Tableau now offers different types of user-based term licenses that grant a range of web
authoring and other capabilities at various price points. This gives organizations more flexibility
to fit licenses to the data analysis and visualization needs of different users. To learn more, see

User-based licenses, or to see the capabilities of each license, see Tableau Pricing.

Install and Deploy Tableau

Register Tableau Desktop from the command line

When you install Tableau Desktop from the command line (for Windows) you can now register
the product as part of the install without having to complete the registration for new users
through the user interface or as a separate command line operation.

Add a single command line that includes the REGISTER="1" installer option. During the
installation process, the installer will run the -regi ster process and add the registration
information. This process uses the registration information from the following location in the
registry: HKEY CURRENT USER\Software\Tableau\Registration\Data.

For information about adding registration information to the registry and the property settings
forthe —-register property, see the "Register Tableau Desktop" and the "Installer properties"
sections in Deploy Tableau Desktop.
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Mac OS system requirements

Tableau Desktop version 2018.1 for the Mac requires Mac OS X 10.11 El Capitan or later. All
Tableau Desktop versions 10.0 through 10.5 are compatible with Mac OS X 10.10 Yosemite.

Connect to and Prepare Data

Support for remote config files for SAP NetWeaver Business Warehouse

Tableau now supports using landscape XML files located on a remote HTTP server.

Connect to spatial columns in Microsoft SQL Server

You can now use spatial columns when you connect to Microsoft SQL Server in Tableau. You
can also use Custom SQL and RAWSQL to perform advanced spatial analysis in Tableau. For
more information, see Connect to Spatial Data in a Database on page 1799.

New connector name

Starting in Tableau 2018.1.4, the Cisco Information Server connector is renamed to
TIBCO Data Virtualization.

Design Views and Analyze Data

Apply step lines and jump lines

Change the Line mark type to a step line or a jump line by clicking the Path property in the
Marks card.
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Step lines and jump lines can help you see and compare incremental patterns of change over
time. Use these line types for numeric data that remains constant for periods of time, with

noticeable changes or deltas — such as account balances, inventory levels, or interest rates. For

details, see Draw paths between marks on page 1376.

Tips for analytics objects

In the Analytics pane, available analytics objects vary based on the current state of the datain a

visualization. For example, you can't apply trend lines to the view when it contains stacked

marks. Tooltips in the Analytics pane explain why an Analytics object isn't available, or provide a

tip on what is required to use that object in the view.
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¢ B f.PiB‘
Not enough marks in the view to show box plots.

Filter hierarchical data

When the data in your view contains hierarchies, filters for those fields can use the All Values
in Hierarchy option. Your filtering experience now matches the parent/child relationships in
the hierarchy.

Days to Ship by Product for Q3 of 2016 Coteeery i T
(an)
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Atlantic Metals Mobile 5-Shelf Bookcases, Cus. I [ | Furnishings
0'Sullivan Living Dimensions 2-Shelf Bookcases - Tables
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For details on filtering options, see Set options for filter card interaction and appearance
on page 1423.
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Hide a Viz in Tooltip worksheet

You can now hide worksheets used as Viz in Tooltips, the same way you would hide worksheets
used in stories or dashboards. In the target worksheet that is the Viz in Tooltip, click Hide.

Arizona -10. 7% overall
Profit Ratio by City

vuma -554% |[EGTGEGIB

Phoenix -28.6% IR

Chandler -11.4%

Mesa -10.7% B
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Glendale B 55%
& OpensireetMap contributors SEIIE L 0%
Tempe 0 io0e%
Sale Map |Tooltip ProfitRatia] -/ Vst I 2z 1%
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To show the Viz in Tooltip worksheet again, in the source worksheet, click Unhide All Sheets.
For more details about Viz in Tooltip, see Create Views in Tooltips (Viz in Tooltip) on

page 1475.
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Refit saved clusters

Clusters are saved as groups so you can use them in other worksheets and workbooks,
however, they don't automatically refresh. When the underlying data changes, you can now
use the Refit option to refresh and recompute the data for your saved clusters. For related
details, see Refit saved clusters on page 2562 in Find Clusters in Data on page 2554.

Synchronize dual axes for different numeric data types

In a chart with dual axes, you can now synchronize dual axes for numeric data types that don't
match. For example, you can synchronize an axis that uses an integer data type and an axis
that uses decimal data type.

Navigate stories with arrows alone

If you like a clean, simple navigator style, select the new arrows-only option. For more
information, see Create a Story on page 2852.

® Arrows only

Create dual-axis (layered) maps from generated and custom latitude and
longitude fields

You can now create dual-axis maps from a combination of Tableau generated latitude and
longitude fields, and custom latitude and longitude fields. For more information, see Create a

dual-axis map from a combination of generated and custom latitude and longitude
fields on page 1948.
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Author and View Data on the Web

Connect to data on the web

With a Creator user license, you can connect to data directly in your browser. Upload Excel or
text-based data sources, connect to data housed in a cloud database or on a server in your
enterprise, or connect to published data saved to your site. For more information, see Creators:
Connect to data on the web.

Prepare your data on the web

With a Creator user license, use the Data Sources tab to prepare your data for analysis. Create
joins, add new data sources, clean your data using the Data Interpreter, and more. For more
information, see Creators: Prepare Data on the Web.

Resize headers on the web

Resize the width of row headers and the height of column headers.
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Add an accessible toolbar to an embedded view

Authors can enable an accessible toolbar so that all users can add comments, download the
view, or share it with others. For more information, see Publish and embed the view in Author

Views for Accessibility.

Other web authoring enhancements

o Show Me is now available for dashboards.

« Double-click an annotation to edit its text.

« Hide or show a Viz in Tooltip worksheet. In the target worksheet that is the Viz in Tooltip,
click Hide. To show the Viz in Tooltip worksheet again, in the source worksheet, click
Unhide All Sheets.

o Filter hierarchical data in views by using the All Values in Hierarchy filter option.

« Change the Line mark type to a step line or a jump line by clicking the Path property in
the Marks card.

« Double-click an axis to edit axis settings.

Collaborate with Tableau Online and Tableau Server

Quickly analyze cloud-based data with Dashboard Starters

If you use Tableau Online, Dashboard Starters help you quickly author and analyze data from
cloud-based systems like Salesforce, ServiceNow, Marketo, and Eloqua. Simply create a new
workbook and choose from several beautiful, informative designs that are tailor-made for key
business metrics. For more information, see Dashboard Starters for Cloud-based Data on
page 2750.
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Email Performance Overview

TIMELINE

DELIVERY

Streamline discussion threads by deleting comments

If acomment is unnecessary or inaccurate, you can quickly delete it. Just click the X in the
upper-right corner. For more information, see Comment on Views on page 3259.

Version 10.5

Added in version 10.5

Install and Deploy Tableau

o Activate Tableau Desktop from the command line
on page 159

o Turn off driver downloads from the command line
(Windows) on page 159
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o Desktop operating system requirements (64-bit
replaces 32-bit) on page 160

Connect to and Prepare Data

« Extracts use the new .hyper format on page 160

« Changes to the way values are computed on
page 160

o Google authentication method update on page 160

« New Box connector on page 161

o Support for SSL authentication to IBM DB2 and
Biginsights databases on page 161

» Use the Extract APl on page 161

o SAP HANA support for failover on page 161

o SAP Sybase ASE support for SSO on page 161

o Support for OData V4 on page 161

» Oracle Eloqua connector update on page 161

Design Views and Analyze Data

o Show visualizations in tooltips on page 162

» Power trend lines on page 162

o Map data updates and additions on page 163

« Extend functionality with dashboard extensions on
page 139

Publish Data Sources and Workbooks

« Downgrade workbooks in Tableau Desktop on
page 164

New in Web Authoring

« Edit axes on page 164
« Additional enhancements on page 165

Collaborate with Tableau Online and Tableau Server

« Upload custom images for user profiles on
page 165
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o Subscribe users in groups, and add custom mes-
sages on page 166

 Rename workbooks on Tableau Online or Tableau
Server on page 166

Install and Deploy Tableau

Activate Tableau Desktop from the command line

When you install Tableau Desktop from the command line you can now activate the product
without having to complete the activation process through the user interface. Instead add a
single command line that includes the installer option ACTIVATE KEY "<key>".Duringthe
installation process, the installer will run —activate and apply the product key you provide to
activate the product automatically.

For more information about installing Tableau from the command line, see Deploy Tableau
Desktop.

Turn off driver downloads from the command line (Windows)

When you install Tableau Desktop the most common drivers are automatically installed for you.
To prevent all or some of these drivers from installing automatically, you can turn off that option
during install.

o To preventall drivers from being automatically installed, do one of the following:

 During install, from the Installer screen, click Customize. Then clear the Install
database drivers: Microsoft SQL Server, PostreSQL and Amazon
Redshift check box.

e« From the command line, setthe DATABASEDRIVERS ="0"

o To preventone or more of these drivers from being automatically installed, do the
following:

o Leave the Install database drivers: Microsoft SQL Server, PostreSQL and
Amazon Redshift check box selected, or from the command line, set the
DATABASEDRIVERS ="1"
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o Add acommand line and set DRIVER MSSQL, DRIVER POSTGRES or
DRIVER REDSHIFT to"0"to disable anindividual driver.

For more information about installing Tableau from the command line, see Deploy Tableau
Desktop.

Desktop operating system requirements (64-bit replaces 32-bit)

Starting with version 10.5, Tableau Desktop, Tableau Reader, and Tableau Public (desktop)
run only on 64-bit operating systems. Version 10.4 is the last version of Tableau Desktop,
Tableau Reader, and Tableau Public to support 32-bit Windows operating systems.

Connect to and Prepare Data

Extracts use the new .hyper format

Beginning with version 10.5, when you create an extract, it uses the new .hyper format.
Extracts in this new format take advantage of the improved data engine, which supports the
same analytical and query performance as the data engine before it, but for even larger
extracts. Similarly, when you perform an extract task on a .tde extract using version 10.5, the
extract is upgraded to a .hyper extract. For more information, see Extract Upgrade to
.hyper Format on page 1031.

Changes to the way values are computed

To improve data source efficiency and scalability, and produce results that are consistent with
commercial databases, values in your data source can be computed differently in version 10.5.
In some cases, these changes can cause differences with the values and marks in your view
between version 10.4 (and earlier) and version 10.5 (and later). This applies to extract data
sources, and can apply to multi-connection data sources, data sources that use live
connections to file-based data, data sources that connect to Google Sheets data, cloud-based
data sources, extract-only data sources, and WDC data sources. For more information, see
Changes to values and marks in the view on page 1015.

Google authentication method update

Starting in October 2017, Google's updated security requirements changed the connection
workflow for some Tableau connectors. Now Tableau opens at tab in your external default
browser when connecting to data that uses OAuth authentication. The connectors affected are
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Google Sheets on page 523, Google BigQuery on page 512, Google Analytics on
page 508, Dropbox on page 497, OneDrive on page 573, and Box on page 483.
New Box connector

Use the Box connector to connect to Box data. For more information, see Box on page 483.

Support for SSL authentication to IBM DB2 and Biglnsights databases

You can now connect to IBM DB2 and IBM Biglnsights databases using SSL authentication. For
more information, see IBM DB2 on page 533 and IBM Biglnsights on page 531.

Use the Extract API

You can use the Extract API 2.0 to create .hyper extracts. For tasks that you previously
performed using the Tableau SDK, such as publishing extracts, you can use the Tableau Server
REST API or the Tableau Server Client (Python) library. For refresh tasks, you can also use the
Tableau Server REST API. For more information, see Tableau Hyper APl on page 1059.

SAP HANA support for failover

Tableau supports connecting to a server that’s configured for failover. For more information,
see SAP HANA on page 609.

SAP Sybase ASE support for SSO

You can now connect to SAP Sybase ASE data using single sign-on (SSO). For more
information, see SAP Sybase ASE on page 629.

Support for OData V4

Tableau now supports OData version 4.0. For more information, see OData on page 571.

Oracle Elogua connector update

The Oracle Elogua connector now supports incremental refreshes, validation for tables with
more than 250 fields, and support for additional tables. For more information, see Oracle

Eloqua on page 583.
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Design Views and Analyze Data

Show visualizations in tooltips

As you craft views and look for ways to reveal more details about data to your audience, you
can embed visualizations within tooltips—aka "Viz in Tooltip."

Sales By Category
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Sales

When you show related views in tooltips, you can help your audience engage with the data ata
deeper level, while maximizing the space available for the current view. For details, see
Create Views in Tooltips (Viz in Tooltip) on page 1475.

Power trend lines

When you add trend lines to a view, a Power option is now available. For related details, see
Add Trend Lines to a Visualization on page 2528 and the "Power" model type in Trend
Line Model Types on page 2535.
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Map data updates and additions

In Tableau 10.5, additional cities are available for South East Asia, Central America, and South
America.

Demographic data updates including 2018 to 2023 statistical projections are now available.
U.S. Core Based Statistical Areas (CBSA) and Metropolitan Statistical Areas

(MSA) have been updated to 2015 definitions.

Updates are now available for U.S. postcodes.

Additionally, the following updates are now available for China:

o The areas of Beijing, Chongqing, Shanghai and Tianjin no longer contain city-level
districts in the Administrative level 2/County geographic role.

o Administrative level 2 features in China (prefecture-level cities, prefectures, leagues,
autonomous prefectures) are considered cities in Tableau. The center points of these
areas are included in the City geographic role as well.

« Additional cities such as Tiemenguan are now included in the City geographic role.

« Names for Administrative level 1 and 2 features are now consistent with names published
by the People’s Republic of China’s National Bureau of Statistics.

Extend dashboard dimensions to 10,000 pixels

To optimize designs for very large screens or vertical mobile layouts, you can now extend
dashboard width and height to 10,000 pixels.
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Publish Data Sources and Workbooks

Downgrade workbooks in Tableau Desktop

If you upgrade a workbook in Tableau Desktop to a newer version, you can now downgrade it
to a previous version so that users who are using Tableau Desktop 10.2 and later can still open
the workbook. To downgrade the workbook, in Tableau Desktop select File > Export As and
select the version that you want to downgrade to. Then save it to your My Tableau Repository
or a selected location.

Export As Version X

You are currently running Tableau version 2020.4.

This action will save a new workbook and will not overwrite
your existing workbook.
Learn More

Export As
Tableau 2019.2 v

Tableau 2020.3 P
Tableau 2020.2
Tableau 2020.1
Tableau 2019.4
Tableau 2019.3
Tableau 2019.2
Tableau 2019.1
Tableau 2018.3
Tableau 2018.2
Tableau 2018.1
Tableau 10.5

[ Cancel ‘ | Export ‘

The downgraded workbook can be opened in the version selected and later. Any features not
available in that previous version will be removed when the workbook is downgraded.

Note: This feature is not available for workbooks that include a Tableau Data Extract

that has been refreshed in 10.5. The extract will have been converted to use the new
.hyper format and this format can't be downgraded back to a .tde format.

New in Web Authoring

Edit axes

You can now edit axes on the web. To open the Edit Axis dialog box on the web, double-click
an axis in the view. Options available from the Edit Axis dialog box include Synchronize dual
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axes, clearing the axis range (Reset), and editing tick marks. You can also enable or disable
Dual axis in a field context menu (right-click a measure field on Rows or Columns shelf).

Additional enhancements

o Add text objects to dashboards and edit them.

» Edit worksheet and dashboard titles. Double-click the title to open the Edit Title dialog
box.

o Edittrend lines and view a description of the trend model. To view the trend model, hover
over any part of the trend line. To edit a trend line on the web, click a trend line and hold
the cursor in place, and then click the Edit menu.

o Trend lines now include a Power option.
« Create hierarchies by dragging one dimension onto another in the Data pane.
o Setthe default color property for a field.

« For quantitative color legends, advanced settings are available (dates not included).

Collaborate with Tableau Online and Tableau Server

Upload custom images for user profiles

By default, users and groups now have profile images that reflect their first two initials. To help
you visually distinguish between profile types, user images are circular, while group images are
square.

User profiles support custom images. To upload one, go to your account settings page, and

click the current image or initials next to your name.

If your organization uses Active Directory, default profile images come from that system. But
two-letter images may briefly appear until Active Directory next synchronizes with your Tableau
server.
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Subscribe users in groups, and add custom messages

To quickly subscribe several users, you can select entire groups created by your Tableau
administrator. Each user in a group is subscribed independently, so the list of recipients
remains fully customizable.

You can also add custom messages to subscription emails, clarifying their contents.

Subscribe

Subszcribe Users

Subscribe Users in Groups

Include

This View v
Schedule

Monday morning . 4
Subject

This Week's Cat Video Stats

Meszage

For more information, see Create a Subscription to a View or Workbook on page 3249.

Rename workbooks on Tableau Online or Tableau Server

There's no need to republish workbooks just to rename them. Now you can rename workbooks
directly on Tableau Online or Tableau Server. When you do, workbook URLs remain the same,
so any links you've shared keep working.

Simply navigate to the main Workbooks area, click the pop-up menu in the upper-right corner
of a workbook, and select Rename.
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Top Community Threads
w5views 1y 0

FRename

Change Cwner...

To rename a workbook, users need the Save permission. You'll have that by default for
workbooks you own, but you might need to add it for other users. For details, see Set
Permissions and Ownership in Help for Tableau site administrators.
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Get Started

This section gives you the basics on getting started with building views in Tableau, the Tableau
workspace, and Tableau concepts.

For related topics and sites, also see:

o Short walkthrough of Tableau Desktop: Build a Basic View to Explore Your Data
below

» In-depth Tableau Desktop tutorial: Get Started with Tableau Desktop
e On-demand webinars: Secrets of Visual Analytics

 Build basic chart types: Build Common Chart Types in Data Views on page 1577
and Choose the Right Chart Type for Your Data on page 371

« Build maps: Maps and Geographic Data Analysis in Tableau on page 1755

o Get started with using Tableau Online and Tableau Server: Use Tableau on the Web
on page 3101.

Watch a video: To see related concepts demonstrated in Tableau, watch these free video
tutorials: Getting Started (25 minutes), Getting Started with Data (6 minutes), and Getting
Started with Visual Analytics (6 minutes). Use your tableau.com account to sign in. To view
other introductory videos, go to Free Training Videos on the Tableau website. Also see different
chart types under the How To category on the Free Training Videos page.

Build a Basic View to Explore Your Data

This topic uses the Sample - Superstore data source to walk through how to create basic views
and explore your data. It shows how your view of data in Tableau evolves through your process
of exploration.

If you are using Tableau Online and Tableau Server to explore data and edit views, see Use
Tableau on the Web on page 3101.
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Connect to your data

The first step is to connect to the data you want to explore. This example shows how to connect
to Sample - Superstore data in Tableau Desktop.

1. Open Tableau. On the start page, under Connect, click Microsoft Excel. In the Open
dialog box, navigate to the Sample - Superstore Excelfile on your computer. Go
to /Documents/My Tableau Repository/Datasources/version

number/ [ language] . Select Sample - Superstore, and then click Open.

2. After you connect to the Excel data, the data source page shows the sheets or tables in
your data. Drag the "Orders" table to the canvas to start exploring that data.

Connections
| Sample - Superstore
Sheets
Use Data Intg/breter
Data Intergfeter might be able to Need more data?
cleanyoufMicrosoft Excel )
mrkbcof Drag tables here to relate them. Learn more
B8 Orders | = Sortfields Datasource order - Show |
B People
B Returs # At B & ke Abe
& Orders Row ID Order ID Order Date Ship Date Ship Mode Customer ID
F& People
1 CA-2018152156 11/8/2018 11/13/2018 Second Class €G-12520
B2 Returns
2 CA-2018152156 11/8/2018 11/13/2018 Second Class 612520
Mew U
R 3 CA-2018-138688 §/12/2018 6/16/2018 Second Class DV-13045
4 US-2017-108966  10/11/2017 10/18/2017 Standard Class 50-20335
§ US-2017-108966 10/11/2017 10/18/2017 Standard Class 50-20335
6 CA-2016-115812 6/9/2016 6/14/2016 Standard Class BH-11710
7 CA-2016-115812  6/3/2016 §/14/2016 Standard Class BH-11710
8 (A-2016-115812 &/9/2016 6/14/2016 Standard Class BH-11710
I x 9 (A-2016-115812 §/9/2016 6/14/2016 Standard Class BH-11710
il co st
v
B Data Source 5 8 o

Depending on how your data is structured, you might need to do more data
preparation and integration before you start exploring it in Tableau. For more
details on connecting to your data, see Connect to and Prepare Data on
page 391 and Tips for Working with Your Data on page 398.

3. Click the sheet tab to go to the new worksheet and begin your analysis.

About the Data pane

In the worksheet, the columns from your data source are shown as fields on the left side in the
Data pane. The Data pane contains a variety of fields organized by table. For each table or
folder in a data source, dimension fields appear above the gray line and measure fields appear
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below the gray line. Dimension fields typically hold categorical data such as product types and
dates, while measure fields hold numeric data such as sales and profit. In some cases, a table
or folder might contain only dimensions, or only measures to start with. For more information,
see Dimensions and Measures, Blue and Green on page 314.

Data Analytics

B Orders (Sample - Supers

IR
Tables
abc Category
@ City
@ Country/Region
abc Customer ID
Abs Customer Name
£ Order Date
abe Order ID
@ Postal Code
Abc Product ID
abc Product Name
Abc Region
# RowliD
b Segment
B Ship Date
Abc  Ship Mode
@ State
Abc Sub-Category
ave Measure Names

Latitude (generated)
D Longitude (generated)
# Orders (Count)
#  Measure Values

For more information about parts of the workspace, see The Tableau Workspace on
page 192.

If you have more than one data source in a workbook, click the data source connection name in
the Data pane to select it for use. For more details, see Navigating Data Sources in the
Data Pane on page 211.

For details on the many ways you can customize the fields in the data pane, see
Organize and Customize Fields in the Data Pane on page 1146, Edit Default
Settings for Fields on page 1157, and Work with Data Fields in the Data Pane on
page 203.

If you have related dimension fields, sometimes you might want to group them in a folder, or as
a hierarchy. For example, in this data source, Country, State, City, and Postal Code are
grouped into a hierarchy named Location. You can drill down into a hierarchy by clicking the +
sign in a field, or drill back up by clicking the - sign in a field.
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Build the view

Aview is a visualization or viz that you create in Tableau. A viz might be a chart, a graph, a
map, a plot, or even a text table.

Every view that you build in Tableau should start with a question. What do you want to know?

Every time you drag a field into the view or onto a shelf, you are asking a question about the
data. The question will vary depending on where you drag various fields, the types of field, and
the order in which you drag fields into the view.

For every question you ask, the view changes to represent the answer visually - with marks
(shapes, text, hierarchies, table structures, axes, color).

Different ways to start building a view
When you build a view, you add fields from the Data pane. You can do this in different ways.
For example:

o Drag fields from the Data pane and drop them onto the cards and shelves that are part
of every Tableau worksheet.

o Double-click one or more fields in the Data pane.

o Select one or more fields in the Data pane and then choose a chart type from Show Me,
which identifies the chart types that are appropriate for the fields you selected. For
details, see Use Show Me to Start a View on page 1323.

» Drop afield on the Drop field here grid, to start creating a view from a tabular
perspective.
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For more details on building visualizations with fields, see Start Building a

Visualization by Dragging Fields to the View on page 1285.

As you start exploring data in Tableau, you will find there are many ways to build a view.

Tableau is extremely flexible, and also very forgiving. As you build a view, if you ever take

a path that isn't answering your question, you can always undo to a previous pointin your

exploration.

. Toundo orredo, click undo € or redo = on the toolbar.

You can undo all the way back to the last time you opened the workbook. You can undo

or redo an unlimited number of times.

Build a view from scratch

These steps show how to build a basic view that shows year-by-year profit.

1. From the Dimensions area in the Data pane, drag the Order Date field to the

Columns shelf. You might need to expand the Order hierarchy to see Order Date.

When you drag a field over a shelf, a plus sign indicates that the shelf can accept the field.

Data Analytics

B Orders (Sample - Supers...

oE T
Tables

abc Category

@ City

@& Country/Region
#Abe Customer ID
Abe Customer Nafne
B Order Date
Ape Order ID

@& Postal Code
abe Product ID

Abe Product Name
abc Region

# RowlD

apbc Segment

B Ship Date

Abc Ship Mode

@@ State

# | ¢ > 8 6

farn]

Standard -

? || Pages

g~

1T o

[iii cotumns__57 ¢

Filters,

Sheet 1

Marks

[T] Automatic

..
Y
Color

(]
Tooltip

&
size | | Text

The resulting table has four columns and one row. Each column header represents a

member of the Order Date field (the default date level is YEAR). Each cell contains an

“Abc” label, which indicates that the current mark type for this view is text.
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jii Columns YEAR(Order Date)

iZ Rows

Order Date
2016 2017 2018 2019
Abc Abc Abc Abc

Notice that the field is colored blue, which indicates that it is discrete. For more
information, see Dimensions and Measures, Blue and Green on page 314.

The default date level is determined by the highest level that contains more than one
distinct value (for example, multiple years and multiple months). That means that if
[Order Date] contained data for only one year but had multiple months, the default level
would be month. You can change the date level using the field menu.

2015
Quarter Q2 2015
Month May 2015
Week Number Week 5, 2015
Day May 8, 2015

More ’

Exact Date

If you're wondering why there are two sets of date levels (from Year down to Day), the
first set of options uses date parts and the second set of options uses date values. For
more information, see Change Date Levels on page 1248.

Tip: To hide the title on the sheet, select the drop-down to the right of the title (Sheet 1),
and select Hide Title.

2. From the Data pane, drag the Profit field to the Rows shelf.
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Data Analytics * | Pages il Columns @ YEAR(Order Date)

G Orders (Sample - Superst... = Rows

Filters Order Date
2016 2017 2018 2019 |
Tables Abc Abc Abc  ADC |

we Category A |.'
e City /
¢ Country/Region e /
= Customer ID @ Automatic - /
e Customer Name |

. H & @
® Order Date Color Size Text /

s« Order ID
© Postal Code ode o /

s Product ID Detail | | Tooltip

= Region
Row ID
e Segment
= Ship Date
=< Ship Mode
@ State
ws Sub-Category
= Measure Names

-
# Product Name
-

= Discount
Profit —m—m————————"
Quantity
= Sales
The Profit field is colored green on the Rows shelf, indicating that it is continuous. Also,
the field name changes to SUM(Profit). That's because measures are automatically
aggregated when you add them to the view, and the default aggregation for this measure
is SUM. For more information on what happens when you add a measure to a view—and

why—see Dimensions and Measures, Blue and Green on page 314.

Tableau transforms the table into a line chart and creates a vertical axis (along the left
side) for the measure.

Aline chartis a great way to compare data over time and identify trends effectively.

This line chart shows profit over time. Each point along the line shows the sum of profit for
the corresponding year.
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Order Date

Profit

The next step is to drill a little deeper into the time dimension.

Drill into the data

This step shows how you can modify the view to show quarters in addition to years. As
you drill down into the hierarchy, the view changes to become a nested table.

You can show [Order Date] by quarters using either of the following methods:

« Click the plus button 221 on the left side of the field YEAR(Order Date) field on

Columns.
iii Columns [} YEAR(Order Dat.. =
— Year of Order Date
= RC'!‘.-'E -:;"._'.-'i.-ﬁ__l ity -

o Drag the Order Date field (again) from the Data pane and drop it on the
Columns shelf to the right of Year(Order Date).

The new dimension divides the view into separate panes for each year. Each pane, in
turn, has columns for quarters. This view is called a nested table because it displays
multiple headers, with quarters nested within years. The word "headers" might be a bit
misleading because while the year headers remain at the "head" of the view (that is, the
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top), the quarter headers are at the foot (that is, the bottom). So it might be more

accurate to call them footers.

Pages i Columns & YEAR(Order Date) @ QUARTER(Order D..
Filters ) B Order Date

Marks

~ AUtomatic -

& @

2018 2019
‘- 30K
Color  Size  Label
0% = ~ .
Detal  Tooltip  Path o

Increase the level of detail with small multiples

This step shows how you can modify the nested table view to add customer segment.

Profit

This will create a small multiples view.

Drag the Segment dimension from the Data pane. Drop it just to the left of SUM(Profit)

on Rows.
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il Colurmns

5 YEAR(Order Date)

= QUARTER(Order D..

= Rows

Order Date
201

Profit

|/

The field is added to the Rows shelf and row headers are created. Each header

represents a member of the Segment field.

You could achieve the same re

sult by dropping Segment just to the left of the Profit axis

in the view (show below). Tableau often supports multiple ways to add fields to the view.

Data

Analytics * | Pages

B Orders (Sample - Superst...

om -

Filters
Tables

Category

City
Country/Region
< Customer ID
Custormer Name
Qrder Date
Order ID

Postal Code
Product ID
Product Name
Region
Row ID
Segment
Ship Date
Ship Made

State
Sub-Category
Measure Names

Marks

F & & §

~ Automatic

&

Size

Q

Tooltip

-
e

Color
.
oo

Detail

« FFFoF oF

F Eo®FoEF

Discount

Profit

Quantity

Sales

Latitude (generated)

\—\r

© YEAR(Order Date) )

SUM(Profit) |

2016

i Columns

= Rows

2017
A0K

35K

-

@
Label

30K

~

25K
Path "

Profit

20K

oK
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Note: Tableau does not allow you to place a dimension to the right of a measure
on either the Rows or Columns shelves because that visual structure would not
make sense in the view.

The new dimension divides the view into 12 panes, one for each combination of year and
segment. This view is a more complex example of a nested table. Any view that contains
this sort of grid of individual charts is referred to as a small multiples view.

Order Date
Segment 2016 2017 2018 2019

N
)
N
<

Profit

I AA

At this point you probably don't want to make the view any more granular; in fact, you may

Profit

want to simplify the view by removing (that is, filtering) some data.

Filter the view to focus your exploration

This section shows how you can focus your exploration by only showing a subset of the
data, such as modifying the view to show only data for orders in 2012 and 2013.

1. Drag the Order Date measure from the Data pane and drop it on the Filters
shelf.
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3.

4.

How do you want to filter on [Order Date]?

& Relative Date
“ Range of Dates

Years [}

Quarters

Months

Days

Week numbers
Weekdays

Month / Year
Month [ Day [ Year
Individual Dates

 Count

Count (Distinct)

= Minimum
£ Maximum

Attribute

Next > Cancel
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In the Filter Field dialog box, choose the date level you want to filter on—Years.
Then click Next.

In the next pane, clear any two years that you do not want to include in the view.

When you are finished, click OK.

The view updates to only show data rows where Order Date is 2018 or 2019. Tableau

can now allocate more space to the data that interests you.

Segment

Profit

Profit

Profit

Order Date

AN
PVAEN
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Next, you will increase the detail in your data exploration by dragging a field to Color on
the Marks card.

Use the Marks card to add depth to your analysis

This step shows how you can modify the view to color the marks based on the region.

1.

Drag the Region dimension from the Data pane and drop it on Color.

Placing a dimension on Color separates the marks according to the members in

the dimension, and assigns a unique color to each member. The color legend

displays each member name and its associated color.

Data

Analytics Pages

f Orders (Sample - Superst...

Filters

Tables YEAR(Order Date)

= Category Cal

@ City

& Country/Region Marks

#e Customer ID ~ Automatic v

= Customer Name 9 @

& Order Date Ei%_u_['
Color 149 Size Label

we Order ID

@ Postal Code oo || O || ~

= Product ID Detail | | Tooltip| Path

== Product Name s

= Region —
# Row D
= Segment

Each pane now has four lines, one for each region. The viz is now showing profit

data summarized the Region level of detail.

This view now shows profit for each customer segment and region for 2012 and
2013.
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Pages fii Columns E YEAR{Order Date) & QUARTER(Order
Fiters Order Date

YEAR(Order Date) Segment

2018
Marks
o~ hutomatic I consumer $5,000
w2 & ;
= Size | Labed 30

(== ~

Detad | Tooltip | Path
. m $10,000
Region Corporate
W Central ¢n
| = .
Q. Q2 a3 04 oL gz Q3 o4

M scuth

W West

For more information on the Marks card and level of detail, see Shelves and
Cards Reference on page 222, Marks on page 249, and How dimensions
affect the level of detail in the view on page 319.

Profit

Profit

Profit

Home Office

More resources
For related topics and sites, also see:

In-depth Tableau Desktop tutorial: Get Started with Tableau Desktop

» On-demand webinars: Secrets of Visual Analytics

« Build basic chart types: Build Common Chart Types in Data Views on page 1577
and Choose the Right Chart Type for Your Data on page 371

« Build maps: Maps and Geographic Data Analysis in Tableau on page 1755

o Use Tableau Online and Tableau Server to explore data and edit views: Use Tableau

on the Web on page 3101

Watch a video: To see related concepts demonstrated in Tableau, watch these free video
tutorials: Getting Started (25 minutes), Getting Started with Data (6 minutes), and Getting
Started with Visual Analytics (6 minutes). Use your tableau.com account to sign in. To view
other introductory videos, go to Free Training Videos on the Tableau website. Also see
different chart types under the How To category on the Free Training Videos page.
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Tourthe Tableau Environment

This section provides information on Tableau pages and its workspace, including panes,
shelves, icons, and other elements in Tableau Desktop.

o The Tableau Workspace on page 192
« Start Page below
« Data Source Page on page 188

If you are using Tableau on the web, see Creators: Get Started with Web Authoring on
page 3119 and Tour Your Tableau Site on page 3104.

Watch a video: To see related concepts demonstrated in Tableau, watch Getting
Started, a 25-minute free training video. Use your tableau.com account to sign in.

Start Page
The start page in Tableau Desktop is a central location from which you can do the following:

o Connectto your data
o Open your most recently used workbooks, and
« Discover and explore content produced by the Tableau community.

The start page consists of three panes: Connect, Open, and Discover.
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On the Connect pane, you can do the following:

« Connect to data: Under To a File, connect to data stored in Microsoft Excel files, text
files, Access files, Tableau extract files, and statistical files, such as SAS, SPSS, and R.
Under To a Server, connect to data stored in databases like Microsoft SQL Server or
Oracle. The server names listed in this section change based on which servers you
connect to and how often.

« Open saved data sources: Quickly open data sources that you have previously saved
to your My Tableau Repository directory. Also, Tableau provides sample saved data
sources that you can use to explore Tableau Desktop functionality. To follow along with
examples in the Tableau Desktop documentation, you'll usually use the Sample —
Superstore data source.

Open

Open recent workbooks, pin workbooks to the start page, and explore sample workbooks.
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Open a Workbook
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World Indicators

o Open recently opened workbooks: When you open Tableau Desktop for the first

time, this pane is empty. As you create and save new workbooks, the most recently

opened workbooks appear here. Click the workbook thumbnail to open a workbook, or if

you don't see a workbook thumbnail, click the Open a Workbook link to find other

workbooks that are saved to your computer.

« Pin workbooks: You can pin workbooks to the start page by clicking the pin icon that

appears in the top-left corner of the workbook thumbnail. Pinned workbooks always

appear on the start page, even if they weren't opened recently. To remove a recently

opened or pinned workbook, hover over the workbook thumbnail, and then click the "x"

that appears. The workbook thumbnail is removed immediately but will show again with
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your most recently used workbooks the next time you open Tableau Desktop.

o Explore sample workbooks: Open and explore sample workbooks.

Discover

See popular views in Tableau Public, read blog posts and news about Tableau, and find training
videos and tutorials to help you get started.
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Discover

Training
Getting Started
Connecting to Data
Visual Analytics
Understanding Tableau

More training videos...
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Forums

Data Source Page

Before or during your analysis, you may want to make changes to the Tableau data source.
You can do that on the data source page. Tableau takes you to the data source page after you
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establish the initial connection to your data. You can also access the data source page by

clicking the Data Source tab from any location in the workbook.

Watch a video: To see related concepts on connecting to data and using the Data pane,
watch Getting Started with Data, a 6-minute free training video. Use your tableau.com
account to sign in.

Although the look of the page and the options available vary depending on the type of data that
you are connected to, the data source page generally consists of four main areas: left pane,
canvas, data grid, and metadata grid.

o
- Sample - Superstore "
® Live Extract 0 Add
Connections

Samgple - Supersiore

N

C
Returns is made of | table
Double-click this table to add joins or unions
m m Sortfields Datasource orde - Sa mp|e - SUDEFSTOI'E t
& | ) Live Extract 0 A
Row 1D Order ID OrderD
Returns [o] X
1 CA-2018-152.. 11/8/2C
3 L1/ Returns.
w [W] Sort fields  Data scurce order = Li/8/2¢ I
= New Linion .
Field Name Table  Remote Field Name 12/2C
* Row D Orders RowiD 10/13/2
ors Order ID 10/1/2017  10/18/2017  StandardClass S0-20335 Sean O'Donnell €
Oate 5/9/2018 6/14/2016 Standard Class  BH-11710 Brosina Hoff.. €

st 5/9/2016 6/14/2016 Standard Class  BM-11710 Brosina Hoff.. €

zinfne &M arng Chnmdned Flase DU 11THR —— -

© Data Source

A.Left pane on the next page - Displays the connected data source and other details about
your data.

B.Canvas on the next page: logical layer - The canvas opens with the logical layer, where you
can create relationships between logical tables.

C.Canvas on the next page: physical layer - Double-click a table in the logical layer to go to the
physical layer of the canvas, where you can add joins and unions between tables.
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D.Data grid on the facing page - Displays first 1,000 rows of the data contained in the Tableau
data source.

E.Metadata grid on page 192 - Displays the fields in your data source as rows.

Back to top

Left pane

The left pane of the data source page displays details about your data—the data that Tableau
Desktop is connected to.

« Forfile-based data, the left pane might display the file name and the worksheets in the
file.

« Forrelational-based data, the left pane might display the server, the database or
schema, and the tables in the database.

You can also use the left pane to add more connections to the data source to create cross-
database joins.

The left pane does not display for cube (multidimensional) data.

Canvas

When connected to most relational and file-based data, you can drag one or more tables to the
canvas area to set up your Tableau data source. The canvas now has two layers: a logical
layer and a physical layer. The default view shows the logical layer, which uses relationships
between logical tables. To go to the physical layer, double-click a logical table in the logical
view and create joins and unions between tables in the physical layer. For more information,
see Tableau Data Model.

When connected to cube data, the top of the data source page displays the available catalog
or queries and cubes to select from to set up your Tableau data source.

Note: Depending on the type of data you are connected to, you can refresh your data
when that data has changed using a number of options. For example if connected to a
data extract, you can refresh a selected extract using the Refresh button

Livi &) Extract
Extract will include all data

that appears next to the Connection area in the left side of
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the pane. For more information about refresh options see Refresh Data Sources on
page 1071. For more information about refreshing data extracts, see Refresh Extracts
on page 1041.

Refreshing your data source

Depending on the type of data you are connected to you can refresh your data when that data
has changed using a number of options. For example if connected to a data extract,

Data grid

Use the data grid to review the fields and the first 1,000 rows of the data contained in the
Tableau data source. You can also use the data grid to make general modifications to the
Tableau data source like sorting or hiding fields; renaming fields or resetting field names;
creating calculations; changing the column or row sort; or adding aliases. For the Web Data
Connector, file- and relational-based data sources in Extract mode, you can see extract data in
the grid, including extract only calculations.

When you're in the logical layer, you see the data for the selected table.
In the physical layer, you see the merged data based on the joins and unions.

To select multiple fields in the grid, click a column, and then drag the mouse to select more
columns.

To select all fields, click the area in the upper-left corner of the grid like in the example, below.
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* Abc * M
Ordars Ondars Ondars
Row ID Order ID = Order Date

1 (CA-2013-152156  11/9/2013

2 (CA-2013-152156  11/9/2013

3 C # ¥ Ahbc ]
Cindars Qrdars Ordars

RowID = OrderD Order Date
1 CA-2013-152156 11/9/2013

2  (A-2013-152156  11/9/2013

3 CA-2013-138688 671372013
The grid is not displayed for cube (multidimensional) data.

Metadata grid

Depending on the type of data that you are connected to, click the metadata grid button to
navigate to the metadata grid. The metadata grid displays the fields in your data source as
rows so that you can quickly examine the structure of your Tableau data source and perform
routine management tasks, such as renaming fields or hiding multiple fields at once.

When connected to cube or some extract only data, the metadata grid displays by default.

The Tableau Workspace

The Tableau workspace consists of menus, a toolbar, the Data pane, cards and shelves, and
one or more sheets. Sheets can be worksheets, dashboards, or stories. For details on
dashboard or story workspaces, see Create a Dashboard on page 2741 or The Story
Workspace on page 2845.

Watch a video: To see related concepts demonstrated in Tableau, watch The Tableau
interface in Getting Started, a 4-minute free training video. Use your tableau.com

account to sign in.

If you are using Tableau on the web, see Creators: Get Started with Web Authoring on
page 3119 and Tour Your Tableau Site on page 3104.
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A. Workbook name. A workbook contains sheets. A sheet can be a worksheet, a dashboard, or
a story. For more information, see Workbooks and Sheets on page 261.

B.Cards and shelves - Drag fields to the cards and shelves in the workspace to add data to your
view.

C.Toolbar - Use the toolbar to access commands and analysis and navigation tools.

D.View - This is the canvas in the workspace where you create a visualization (also referred to
as a "viz").

E. Click this icon to go to the Start page, where you can connect to data. For more information,
see Start Page on page 183.

F.Side Bar - In a worksheet, the side bar area contains the Data pane and the Analytics pane.

G. Click this tab to go to the Data Source page and view your data. For more information, see
Data Source Page on page 188.
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H.Status bar - Displays information about the current view.

I. Sheet tabs - Tabs represent each sheet in your workbook. This can include worksheets,
dashboards, and stories. For more information, see Workbooks and Sheets on page 261.

Back to top

Tableau Toolbar Button Reference

When you are creating or editing a view, you can use the toolbar at the top of the view to
perform common actions.

In Tableau Desktop, you can hide or display the Tableau toolbar by selecting Window > Show
Toolbar.

The table below explains the functions of each toolbar button. Some buttons are not available
in all Tableau products. Also see Visual Cues and Icons in Tableau Desktop on page 277.

Toolbar Button Description

Tableau icon: Navigates to the start page. For more information, see
A

ey Start Page on page 183.

Note: Tableau Desktop only.

Undo: Reverses the most recent action in the workbook. You can undo
an unlimited number of times, back to the last time you opened the
workbook, even after you have saved. For more information, see Undo
and Redo on page 2725.

Redo: Repeats the last action you reversed with the Undo button. You
can redo an unlimited number of times.

Save: In Tableau Desktop, saves the changes made to the workbook.
For more information, see Save Your Work on page 3017.

In Tableau Server or Tableau Online, click File > Save or File > Save
As to save your changes.

New Data Source: In Tableau Desktop, opens the Connect pane

§D

where you can create a new connection or open a saved connection. For
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Toolbar Button

Description

more information, see Connect to Your Data on page 391.

In Tableau Server or Tableau Online, opens the Connect to a Data
Source page, where you can connect to a published data source. For
more information, see Connect to published data sources while
web authoring on page 449.

Pause Auto Updates: Controls whether Tableau updates the view
when changes are made. Use the drop-down menu to automatically
update the entire sheet or just use filters. For more information, see
Refresh Data or Pause Automatic Updates on page 3223.

Run Update: Runs a manual query of the data to update the view with
changes when automatic updates are turned off. Use the drop-down
menu to update the entire worksheet or just use filters.

Note: Tableau Desktop only.

@ -

New Worksheet: Creates a new blank worksheet, use the drop-down
menu to create a new worksheet, dashboard, or story.

For more information, see Create new worksheets, dashboards, or
stories on page 262.

Duplicate: Creates a new worksheet containing the same view as the
current sheet. For more information, see Duplicate a sheet on
page 264.

Clear: Clears the current worksheet. Use the drop-down menu to clear
specific parts of the view such as filters, formatting, sizing, and axis
ranges.

Swap: Moves the fields on the Rows shelf to the Columns shelf and
vice versa. The Hide Empty Rows and Hide Empty Columns set-
tings are always swapped with this button.

Tableau Software
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Toolbar Button Description

Sort Ascending: Applies a sort in ascending order of a selected field
based on the measures in the view. For more information, see Sort

Data in a Visualization on page 1447.

Sort Descending: Applies a sort in descending order of a selected field
based on the measures in the view. For more information, see Sort

Data in a Visualization on page 1447.

Totals: You can compute grand totals and subtotals for the data in a
X~ view. Select from the following options:

e Show Column Grand Totals: Adds a row showing totals for all
columns in the view.

« Show Row Grand Totals: Adds a column showing totals for all
rows in the view.

» Row Totals to Left: Moves rows showing totals to the left of a
crosstab or view.

e Column Totals to Top: Moves columns showing totals to the top
of a crosstab or view.

o Add All Subtotals: Inserts subtotal rows and columns in the
view, if you have multiple dimensions in a column or row.

« Remove All Subtotals: Removes subtotal rows or columns.

Note: Tableau Server and Tableau Online only. In
Tableau Desktop, click Analysis > Totals. For more information,
see Show Totals in a Visualization on page 1456.

Highlight: Turn on highlighting for the selected sheet. Use the options

¢ - on the drop-down menu to define how values are highlighted. For more
information, see Highlight Toolbar Button on page 1505.
P Group Members: Creates a group by combining selected values. When

multiple dimensions are selected, use the drop-down menu to specify
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Toolbar Button

Description

whether to group on a specific dimension or across all dimensions. For
more information, see Correct Data Errors or Combine Dimension
Members by Grouping Your Data on page 1184.

Note: Tableau Desktop only. In Tableau Server and Tableau
Online, create groups using the Group Members button on the
tooltip.

Show Mark Labels: Switches between showing and hiding mark labels
for the current sheet. For more information, see Show, Hide, and
Format Mark Labels on page 1378.

Fix Axes: switches between a locked axis that only shows a specific
range and a dynamic axis that adjusts the range based on the minimum
and maximum values in the view. For more information, see Edit Axes
on page 2900.

Note: Tableau Desktop only.

Format Workbook: Open the Format Workbook pane to change how
fonts and titles look in every view in a workbook by specifying format
settings at the workbook level instead of at the worksheet level.

Note: Tableau Server and Tableau Online only. In Tableau
Desktop, click Format > Workbook. For more information, see
Format at the Workbook Level on page 2882.

Standard -

cir-

Fit: Specifies how the view should be sized within the window. Select
Standard, Fit Width, Fit Height, or Entire View. Note: This menu is not
available in geographic map views.

The Cell Size commands have different effects depending on the type
of visualization. To access the Cell Size menu in Tableau Desktop click
Format > Cell Size.

Tableau Software
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Toolbar Button Description

Show/Hide Cards: Shows and hides specific cards in a worksheet.

o - Select each card that you want to hide or show on the drop-down menu.

In Tableau Server and Tableau Online, you can show and hide cards for
the Title, Caption, Filter and Highlighter only.

Presentation Mode: Switches between showing and hiding everything
except the view (i.e., shelves, toolbar, Data pane). For more
information, see Reorganizing the Workspace on page 273.

Note: Tableau Desktop only.

Download: Use the options under Download to capture parts of your
view for use in other applications.

» Image: Displays the view, dashboard, or story as an image in a
new browser tab.

o Data: Displays the data from the view in a new browser window
with two tabs: Summary, showing aggregated data for the fields
shown in the view, and Underlying, showing underlying data for
the selected marks in the visualization. If the new window does not
open, you may need to disable your browser's popup blocker.

o Crosstab: Saves the underlying data for the selected marks in
the visualization to a CSV (comma-separated values) file which
can then be opened in Microsoft Excel.

e PDF: Opens the current view as a PDF in a new browser window.
From there you can save it to a file. If the new window does not
open, you may need to disable your browser's pop-up blocker.

Note: Tableau Server and Tableau Online only.

Share Workbook With Others: Publish your workbook to Tableau
Server or Tableau Online. For more information, see Simple Steps to
Publish a Workbook on page 3056.
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Toolbar Button Description

Note: Tableau Desktop only.

—_— Show Me: Helps you choose a view type by highlighting view types that
work best with the field types in your data. An orange outline shows
around the recommended chart type that is the best match for your data.
For more information, see Use Show Me to Start a View on

page 1323.

Back to top

Show and Hide the Side Bar (Data pane)

The Side Bar contains the Data pane and the Analytics pane when you are editing a
worksheet. Different panes are visible depending on what you are doing in the view (Data,
Analytics, Story, Dashboard, Layout, Format). The most important thing to know about the Side
Bar is that you can expand and collapse this area in the workspace.

To hide the side bar in Tableau Desktop, click the collapse arrow in the side bar.

# | € > 8 8
Data Analytics ¥
| E] Sample - Superstore v|

To hide the side bar on the web, click the collapse arrow in the side bar.

« - B & W

Data Analytics <

Economic Indicators

To show the side bar on Tableau Desktop, click the expand arrow in the bottom-left of the
workspace (in the status bar.
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To show the side bar on the web, click the expand arrow in the side bar.

Back to top

Status Bar Information

The status bar is located at the bottom of the Tableau workspace. It displays descriptions of
menu items as well as information about the current view. For example, the status bar below
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shows that the view has 143 marks shown in 3 rows and 12 columns. It also shows that the SUM
(Sales) for all the marks in the view is $2,297,201.

# Profit Bin Size

# Top Customers

B Data Source Sheetl [} H O

143 marks 3rowsbyl2columns SUM(Sales): $2,297.201

You can hide the status bar by selecting Window > Show Status Bar.

Occasionally, Tableau will display warning icons in the bottom right corner of the status bar to
indicate errors or warnings. Below are the possible warning icons and what they mean.

Warning Icon Description

8 Cancel query indicator: When you cancel multiple queries, an indicator
a
appears to show you how many queries are still running on the database

and using resources.

When you cancel a query in Tableau, the database is told to stop
processing the query. However, some databases do not support cancel
(MS Excel, MS Access, Essbase, Microsoft Analysis Services 2000). If
you cancel a query using one of these types of data sources, the query is
abandoned by Tableau but is still running in the background and using
resources. When you have abandoned queries, an indicator appears in
the bottom right corner of the workbook showing the number of queries

still running & 1. As queries in the background complete, the number will
go down. ltis important to monitor the number of queries running and not
let the number get too high, otherwise you will see performance
degradation of both Tableau and the underlying database.

Note: Text, Microsoft Excel, and Microsoft Access data sources
may be temporarily unavailable after canceling a query because of
a lock performed internally. You may have to wait until the
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Warning Icon

Description

abandoned query has completed before re-connecting.

Precision warning: Some fields are more precise in the database than
Tableau can model. When you add a field to a view that contains values

with more precision than Tableau can model, a warning icon Nis

displayed in the bottom right corner of the status bar.

For example, a value in the database may have 22 decimal places but
Tableau only supports up to 15. When you add that field to the view, you
get a precision warning. If you click on the warning, you can read more
details including the number of decimal places that have been truncated
in the view.

Remember that the precision of the data displayed in Tableau will always
first be dependent on the data in your database. If the values in your
database exceed 15 decimal places, when you add them to the view, the
value is truncated and a precision warning appears.

Note: Extracts of relational databases always use the Hyper
double precision type, and never use the Hyper numeric type. So if
you create an extract of a relational database, you only get 15
digits of precision. You can write to the Hyper APl and use the
numeric type to get up to 18 digits. For related information, see

Numeric Types in Hyper APl documentation.

Special values indicator: If your data contains null values, unknown
geographic locations, or negative or zero values on a logarithmic axis; the
values are shown with an indicator in the lower right corner of the view.
Click the indicator for options for handling these values. See Handling
Null and Other Special Values on page 1317 to learn more about this
indicator and how to handle these values.

Back to top
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Work with Data Fields in the Data Pane

Tableau displays data source connections and data fields for the workbook in the Data pane on
the left side of the workspace.

Note: For details on how to start creating visualizations, see Get Started on page 169.
For details on the many ways you can customize the fields in the Data pane, see
Organize and Customize Fields in the Data Pane on page 1146 and Edit Default
Settings for Fields on page 1157.

Areas of the Data pane

After you connect to your data and set up the data source with Tableau, the data source
connections and fields appear on the left side of the workbook in the Data pane. For details on
connecting to data, see Connect to and Prepare Data on page 391.

Current data source connections appear at the top of the Data pane. When you have more than
one connection available, click a connection to select it and start working with that data.

You build visualizations by adding fields from the Data pane to the view. For details, see Start
Building a Visualization by Dragging Fields to the View on page 1285.

Fields can be organized by table (Group by Data Source Table) or folder (Group by
Folder). Dimensions are displayed above the gray line, and measures below the gray line for
each table or folder. In some cases, a table or folder might contain only dimensions, or only
measures to start with.

« Calculated fields are listed with their originating field, if all of their input fields come from
the same table.

o Sets are listed with the table with their originating field.

o Parameters are global to the workbook and are displayed in the Parameters area.

» Fields that don't belong to a specific table are displayed in the general area below the
tables. These include: aggregated calculations, calculations that use fields from multiple
tables, Measure Names, and Measure Values.

Below the data source connections in the Data pane are the fields that are available in the
currently selected data source. You can toggle between the Data and Analytics panesina
worksheet. For details on the Analytics pane, see Apply Advanced Analysis to a View
(Analytics Pane) on page 213.
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Fields from a single-table data source in the Data pane

The Data pane includes:

« Dimension fields — Fields that contain qualitative values (such as names, dates, or
geographical data). You can use dimensions to categorize, segment, and reveal the
details in your data. Dimensions affect the level of detail in the view. Examples of
dimensions include dates, customer names, and customer segments.

« Measure fields — Fields that contain numeric, quantitative values can be measured.
You can apply calculations to them and aggregate them. When you drag a measure into
the view, Tableau applies an aggregation to that measure (by default). Examples of
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measures: sales, profit, number of employees, temperature, frequency.

o Calculated fields — If your underlying data doesn't include all of the fields you need to
answer your questions, you can create new fields in Tableau using calculations and then
save them as part of your data source. These fields are called calculated fields.

o Sets — Subsets of data that you define. Sets are custom fields based on existing
dimensions and criteria that you specify. For more information, see Create Sets on
page 1186.

Named sets from an MS Analysis Services server or from a Teradata OLAP connector
also appear in Tableau in this area of the Data pane. You can interact with these named
sets in the same way you interact with other custom sets in Tableau.

o Parameters — Values that can be used as placeholders in formulas, or replace constant
values in calculated fields and filters. For more information, see Create Parameters on
page 1218.

Note: For cube data sources, fields are explicitly defined as dimensions or measures
when the database is created. For relational data sources, Tableau automatically
organizes the fields. By default, fields containing text, date or boolean values are
dimensions, while fields containing numerical values are measures.

By default the field names defined in the data source are displayed in the Data pane. You can
rename fields and member names, create hierarchies, and organize the fields into groups and
folders. For details, see Edit Default Settings for Fields on page 1157, Organize and
Customize Fields in the Data Pane on page 1146, and Create Hierarchies on page 1170

Columns become measure and dimension fields in the view

Data sources contain fields. For relational data sources that you connect to, the fields are
determined by the columns of a table or view. Each field contains a unique attribute of the data
such as customer name, sales total, product type, and so on.

For cube (multidimensional) data sources, the fields are determined by the dimensions and
measures of a cube. In Tableau, cube data sources are supported only in Windows.

Here's an example of fields from an Excel worksheet.
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A B C D E F G H

1 |RowID Order ID Order Date Ship Date  Ship Mode  Customer ID Customer Na Segment
2 1 CA-2013-152156 11/9/2014 11/12/2014 Second Class CG-12520  Claire Gute Consumer
3 2 CA-2013-152156 11/9/2014 11/12/2014 Second Class CG-12520  Claire Gute Consumer
4 3 CA-2013-138688 6/13/2014 B/17/2014 Second Class DV-13045  Darrin Van Hi Corporate
5 4 US-2012-108966 10/11/2013 10/18/2013 Standard Cla:50-20335  Sean O'Donn Consumer
[ 5 US-2012-108966 10/11/2013 10/18/2013 Standard Cla:S0-20335  Sean O'Donn Consumer
7 6 CA-2011-115812 6/9/2012 6/14/2012 Standard Cla:BH-11710  Brosina Hoffr Consumer
8 7 CA-2011-115812 6/9/2012 6/14/2012 Standard Cla:BH-11710  Brosina Hoffr Consumer
9 8 CA-2011-115812 6/9/2012 6/14/2012 Standard ClasBH-11710  Brosina Hoffr Consumer
10 9 CA-2011-115812 6/9/2012 6/14/2012 Standard ClasBH-11710  Brosina Hoffr Consumer
11 10 CA-2011-115812 6/9/2012 6/14/2012 Standard Cla:BH-11710  Brosina Hoffr Consumer
12 11 CA-2011-115812 6/9/2012 6/14/2012 Standard Cla:BH-11710  Brosina Hoffr Consumer
13 12 CA-2011-115812 6/9/2012 6/14/2012 Standard Cla:BH-11710  Brosina Hoffr Consumer
14 13 CA-2014-114412 4/16/2015 4/21/2015 Standard ClasAA-10480  Andrew Allen Consumer
15 14 CA-2013-161389 12/6/2014 12/11/2014 Standard Cla:IM-15070 Irene Maddo: Consumer
16 15 U5-2012-1185983 11/22/2013 11/26/2013 Standard ClasHP-14815 Harold Pawla Home Office
17 16 U5-2012-118983 11/22/2013 11/26/2013 Standard Cla:HP-14815 Harold Pawla Home Office
18 17 CA-2011-105893 11/11/2012 11/18/2012 Standard ClasPK-19075 Pete Kriz Consumer
19 18 CA-2011-167164 5/13/2012  5/15/2012 Second Class AG-10270  Alejandro Grc Consumer
20 19 CA-2011-143336 8/27/2012 9/1/2012 Second Class ZD-21925  Zuschuss Dot Consumer
21 20 CA-2011-143336 8/27/2012 9/1/2012 Second Class ZD-21925  Zuschuss Dot Consumer
22 21 CA-2011-143336 8/27/2012 9/1/2012 Second Class ZD-21925  Zuschuss Dor Consumer

When you start building a visualization in a worksheet, these columns are available as fields in

the Data pane. For details, see Areas of the Data pane on page 203.

Each field has a data type (that you can change if needed), and a role: discrete dimension,

continuous dimension, discrete measure, or continuous measure. For details, see Data

Types on page 325 and Dimensions and Measures, Blue and Green on page 314.

Each field also includes some default settings, such as a default aggregation of SUM or AVG,

depending on the structure of the current view. For details, see see Edit Default Settings for

Fields on page 1157 and Data Aggregation in Tableau on page 341.

Fields that Tableau automatically creates

The Data pane can also contain a number of fields that do not come from your original data:

Measure Names and Measure Values, Number of Records, Latitude and Longitude.

Measure Names and Measure Values

o The Measure Values field contains all the measures in your data, collected into a single
field with continuous values. Drag individual measure fields out of the Measure Values
card to remove them from the view.

« The Measure Names field contains the names of all measures in your data, collected
into a single field with discrete values.
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For more details about how to use Measure Values and Measure Names in
visualizations, see Measure Values and Measure Names on page 1310. To see
measure names and measure values in action, watch the 5-minute Measure Names and
Measure Values training video. Use your tableau.com account to sign in. To view more
training and introductory videos, go to Free Training Videos on the Tableau website.

Count of Table

Starting with Tableau 2020.2, every table in a data source has a Count field, in the form of
NameofTable(Count). The table count field is an automatically generated, calculated field.

COUNT of table = SUM of the number of records per table

To see the count for a table, drag its Count field into the view. To see the count for all tables,
select the Count field for each table in the Data pane, and then click the Text Table in Show Me.

You can't build calculations on top of a table's Count field, and it is aggregate-only.

Number of Records (before version 2020.2)

You might see a Number of Records field if it is being used in a visualization from a previous
version of Tableau.

In versions of Tableau before 2020.2, the Number of Records field is an automatically
generated, calculated field that is set to the number 1. That number gets associated with each
row in the data source. If you add the Number of Records field to the view, you will see the
summed count of all the rows in a data source (the number of records). You can use the
Number of Records field to get quick counts of various dimensions' values. Viewing the Number
of Records can help you to see if you data joins are working the way you expect them to.

Latitude and Longitude (generated)

When Tableau interprets fields to be geographic fields that can be used with maps, it
automatically geocodes the data and includes Latitude (generated) and Longitude
(generated) fields. You can use these fields to overlay your data on live maps. For more
information on how to use these fields, and best practices for building maps in Tableau, see
Maps and Geographic Data Analysis in Tableau on page 1755 Assign Geographic
Roles on page 1834, Location Data that Tableau Supports for Building Map Views on
page 1795,
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Perform common tasks in the Data pane

To select a data source connection for analysis, click the data source connection name
in the Data pane. For more details, see Navigating Data Sources in the Data Pane on
page 211.

o« 2o R GG

Data Analytics

£ 13

M Sales Commission
A Sales Target Extract
Eﬂ Sample - Superstore

Folders B2L -
v [E& Customer -
Abc Customer Name H

Abc Segment

To view a context menu for the data source, click Data in the top menu and then click on
the data source in the menu list. For more information, see Edit Data Sources on page 1060.

To search for fields in the Data pane, click the magnifying class icon and then type in the
text box.

To see the underlying data, click the View Data icon at the top of the Data pane.

For more information , see View Underlying Data on page 2728
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9,994 rows Show aliases
Category City Country Customer Name
Office Supplies Houston United States Darren Powers
Office Supplies Maperville United States Phillina Ober
Office Supplies Maperville United States Phillina Ober
Office Supplies Maperville United States Phillina Ober
Office Supplies Philadelphia United States Mick Brown
Office Supplies Athens United States Jack O'Briant
Office Supplies Los Angeles United States Lycoris Saunders
Furniture Henderson United States Maria Etezadi
Office Sunnlies Hendersnn linited States Maria Ftezadi

In cases where Tableau has misclassified a field as a dimension or a measure, possibly
because of the data type, you can convert it and change its role.

To convert a measure to a dimension, drag the measure and drop it into the Dimensions
area in the Data pane. For more details, see Convert a Measure to a Dimension on
page 1165.

Change data fields to fit your needs

When you drag a field into the view, it will have certain default settings and characteristics. You
can customize a field that is already in the view, just for that instance of the field. Or you can
change its settings in the Data pane to make the field use those settings going forward.

You can control the definition of a field in the view, depending on how you want to work with that
field data.

Note: To change the default settings for a field before you drag it into the view, right-click
it (Control-click on a Mac). You can then edit its settings and default properties from its
context menu.

For details on the many ways you can customize the fields in the Data pane, see Organize and
Customize Fields in the Data Pane on page 1146 and Edit Default Settings for Fields on
page 1157.

Relational versus cube data

The Data pane for a relational and cube data source are shown below. Note that the panes look
essentially the same for both data sources in that the fields are organized into dimensions and
measures. However, the cube data source contains hierarchies for dimensions. For example,
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notice that the Employee dimension in the cube Data pane contains hierarchical members
such as Manager Name and Employee Dept.

Relational data sources don’t have built-in hierarchies. However, relational data sources often
have related dimensions that have an inherent hierarchy. For example, a data source may
have fields for Country, State, and City. These fields could be grouped into a hierarchy called
Location. You can assemble relational hierarchies by dragging and dropping in the Data pane.
For details, see Create Hierarchies on page 1170.

Note: In Tableau, cube (multidimensional) data sources are supported only in
Windows.

Data Analytics : Data Analytics =
[j Orders (Sample - Superstore) @ Basic
Dimensions EL - Dimensions £ -
Abc Category 4 Call Center -
@ City =zl Call Center Region I
Abc Customer ID 4 Customer Segment
Abc Customer Mame £z Customer Segment
Abc  Customer Segment 4 Employee
B Order Date sz Manager Mame
abc Crder ID &2 Employee Dept 3
i@ Postal Code &3 Employee Name
Abc Product ID 4 Market Segment
Abc Product Mame =zl Market Segment
Abc Region 4 Order Date
# RowlID &l Year
B Ship Date Sz? Quarter 0
Abc Ship Mode s=° Month
@ State ot Day
Abc Sub-Category 4 Product
Abc Meagsure Names 2l Prod Typel
&7 Prod Type2

Measures 1 e A &7
F Discount Measures
# Profit F Item Count -
#  Quantity F# Order Quantity b
# Sales F# Sales Total
& Lotitude (generated) H# Discount
i@ Llongitude (generated) F# Tax Rate
=H  MNumber of Records # Fill Time
#  Measure Volues H# Gross Profit )

F# Price 3
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Data pane with relational data (left image) versus cube data (right image)

You can expand or collapse hierarchies in both relational and cube Data panes by clicking the

arrow. You can hide the Data pane all together by clicking the minimize button # in the upper-

right corner of the Data pane.

For information on cube data sources, see Cube Data Sources on page 1085.

Navigating Data Sources in the Data Pane

The top of the Data pane lists all of the data sources in a given workbook. Click the data source
you want to use to select it. The Data pane updates to show the corresponding fields in that data

source.

LL3

Data Analytics

9 DATA (Coffee Sales) Ex...
O) Office Supply

E@ Sales_Actual vs_Plann...
Ej Sample - Superstore

o
4

Tables
apc Category

ape Customer Segment

Note: images in this topic have not been updated to reflect the most current Ul. The Data pane no longer
shows Dimensions and Measures as labels.

You can resize the data source list area in the Data pane to save space. When you resize to a
limited vertical height, you can scroll down to a data source.

Data Analytics :
O Office Supply -

=
E@ Sales_Actual vs_Pla.. -
Tables EL -

abc Category

abe Customer Seoment

Each data source has an icon to indicate its type. For example, the icon can indicate whether
the data source is relational, cube (multidimensional), or an extract. In Tableau, cube data

sources are supported only in Windows.
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You can right-click (control-click on a Mac) the data source to access the commands that are
on the Data menu. For example, you can right-click (control-click on a Mac) a data source and
rename, export, or close it.

# € 2> R 8 6-C- [

Data Analytics * || Pages

5 DATA (Coffee Sales) Ex...
O Office Supply

@ Sales Achial us Dlann Filters
Edit Data Source...

EI Sample -
Refresh

Tables == View Data...

abc Category Rename...

abc Custome Duplicate

@ Custome Close

B Order Dal

[Cﬂ Extract Data...

A Region v Use Extract
ave Measure ERiTI 5

Edit Data Source Filters...
Replace Data Source...

# Sales Cun Date Properties...

@ Latifude Edit Aliases... ’
@ Longitud Publish to Server..

= Number ¢ Add to Saved Data Sources...

Properties...
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For details on the many ways you can customize and work with the fields in the Data pane, see
Organize and Customize Fields in the Data Pane on page 1146, Edit Default Settings
for Fields on page 1157, and Work with Data Fields in the Data Pane on page 203.

Navigate Between the Start Page and Workspace

When Tableau Desktop is already open, you can navigate to the start page by clicking the
Tableau icon in the upper-left corner of the Tableau Desktop workspace.

# e =2\l &6

Data | Analytics .

H Sample - Superstore

| Search o |5§§ | -
Folders
w [ Customer ~
Abc  Customer Mame
Abc Segment

To go back to the Tableau workspace, click the Tableau icon in the start page.

File  Data Server Help

Connect

Microsoft Exce

Text file

Apply Advanced Analysis to a View (Analytics Pane)

Drag reference lines, box plots, trend lines forecasts, and other items into your view from the
Analytics pane, which appears on the left side of the workspace. Toggle between the Data

pane and the Analytics pane by clicking the tabs at the top of the side bar.
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Data Analytics s

Tableau Desktop Analytics pane

In Tableau Desktop, options for adding Analytics objects to the view are available the
Analytics pane or menu, or in context in the view. For example, reference lines and bands are
available when you edit an axis, and trend lines and forecasts are available from the Analysis
menu.

The Analytics pane provides drag-and-drop access for the various options.

On the web, most Analytics objects are available from the Analytics pane.

Watch a video: To see related concepts on visual analytics in demonstrated in
Tableau, watch the Getting Started with Visual Analytics (6-minutes) and Getting
Started with Calculations (3-minutes), free training videos. Use your tableau.com
account to sign in.
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Add an analytics object to the view

To add an item from the Analytics pane, drag it into the view. When you drag an item from the

Analytics pane, Tableau shows the possible destinations for that item. The range of choices

varies depending on the type of item and the current view.

In a simple case, the drop target area would offer these three options:
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! Constant Line =
21 Average Line e Sheet 1
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Adds areferencelineto the entiretable
across all panes.

Adds areferencelineon a perpane ba-
sis. Computed reference lines are reca-
culated for each paneintheview.

Adds areferencelinewithin each cell.
Computed reference lines are recaleus-
lated for each cell in theview.

For a more complicated view—for example, if the view contained a line chart with multiple or

dual axes—Tableau would show you a drop target area that looked like this:
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Add a Akt | [ akd dih
Median with Quartiles

Table Pane Cell
SUM(Profit)
S5UM(Sales)

If you dropped the item in one of the three larger boxes in the header at the top of the drop

target area--for example, the Table box--a separate median with quartiles would be added for

each axis:
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But if you drop the item in any of the six lower boxes aligned with a specific measure, the

median with quartiles would only be added on the corresponding axis, with the specified scope.

Delete an analytics object from the view

You can delete an analytics object from the view by clicking Undo, or drag the object off the

view to delete it.

You can also click on an item and choose Remove from the tooltip.

Note: Some Analytics pane items (Median with Quartiles and Average with 95%

Cl) add both a reference line and a reference distribution. Unless you are using Undo,

you would need to delete these items separately.
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Edit an analytics object in the view

To edit an item you have added from the Analytics pane, click on the item and select Edit from
the tooltip. For additional editing options, see the section for a particular item type under
Analytics object definitions, below.

Analytics object definitions

The following items can be dragged from the Analytics pane and dropped in the view. If an
analytics object cannot be applied to the current configuration of fields in the view, itisn't
available.

Constant Line

Adds one or more constant lines to the view. You can add a constant line for a specific measure,
for all measures, or for date dimensions. When you add a constant line, Tableau displays a
Value prompt where you specify the value for the constant:

Value: Sl

In Tableau Desktop, the Value prompt for a date value is a calendar control:

L}Value: flr1/2011 12:00 AM  EF

£ January 2011 >

M T W T F
27 2% 29 30 3
3 4 5 & 7

10 11 12 13 14
17 18 19 20 21
24 25 26 27 28
11 2 3 4

Today:  1/9/2015

[
BHihE oy e
wn fd fa i3 e = e

You can click on a resulting constant line and choose Edit or Remove. In Tableau Desktop
there is a third option: Format. Choosing Edit opens the Edit Reference Line dialog box. For
details, see Edit Existing Reference Lines, Bands, and Distributions on page 2527 in the
Reference Lines, Bands, Distributions, and Boxes article. Another way to edit a line in
Tableau Desktop is to right-click (control-click on Mac) the relevant axis and choose Edit
Reference Line.
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Average Line

Adds one or more average lines to the view. You can add an average line for a specific
measure or for all measures.

You can click on a resulting average line and choose a different aggregation, such as Total or
Sum. You can also choose Edit or Remove. In Tableau Desktop there is a third option:
Format. Choosing Edit opens the Edit Reference Line dialog box. For details, see Edit
Existing Reference Lines, Bands, and Distributions on page 2527 in the Reference
Lines, Bands, Distributions, and Boxes article. Another way to edit a line in Tableau
Desktop is to right-click (control-click on Mac) the relevant axis and choose Edit Reference
Line.

Median with Quartiles

Adds one or more sets of median lines and distribution bands to the view. You can add a
median with quartiles for a specific measure or for all measures.

The distribution bands are computed as quartiles; the middle two quartiles are shaded.

You can click on a resulting median line or distribution and choose Edit or Remove. In
Tableau Desktop there is a third option: Format. Median lines and distributions must be
edited, formatted, or removed separately. Choosing Edit opens the Edit Reference Line dialog
box. You must click on the outer edge of a distribution band to see the options--clicking in the
middle of the band has no effect. For details, see Edit Existing Reference Lines, Bands,
and Distributions on page 2527 in the Reference Lines, Bands, Distributions, and
Boxes article. Another way to edit a line or distribution in Tableau Desktop is to right-click
(control-click on Mac) the relevant axis and choose Edit Reference Line. A submenu will
offer you two choices: Quartiles and Median.

For information on distribution types, including quartiles, see Add Reference Distributions
on page 2518 in the Reference Lines, Bands, Distributions, and Boxes article.

Box Plot

Adds one or more box plots to the view. You can add box plots for a specific measure or for all
measures. The scope for a box plot is always Cell (and never Table or Pane).

Click or hover over any of the horizontal lines in the box plot to see statistical information about
the whiskers, quartiles, and median.

You can also choose Edit or Remove when you click on a line. In Tableau Desktop there is a
third option: Format. Choosing Edit opens the Edit Reference Line dialog box. Another way to
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edit a box plot in Tableau Desktop is to right-click (control-click on Mac) the relevant axis and
choose Edit Reference Line.

Note: In Tableau Desktop, there are two items named Box Plot in the Analytics pane.
For the Box Plot option in the Summarize section, Tableau will automatically add a box
plot for the specified target. For the Box Plot option in the Custom section, Tableau will
open the Edit Reference Line, Band, or Box dialog box after you specify a target.

Totals

Adds totals to the view. When you add totals, the drop options are Subtotals, Column Grand
Totals, and Row Grand Totals.

For details, see Show Totals in a Visualization on page 1456.
To remove totals, click the relevant column or row header and choose Remove.

In Tableau Desktop, you can also click on a totals column or row header after adding totals and
set the aggregation for that row or column from the tooltip:

Totalf Appliances Art Binders

60,7 4 =+ T} | Automatic ﬂ Remove
. Loy
33161 53 items selecte| @ | Automatic 1,897
5175
" Total Surmn
515,10 B | ~
Average
59,677 -
36,904 Minimum
35,343 Maximum
'5‘:|355 SEF‘:EF

i

Average with 95% CI

Adds one or more sets of average lines with distribution bands; the distribution bands are
configured at a 95% confidence interval. You can add these items for a specific measure or for
all measures.

The confidence interval distribution bands shade the region in which the population average will
fall 95% of the time.

You can click on a resulting average line or distribution and choose Edit or Remove. In
Tableau Desktop there is a third option: Format. Choosing Edit opens the Edit Reference Line
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dialog box. The average lines and distributions must be edited, formatted, or removed
separately. You must click on the outer edge of a distribution band to see the options--clicking
in the middle of the band has no effect. Another way to edit a line or distribution in Tableau
Desktop is to right-click (control-click on Mac) the relevant axis and choose Edit Reference
Line. A submenu will offer you two choices: Average and 95% Confidence Interval.

You can also remove lines and bands by dragging them off the view.

Median with 95% CI

Adds one or more sets of median lines with distribution bands; the distribution bands are
configured at a 95% confidence interval. You can add these items for a specific measure or for
all measures.

The confidence interval distribution bands shade the region in which the population median will
fall 95% of the time.

You can click on a resulting median line or distribution and choose Edit, Format, or Remove.
In Tableau Desktop there is a third option: Format. Choosing Edit opens the Edit Reference
Line dialog box. The median lines and distributions must be edited, formatted, or removed
separately. You must click on the outer edge of a distribution band to see the options--clicking
in the middle of the band has no effect. Another way to edit a line or distribution in Tableau
Desktop is to right-click (control-click on Mac) the relevant axis and choose Edit Reference
Line. A submenu will offer you two choices: Median and 95% Confidence Interval.

You can also remove lines and bands by dragging them off the view.

Trend Line

Adds one or more trend lines to the view. When you add trend lines, the drop options identify
the trend line model types available in Tableau: Linear, Logarithmic, Exponential, and
Polynomial. For some views, only a subset of these options is available.

For details, see Trend Line Model Types on page 2535

Click on a trend line to remove or edit it, or to see a statistical definition. You can also remove a
trend line by dragging it off the view.

Forecast

Adds a forecast to the view. This option is only available in Tableau Desktop—not when you
edit a view on the web. Forecasting is only possible when there is at least one measure in the
view.
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Forecasting is not supported for views based on multidimensional data sources. In addition, the
view cannot contain any of the following:

o Table calculations

o Disaggregated measures

o Percent calculations

o Grand Totals or Subtotals

o Date values with aggregation set to Exact Date
Atime series containing null values also imposes constraints.
For details, see Forecasting on page 2580.

To remove, edit, or read a description of the current forecast, go to the Analysis menu and
choose Forecast.

Custom Reference Line
You can add reference lines for a specific measure or for all measures in the view.

After you drag a reference line from the Analytics pane and drop it on a target, Tableau
automatically opens an edit dialog box. See Add a Reference Line on page 2506 in the
Reference Lines, Bands, Distributions, and Boxes article for information on the available
options. To return to this dialog box later, click on the line and choose Edit.

Custom Reference Band
You can add reference bands for a specific measure or for all measures in the view.

After you drag a reference band from the Analytics pane and drop it on a target, Tableau
automatically opens the Edit Reference Line, Band, or Box dialog box. See Add Reference
Bands on page 2513 in the Reference Lines, Bands, Distributions, and Boxes article for
information on the available options. To return to this dialog box later, click on the band and
choose Edit. You must click on the outer edge of a reference band to see the options--clicking
in the middle of the band has no effect.

Custom Distribution Band
You can add reference distributions for a specific measure or for all measures in the view.

After you drag a reference distribution from the Analytics pane and drop it on a target, Tableau
automatically opens Edit Reference Line, Band, or Box dialog box. See Add Reference
Distributions on page 2518 in the Reference Lines, Bands, Distributions, and Boxes
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article for information on the available options. To return to this dialog box later, click on the
band and choose Edit. You must click on the outer edge of a distribution band to see the
options--clicking in the middle of the band has no effect.

Custom Box Plot

In Tableau Desktop—but not when you edit a view on the web—you can drag a box plot from
the Custom section of the Analytics pane and drop it on a target. (But keep in mind that on the
web, you can add a box plot from the Summarize section on the Analytics pane.) When you
drag Box Plot from the Custom section, Tableau automatically opens Edit Reference Line,
Band, or Box dialog box. See Add a Box Plot on page 2523 in the Reference Lines, Bands,
Distributions, and Boxes article for information on the available options. The scope for a
box plot is always Cell (and never Table or Pane).

Click any of the horizontal lines in the box plot to see statistical information about the whiskers,
quartiles, and median.

To return to this dialog box later, click on the band and choose Edit.

Shelves and Cards Reference

Every worksheet in Tableau contains shelves and cards, such as Columns, Rows, Marks,
Filters, Pages, Legends, and more.

By placing fields on shelves or cards, you:
« Build the structure of your visualization.

o Increase the level of detail and control the number of marks in the view by including or
excluding data.

« Add context to the visualization by encoding marks with color, size, shape, text, and
detail.

Experiment with placing fields on different shelves and cards to find the optimal way to look at
your data.

Options for starting a view

If you aren't sure where to place a field, you can get let Tableau help you determine the best
way to display the data.
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e You can drag fields from the Data pane and drop them onto the cards and shelves that
are part of every Tableau worksheet.

e You can double-click one or more fields in the Data pane.

e You can select one or more fields in the Data pane and then choose a chart type from
Show Me, which identifies the chart types that are appropriate for the fields you selected.
For details, see Use Show Me to Start a View on page 1323.

e You candrop a field on the Drop field here grid, to start creating a view from a tabular
perspective.

Columns and Rows shelves
Drag fields from the Data pane to create the structure for your visualizations.

The Columns shelf creates the columns of a table, while the Rows shelf creates the rows of a
table. You can place any number of fields on these shelves.

When you place a dimension on the Rows or Columns shelves, headers for the members of
that dimension are created. When you place a measure on the Rows or Columns shelf,
quantitative axes for that measure are created. As you add more fields to the view, additional
headers and axes are included in the table and you get an increasingly detailed picture of your
data.

In the view shown below, the members of the Segment dimension are displayed as column
headers, while the Profit measure is displayed as a vertical axis.
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iii Columns Segment

= Rows SUM(Profit)

Sheet 1
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$40,000

$20,000
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Office

Tableau displays data using marks, where every mark corresponds to a row (or a group of
rows) in your data source. The inner fields on the Rows and Columns shelves determine the
default mark type. For example, if the inner fields are a measure and a dimension, the default
mark type is a bar. You can manually select a different mark type using the Marks card drop-
down menu. For more information, see Change the Type of Mark in the View on

page 1332.

Adding more fields to the Rows and Columns shelves adds more rows, columns, and panes
to the table.
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Hide rows and columns

Generally you will add dimensions and measures to create the rows and columns of the table
and you’ll either include all data or add filters to only show a subset. However, when you filter
data it is also excluded from calculations and other computations performed on the summarized
data in the table. Instead of filtering the data, you can hide the row or column so it doesn't
display in the view but it is still included in calculations.

Tip: Hiding columns is especially useful when using table calculations that compare to a
previous or next date value. In these cases, there will be a row or column that doesn’t show data
because there is no data to be compared to. Hide the empty column to keep the table
calculation intact. For more details on table calculations, see Table Calculation Types on
page 2419.

For example, when calculating year-over-year growth, the first year wouldn't have a previous
year to compare to, so the column is left blank. Filtering the first year would remove it from the
view but it would also remove it from the calculation (the second year then doesn't have a
previous year to compare to and is left blank). Instead of filtering, hiding the blank column keeps
the calculation intact.

To hide a row or column:

Right-click (control-click on Mac) the row or column you want to hide, and then select Hide.
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To show hidden data:

Open the field menu for a field that has hidden columns or rows and select Show Hidden
Data.
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Marks card

The Marks card is a key element for visual analysis in Tableau. As you drag fields to different
properties in the Marks card, you add context and detail to the marks in the view.

You use the Marks card to set the mark type (see Change the Type of Mark in the View on
page 1332), and to encode your data with color, size, shape, text, and detail. To change the
mark settings, see Control the Appearance of Marks in the View on page 1356.
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In this example, three different fields have been dragged to different properties in the Marks
card. Segment is on Color, Region is on Shape, and Quantity is on Size.

After you add a field to the Marks card, you can click the icon next to the field to change the
property itis using. You can also click the property buttons in the Marks card to change those
settings.
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Color Size Label
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Many properties can have multiple fields. For example, you can add multiple fields to Label,
Detail, Tooltip, and Color. Size and Shape can only have one field at a time. For more details,
see Control the Appearance of Marks in the View on page 1356.

Note: By default, dragging a new field to Color replaces the existing fields. To add a new
field to color without replacing the existing field, hold the SHIFT key on your keyboard
while dragging a new field to Color on the Marks card.

Filters shelf

The Filters shelf allows you to specify which data to include and exclude. For example, you
might want to analyze the profit for each customer segment, but only for certain shipping
containers and delivery times. By placing fields on the Filters shelf, you can create such a view.

Note: This section presents a brief overview of filtering. For more information on filtering,
see Filter Data from Your Views on page 1411.

You can filter data using measures, dimensions, or both at the same time. Additionally, you can
filter data based on the fields that make up the columns and rows of the table. This is called an
internal filter. You can also filter data using fields that don’t contribute headers or axes to the
table. This is called an external filter. All filtered fields display on the Filters shelf.

Toillustrate the basic concepts of filtering, consider the following view.
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= Rows SUM(Profit)

iii Columns Segment

Sheet 1

Segment

140,000

$3120,000

$100,000

$30,000

Profit

$60,000

$40,000

$20,000

30

Consumer Corporate Home
Office

Suppose you are not interested in the Home Office data. You can remove this column from the
view by filtering the Segment dimension. To do so, select Filter on the field menu or drag the
Segment dimension to the Filters shelf. The Filter dialog box opens. By default all members

are selected. Clear the check box for Home Office to exclude it from the view. All selected
members will be included.
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Filter [Segment] | &

General | Wildcard Condition | Top |

@ Select from list ) Custom value list ) Use all |E|

Enter search text
Consumer
Corporate
[] Home Office

As shown below, the view updates and the Home Office column is removed. The filter is
indicated by the Segment field on the Filters shelf.
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Suppose you want to only view profit for a category of the products. Even though the Category
field is not used on the Rows and Columns shelves or on the Marks card, you can stilladd a

filter. Drag the Category dimension to the Filters shelf. This is an example of an externalfilter
because Category is not part of the view.

The Filter dialog box automatically opens. By default, none of the members are selected.
Select the members you want to keep as part of the view. All cleared members are excluded. In
this example, Office Supplies is selected.

The modified data view is shown below. The mark label shows that the sum of the profit for the
Consumer segment has decreased to $56,330. This number is derived by summing all the
rows in the data source that are associated with the Corporate market and are part of the
Office Supplies category.
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o i ot
= Rows SUM{Profit)
Filters
Sheet 1
Category: Office Sup.. t50.000
456,330
Marks $50,000
nol Automatic -
$4U,22?
H- & $40,000
Color Size Label
D;Q Q %
= =
Detail | Tooltip a 30,000
SUM(Profit)
520,000
510,000

Consumer Corporate

The order of fields placed on the Filters shelf does not affect the data view because the filters
are independent. In other words, the result of filtering by customer segment, and then by
container is the same as filtering by container and then by customer segment. For more
information about the filtering order of operations, see Filter Data from Your Views on
page 1411.

Pages shelf

The Pages shelf lets you break a view into a series of pages so you can better analyze how a
specific field affects the rest of the data in a view. When you place a dimension on the Pages
shelf you are adding a new row for each member in the dimension. When you place a measure
on the Pages shelf, Tableau automatically converts the measure into a discrete measure.
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The Pages shelf creates a set of pages, with a different view on each page. Each view is based
on a member of the field you placed on the Pages shelf. You can easily flip through the views
and compare them on a common axis, using the controls that get added to the view when you
move a field to the Pages shelf. For example, the view below shows the Profit vs. Sales by
Region for each day throughout the month. The image below shows days 1, 2, 3, and 4. You
would have to scroll down to see other days in the month.

Fages iii Columns SUM(Profit)
= Rows DAY (Order Date) SUM(Sales)
Filters Sheet l Region
B central
Day of Order .. . Eact
$40 000 = B south
Marks ; B H [ west
B @ $20,000
28 Automatic - g
w & :
Color Size Label 340,000
o Q
9 | ]| - o OO
Detail | Tooltip | Shape T O
- CEE '
40,0 fo)

L
Sales

$40,00
4 3 o
® §20,00 OO
< O -
$0 $10,000

Profit

To make this view more user-friendly, move DAY (Order Date) to the Pages shelf and use the
associated control to flip through the pages (one for each day). You can quickly discover
hidden insights. In this example, it is interesting that the 19th is an especially big day in terms of
sales and profit in the Western region.
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= Rows DAY(Order Date) SUM(Sales)

Filters Sheet l - Region
[} . Central
Day of Order .. . East
-
440,000 8 Il soutn
Marks ] E B west
1 o
v 520,000
28 Automatic b @
30
w || &
Color Size Label 540,000
w
. oo 5 w 0O
ol | B @ $20,000 0
Detail | Tooltip| | Shape Q

w
1=}

M Region

540,000 O

420,000 éJ

[¥5)
Sales

W
=1

340,000

=
Sales
O

$20,000 OO
o]

i
5
1

30 $10,000

Profit

When you add a field to the Pages shelf, a page control is automatically added to the right of
your view.

Use this control to navigate through the pages. There are three ways to navigate through the
pages in a view:

« Jump to a specific page

« Manually advance through the pages

« Automatically advance through pages
Jump to a specific page

Select the member or value you want to view from the drop-down list to display a specific page.
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. Central
. East
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. West
DAY (Order Date)
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o

«[m» -[=/=

Chrvw hictmre
Show history =

You can manually advance through the sequence of pages by doing any of the following:

« Use the forward and back buttons on either side of the drop-down list to navigate

through the pages one at a time.

o Use the Page Slider to quickly scroll forward and backward in the sequence of pages.

« Use any of the following keyboard shortcuts to scroll forward and backward in the
sequence of pages.

F4 Starts and stops forward playback
SHIFT + F4 | Starts and stops backward playback
CTRL +. Skip forward one page

CTRL +, Skip backward one page

On a Mac, these are the equivalent keyboard shortcuts.
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F4

Starts and stops forward playback

Shift-F4

Starts and stops backward playback

Command-period

Skip forward one page

Command-comma

Skip backward one page

Automatically advance through pages

Use the playback controls to watch a slide show of the pages in the view. You can play forward

or backward, and stop the playback at any time. You can control the speed of playback with the
speed controls in the bottom right corner of the control. The smallest bar indicates the slowest

playback speed.

Show the Page history

Show page history using the Show History check box. With page history, marks from previous

pages are shown on the current page.

In Tableau Desktop only: Open the drop-down control for history to specify what marks to show

and when to show them.
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DAY (Order Date)
<5 *||>

o
«[m» ===
Show history *

Marks to show history for

Selected Highlighted

Manual All

Length

Ol Last;
Show

Trails Both

Marks

Format: Mone A

Fade: s D

Trails

Format:

The history drop-down control has the following options:

o Marks to show history for — select whether you want to show history for just selected
marks, highlighted marks, marks that you’ve manually selected to show history for, or all
marks. To manually show history for marks, right-click (control-click on Mac) the mark in
the view and select an option on the Page History menu.

o Length — select the number of pages to show in the history.

« Show - specify whether to show the historical marks, a line tracing through the previous
values (trails), or both.

o Marks — format the historical marks including the color and how much to fade them if the
color is set to automatic, the marks will either use the default mark color or the color
encoding on the Color shelf.

o Trails — format the lines that are drawn through the historical marks. This option is only
available if Trails is selected in the Show options.

Page trails may not display if there are multiple marks per color on a page. Make sure that the

level of detail for the view is less than or equal to the level of detail on the Pages shelf and on
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the Color target. Also, trails are only supported for discrete mark types such as squares, circles,
or shapes. They are not supported when the mark type is Automatic.

Pages on dashboards (Tableau Desktop only)

When a dashboard contains multiple views that use the same field on the Pages shelf, you can

control all of the views with a single page control by selecting the Synchronized option. This
option is only available on the page control shown on a dashboard.

G- o [ B g T, &
PR - x}
' | Region
Sheet 1
B central
550,000 . East
B south
540,000 . West
Day of Order Date
. 530,000 ¢||s - [
=
b o O O 9]
. ) L) [r—
““““ O 1 @ 4 _@=
Show history
510,000
o
40 [y
($5,000) 30 35,000 $10,000
Profit

Additional Shelves, Legends, Cards, and Controls

Some shelves, legends, cards, or controls are only displayed as a result of things that you do as
you work with views. For example, the Color legend is only displayed when there is a field on
Color.
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Ship Mode

B First Class
. Same Day
B second Class

. Standard Class

Tableau provides controls for moving or otherwise customizing these elements of the view.

The following list describes each such shelf, legend, card, or control.

+ Measure Values Shelf— Measure Values is a special field that always appears in the
Data pane and contains all the measures of your data collected into one field. Tableau
automatically adds Measure Values to the view when multiple measures are sharing the
same axis. When Measure Values is in the view, Tableau displays a Measure Values
shelf that shows which measures are being included. You can add measures to or
remove measures from this card. For more information, see Measure Values and

Measure Names on page 1310.
« Color Legend — Shows how colors are allocated when there is a field on Color.
o Shape Legend — Shows how shapes are allocated when there is a field on Shape.
o Size Legend — Shows how sizes are allocated when there is a field on Size.

o Map Legend — Shows the legend for the symbols and patterns on a map. The map
legend is not available for all map providers.

o Parameter Controls — A separate parameter control is available for every parameter
in the workbook. For more information, see Create Parameters on page 1218.

o Title — Atitle is displayed by default for every view. The default title is the sheet name.
Double-click a title (Control-click on a Mac) to edit it.

o Caption — Choose Show caption from the Worksheet menu to display a caption for the
view.

o Summary Card — Choose Show summary from the Worksheet menu to display a
summary card for the view. For more information, see Summary Card on page 2727.

« Page Control — Provides options for navigating through pages when there is a field on
the Pages shelf.
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Parts of the View

This section describes the basic elements of views that you can create in Tableau. You can
show or hide parts of the view as needed (described below). Every view has a table in some
form, which may include rows, columns, headers, axes, panes, cells, and marks. Views can
optionally include tooltips, titles, captions, field labels, and legends.

The View area

Data views are displayed in a table on every worksheet. A table is a collection of rows and
columns, and consists of the following components: Headers, Axes, Panes, Cells, and Marks. In
addition to these, you can choose to show or hide Titles, Captions, Field Labels, and Legends.

B C D

Annual Profit by Product

Order Date / Region
A ——= Category 5 -

Profit

ofit

A. Field Labels on page 255 - The label of a discrete field added to the row or column shelf that
describes the members of that field. For example, Category is a discrete field that contains
three members; Furniture, Office Supplies and Technology.

B. Titles on page 252 - The name that you give your worksheet, dashboard, or story. Titles
display automatically for worksheets and stories and you can turn them on to display them in
your dashboards.

C. Marks on page 249 - The data that represents the intersection of the fields (dimensions and
measures) included in your view. Marks can be represented using lines, bars, shapes, maps
and so on.
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D. Legends on page 257 - A key that describes how the data is encoded in your view. For
example if you use shapes or colors in your view, the legend describes what each shape or
color represents.

E. Axes on page 246 - Created when you add a measure (fields that contain quantitative,
numerical information) to the view. By default, Tableau generates a continuous axis for this
data.

F. Headers below - The member name of a field.

G. Captions on page 254 - Text that describes the data in the view. Captions can be
automatically generated and can be toggled on and off.

Also see information on Cells on page 248 and Panes on page 248.

Headers

Headers are created when you place a dimension or discrete field on the Rows shelf or the
Columns shelves. The headers show the member names of each field on the shelves. For
example, in the view below the column headers show the members of the Order Date field
and the row headers show the members of the Sub-Category field.
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QOrder Date
Sub-Category 2012 2013
Accessories
Appliances
Art
Binders
Bookcases
Chairs
Copiers
Envelopes
Fasteners
Furnishings
Labels

Machines

Paper

Phones
Storage
Supplies
Tables

You can show and hide row and column headers at anytime.

To hide headers:
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« Right-click (control-click on Mac) the headers in the view and select Show Header.

Sub-Category 2012 2013
ACcessories

Appliances

Art 4/ 058 %5 237
Binderz | ¥ Keeponly

Bookcesd & Exclude

Chairs Hide

Copiers

Envelops +  Drill down

Fastenen Farmat...

Lol Rotate Label

Lanels v Show Header
Machins

Faper Edit alias...

Phones Split

Storaae

o Select the field in the view whose headers you want to show and select Show Header

on the field menu.
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Remove

Hiding headers can be useful when you are working with multiple measures. For example, the
view below shows both the sales and profit for each region along a single axis. You can see the
view looks cluttered with the Measure Names headers showing. Because Measure Names is
also indicated by the mark color, you can hide the excess headers to clean up the view.
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Axes

Axes are created when you place a measure or continuous field on the Rows or Columns
shelves. By default, the values of the measure field are displayed along a continuous axis.

Pages fii Columns
= Rows SUM(Sales)

Filters Region Segment
M consumer
M corporata
£700,000 Il Home Office
Marks
ool Automatic ¥ $600,000
HH & o
Color Size Label
$500,000
CSD Q
Detail  Tooltip
"
&
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You can show and hide axes at any time.

To hide axes:
 Right-click (control-click on Mac) the axis in the view and select Show Header to clear

the check mark next to this option.

Region

Edit Axis...

Clear Axis Range

Select Marks
Synchronize Axis

Format...
Show Header

Add Reference Line

Central East South West

To show axes:

« Right-click (control-click on Mac) the measure in the view whose axis you want to show
and select Show Header on the field menu.
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i Conns
Rows . SUM(Sales) e
] Filter..

Region Show Filter

Format...
Show Header
v Include in Tooltip

Dimension
Attribute
© Measure (Sum) 3

Panes
A pane is defined by the intersection of fields on the rows and columns shelves.

In a table calculation, this is seen as one or more cells that belong to the same field, which are
computed down or across according to the calculation, as in the example below:

Pages iii Columns
gitters Order Date
Quarter of Orde.. Month of Order .. 2011 2012 2013 2014
Q1 January
Marks February 39136 -$5,963 $4,325  -$24,420
[T] Automatic . March 350880 $26,256 $28,319 $33,625
Q2 April
n | &
ane | & ||| o= May -$4647  -$4,084 517,442 $5,539
. 0 June $10,947 -$5,334 -$17,261 $2,609
Detail | Toaltip Q3 July
August -$6,037 $8,133 -$5,175 $13,088
September $53,868 $27,658 $39,643 $28,973
Q4 October
Movember $47,175 $44,568 $25,729 $34,533
December -$9,083 -$1,053 315,045 -$21,852

For more information, see Transform Values with Table Calculations on page 2406.

Cells

Cells are the basic components of any table you can create in Tableau, defined by the
intersection of a row and a column. For example, in a text table, a cell is where the text is
displayed, as shown in the view below:
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Marks

When you drag fields to the view, the data are displayed using marks. Each mark represents the
intersection of all of the dimensions in the view.

For example, in a view with Region and Year dimensions, there is a mark for every
combination of those two dimensions (East 2011, East 2012, West 2011, West 2012, etc.). In
this case, the mark type is set to Text, so the Abc represents the location where the value for
the text mark will appear—once a measure such as Sales is added to the view.

(RGN = YEAR(Order Date)
& Rows
Order Date
Region 20mM1 mz2 2013 2014
Central Abc Abe Abec Abec
East Abc Abe Abec Abec
South Abc Abe Abec Abec
West Abc Abe Abec Abec
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For details on creating and customizing marks, see Marks card on page 227, Control
the Appearance of Marks in the View on page 1356, Change the Type of Mark in
the View on page 1332, Stack Marks on page 1392

Marks can be displayed in many different ways including lines, shapes, bars, maps, and so on.
You can show additional information about the data using mark properties such as color, size,
shape, labels, etc. The type of mark you use and the mark properties are controlled by the
Marks card. Drag fields to the Marks card to show more data. For example, the same view
above is shown again below but this time with Profit on Color. With this additional information,
it is clear that the West region had the highest profit in 2014.

~ Pages fi§ Columns B YEAR(Order Date)
12 Rows
~ Filters Profit

5540 N 542901 Region

Central

~ Marks East
South

West

0O Automatic .

H- & |

Codor S Labe

oho 0

Detail Taottip

! EIEDD

Control the marks in the view using the Marks card. Use the drop-down menu to specify the
type of mark to show. Drag fields to the Marks card and use the drop-down controls to add
more information to the view and control the color, shape, size, labels, and number of marks in
the view.

Tooltips

Tooltips are additional data details that display when you hover over one or more marks in the
view. When you select one or more marks and hover, tooltips also include options to filter
marks (exclude or keep only), display marks that have the same values, create groups, create
sets, or display the underlying data. If you don't want users to be able to access tooltip
commands, you can disable them.
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For details on formatting tooltips and other tooltip settings, also see Format Titles, Captions,

Tooltips, and Legends on page 2937, Add tooltips to marks on page 1366, and Create

Views in Tooltips (Viz in Tooltip) on page 1475. For details on analysis options in tooltips,

see Explore and Inspect Data in a View on page 2707

Tooltip command buttons for exploring data in a viz

The top of the tooltip lists commands for filtering data, creating a group, sorting the selection,

and view the underlying data. For example, you can use the tooltip to quickly remove an outlier

in a scatter plot. Each of the commands are described below.

To see tooltip commands, hover over a mark and then keep the cursor still. The

Keep Only - creates a filter that removes all other data. See Select to keep or exclude
data points in your view on page 1412 to learn more.

Exclude - creates a filter that removes the selected data. See Select to keep or
exclude data points in your view on page 1412 to learn more.

Group Members - creates a group based on the selection. If the selection contains
multiple dimensions, you can group on one dimension or all dimensions. See Correct
Data Errors or Combine Dimension Members by Grouping Your Data on
page 1184 to learn more.

Create Set (Tableau Desktop only) - creates a new set containing the selected
members. You can create a new set or add members to an existing set. See Create Sets

on page 1186 to learn more.

View Data - opens a window displaying the data. You can view the summarized data or
the underlying data. See View Underlying Data on page 2728 to learn more.
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These commands are visible by default. You can disable the commands in the Edit Tooltip
dialog box by deselecting Include command buttons. Doing so will also hide the
aggregation summary if multiple marks are selected.

Disable tooltip commands

If you don't want users to be able to access tooltip commands, you can disable them.
1. Click Tooltip on the Marks card or select Worksheet >Tooltip.
2. In the Edit Tooltip dialog box, clear the Include command buttons check box.

Tooltip settings apply to the active worksheet and can be different for each sheetin the
workbook.

Body text and markup in tooltips

The body of a tooltip contains details about a specific mark or a selection of multiple marks. For
example, in a bar chart showing sales by region, the tooltip body may include the actual sales
amount and the region name. The default tooltip is based on the fields used in the view. You
can customize what is shown in the tooltip by dragging fields to Tooltip on the Marks card.

To customize a tooltip and its formatting, click Tooltip on the Marks card.

Alternatively, you can select Worksheet > Tooltip.

Action links

If the sheet has any actions, the action links are listed below the body of the tooltip. An action
adds context and interactivity to your data through filters, highlighting, and links to external
resources. See Actions on page 1491 to learn more about adding actions to your workbook.

Titles

You can show titles on any worksheet, dashboard, or story. For worksheets and stories, a title
is displayed by default, but you can remove it. For dashboards, you can add a title. By default,
the title is the name of the sheet, but you can edit the title to change the text and include
dynamic values such as page number and sheet name. For more information about how to
format titles, see Format Titles, Captions, Tooltips, and Legends on page 2937.

Show and hide titles in worksheets

Titles are shown by default for worksheets and are included as part of the worksheet, shown at
the top of the view. You can move the title to the sides or the bottom of the view. However,
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when you move the title from the top of the view, it becomes a Title card and displays like any
other card in the view.

Note: If you move a title from the top position and then hide it; when you show the title
again, it appears back at the top of the worksheet in its default position.

2013 Regional Sales

Crdst Date / Rogion
201

5180,000

$160,000

Title iii Columns @ YEAR(Order Date)
Sales by Region = Rows SUM(Sales)

5140,000

$120,000
Order Date / Region

. 2011 2012 2013 2014
5 S0 $260,000

580,000 . $240,000

$220,000
$200,000
$180,000

$160,000

8 $140,000
@
$120,000
$100,000
580,000 I

To show or hide titles in a worksheet
¢ From the toolbar menu, click Worksheet > Show Title.

e On the toolbar, click the drop-down arrow on the Show/Hide Cards button and select
Title from the context menu.

Toggle the check mark on or off to show or hide the title.

Show and hide titles in dashboards
You can turn on titles for dashboards. The title appears as part of the dashboard.

To show or hide titles on a dashboard, from the toolbar menu, select Dashboard > Show Title.
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When you add worksheets to the dashboard, the title of the worksheet automatically shows,
even if you turned off the title on the worksheet itself. To turn off the title for the worksheet on
the dashboard, do the following steps:

1. Inthe dashboard, select the worksheet to highlight it.
2. Inthe top right corner of the highlighted worksheet, click the drop-down arrow and select
Title in the context menu to clear the check mark.

Show and hide titles in stories

Story titles are displayed by default. To toggle story titles on or off, in the top menu, select
Story > Show Title to add or remove the check mark.

Captions

All views can have a caption that is either automatically generated or manually created. The
caption is displayed on the Caption card.

To show a caption in a worksheet, select it on the Show/Hide Cards toolbar menu Bl - o

select Worksheet > Show Caption.
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Caption

Sum of Sales for each Category. Color shows details about Region. The
view is filtered on Region, which keeps Central, East and South.

The caption is automatically generated by default.

To edit the caption, double-click the Caption area in the view. In the Edit Caption dialog box,
you can use change the font, size, color, and alignment and style.

Tableau Book ¥ 9 - IE' - =] || Insert= |

Sum of Sales for each Category
Color: Region

Click the Insert menu to add automatic text such as page number, sheet name, and field and
parameter values.

The caption can optionally be included when printing, printing to PDF, and publishing to
Tableau Server. When you export the view as an image to another application like Microsoft
PowerPoint, you can optionally include the caption.

Field Labels

Placing discrete fields on the rows and column shelves creates headers in the view that display

the members of the field. For example, if you place a field containing products on the rows shelf,

each product name is shown as row headers.

In addition to showing these headers, you can show field labels, which are labels for the

headers. In this example, the rows are labeled Category, to indicate that the discrete category

names are members of the Category field.
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Region / Order Date

Category

Field labels apply only to discrete fields. When you add continuous fields to the view, Tableau
creates an axis. The axis is labeled with a header.

By default, field labels are shown.

To hide or show field labels, select Analysis > Table Layout > Show Field Labels for
Rows or Show Field Labels for Columns.

Analysis ||
Show Mark Labels
v Aggregate Measures
Stack Marks »
== View Data..
Reveal Hidden Data
Percentage of -
Totals "
Forecast b
Trend Lines »
Special Values b
Table Layout » Show Empty Rows
Legends vl Show Empty Columns
Filters , | ¥ Show Field Labels for Rows
Parameters , v Show Field Labels for Columns
Create Calculated Field... Advanced...
Edit Calculated Field 9

You can format the fonts, alignment, shading, and separators for field labels.
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Legends

When you add fields to Color, Size, and Shape on the Marks card, a legend displays to indicate
how the view is encoded with relation to your data.

Color Legend

Region

B central
. East
. South
. West

Size Legend

SUM(Sales)
$503
£20,000
£40,000
£50,000
£30,000
$101,781

Shape Legend

Category

QO Furniture
O office supplies
<+ Technology

Not only do legends help you understand encodings, you can also use legends to sort, filter,
and highlight specific sets of data. For more information, see Legend Highlighting on
page 1499.

Measure values and color legends

If you include the Measure Values and Measure names fields in your views, you can create
either a single combined color legend or separate color legends for your measures. If you drag
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the Measure Values field to Color on the Marks card, by default Tableau creates a single
color legend that applies one color palette to all marks in the view. If you want to differentiate
certain measures in the view you can create separate color legends for the measures and
assign a unique color palette to each legend.

For more information about Measure Values and Measure Names, see Measure Values and
Measure Names on page 1310.

The following example shows how to create separate color legends. This example uses the
Sample Superstore data set.

1. Connect to the Sample-Superstore data set.
2. From the Data pane:

e Drag Order Date to the Columns shelf and Category and Sub-Category to the
Rows shelf.

« Drag Measure Names to the columns shelf and drop it to the right of Order
Date.

o Drag Measure Values to Color on the Marks card.

3. Inthe Measure Values card, drag measures off the card so that you keep SUM(Sales),
and SUM(Profit) only.

4. Click Label on the Marks card and select Show mark labels to show the measure
values in the view.

When you drag Measure Values to Color on the Marks card, Tableau creates a single
color legend and adds it to the view. Your view should look something like this.

Fages il Golumns & YEAR(Order Date)
= fiows & Calegory & Sub-Calegary
Filtars Order Date Measure Values
Lo, —
Measure Names Category S 6,141 105,643

Furniture =
Marks.
O Automatic
office
n & i3] Supplies
Color | Size || Label

[=}

Deseil | Tochtip

B Measure Values

: 514,835
34,16 EETEES]
4,394

Measure Values

SUM(Sales)

5. To create separate legends for each measure on the view, click the drop-down arrow on
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the Measure Values field in the Marks card and select Use Separate Legends from
the context menu.

Tableau Desktop version Web version

I

Use Separate Legends

Tableau creates an individual color legend for each measure in the view using the default
color palette.

Pages. il Columns

= Rows

SUM(Prafit)

. T——

Category  Sub-Catego.. 48,141 425,032
Fumniture  Eockcases

Chairs SUM(Sates)

Lo

Tables
Office Appliances $545 £105,643
Supplies At

Binders
Envelopes
Fasteners
Labels
Paper
Starage
Supplies
Technology  Accessories

Coplers
Machines
Phaaes

To assign a different color palette to the color legend, do one of the following:
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o In Tableau Desktop, click the drop-down arrow in the top right corner for each
color legend and select Edit Colors. Then select a color from the Palette drop-

down list.

o In Tableau Server or Tableau Online, click the drop-down arrow in the top right
corner for each color legend. Then select a color from the Palette drop-down list.

Your view might look something like the following example:

Pages iil Comng

= Rows
SUM{Profit)

| ——
48141 525,032

SUM{Sales)

|
4525 $105.643

Office
Supplies

Technato...
Measure Values.

SUM(Profit)

6. To combine the separate legends back to a single legend, click the drop-down arrow on
the Measure Values field on the Marks card and select Combine Legends from the

context menu.

Tableau Desktop version Web version
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Marks -
: ~ Marks
D Automatic |~
| O Automatic - |
HH & @
Color  Size | Label | s s
o 0 ' Color | Size | Label
Detail | Toolti .
. .l p ) [=]=1=) Q
EH Detail | | Tooltip
Edit Filter...
: : Measure Values
Combine Legends
— Show Filter
v Show Measure Values Shelf |
show Filter | Combine Legends

Format... |

i| Include in Tooltip v Include in Tocltip

~ Attribute ' i
il Measure (Sum) L Format Number...
Remove
Remowve
Workbooks and Sheets

Tableau uses a workbook and sheet file structure, much like Microsoft Excel. A workbook
contains sheets. A sheet can be a worksheet, a dashboard, or a story.

» Aworksheet contains a single view along with shelves, cards, legends, and the Data and
Analytics panes in its side bar. For details on the worksheet workspace, see The
Tableau Workspace on page 192.

o Adashboard is a collection of views from multiple worksheets. The Dashboard and
Layout panes are available in its side bar. For more details about creating dashboards,
see Dashboards on page 2735.

o Astory contains a sequence of worksheets or dashboards that work together to convey
information. The Story and Layout panes are available in its side bar. For more details
about creating stories, see Stories on page 2845.

For details on hiding or showing sheets in a workbook or Viz in Tooltip, see Manage Sheets in
Dashboards and Stories on page 2834 and Hide or show a Viz in Tooltip worksheet on
page 1483. For details on organizing sheets, see Navigate and Organize Sheets on

page 269. For details on creating and opening workbooks, see Create or Open Workbooks
on page 265.
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About sheets

Each workbook can contain different types of sheets: views (also known as worksheets),
dashboards, and stories.

« Aworksheetis where you build views of your data by dragging and dropping fields onto
shelves.

o Adashboard is a combination of several views that you can arrange for presentation or
to monitor.

« Astoryis a sequence of views or dashboards that work together to convey information.

The sheets display along the bottom of the workbook as tabs. In this section you’ll learn how to
create, open, duplicate, hide, and delete sheets. You'll also learn how to organize sheets in a
workbook.

Within a workbook, you can create new sheets, clear an entire worksheet, duplicate sheets,
hide or show a worksheet, and delete a sheet. Tableau has several ways to view and organize
the sheets in your workbook.

Create new worksheets, dashboards, or stories

There are several ways to create new sheets in a workbook, dashboard, or a story. You can
create as many sheets in a workbook as you want.

To create a new worksheet, dashboard, or story, click the New Worksheet, New
Dashboard, or New Story button at the bottom of the workbook.

LT_L

The New Worksheet button.

To rename a new worksheet, dashboard, or story, right-click (Ctrl-click on a Mac) the tab
and then select the Rename command.

More ways to create new worksheets
Create a new worksheet by doing one of the following:
o Select Worksheet > New Worksheet.

» Right-click any open tab in the workbook, and select New Worksheet from the menu.
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¢

« Onthe toolbar, click the drop-down arrow on the New Workshee button and then

select New Worksheet.

o Press Ctrl + M on your keyboard (Command-M on a Mac).

More ways to create new dashboards

Create a new dashboard by doing one of the following:

o Select Dashboard > New Dashboard.

¢ Clickthe New Dashboard button at the bottom of the workbook.

« Right-click on any open tab in the workbook, and select New Dashboard from the menu.

o Onthe toolbar, click the drop-down arrow on the New Worksheet by - button and then

select New Dashboard.

More ways to create new stories

Create a new story by doing one of the following:

Select Story > New Story.

« Click the New Story button at the bottom of the workbook.

oo 15

Right-click on any open tab in the workbook, and select New Story from the menu.

« Onthe toolbar, click the drop-down arrow on the New Worksheet “% " button and then

select New Story.

Undo, redo, or clear sheets
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Every Tableau workbook contains a history of steps you have performed on the worksheets,
dashboards, and stories in that workbook for the current work session.

To move backward through the history, click Undo € on the toolbar or press Ctrl + Z on

your keyboard (Command-Z on a Mac).

To move forward through the history, click Redo —* on the toolbar or press Ctrl + Y

(Command-Y on a Mac) on your keyboard.

To remove all fields, formatting, sizing, axis ranges, filters, sorts, and context filters

in the sheet, click Clear Sheet b - on the toolbar.

To clear specific aspects of the view, use the Clear Sheet drop-down menu.

Note: Using the clear commands on the toolbar does not clear the history. If you decide
that you didn’t want to clear the sheet, click the Undo button.

Duplicate a sheet

When you want to use an existing sheet as a jumping off point for more exploration, you can
duplicate that sheet. The duplicated sheet contains all of the same fields and settings as a
starting point for new analysis.

Duplicate creates a new version of a worksheet, dashboard, or story you can modify without
effecting the original sheet.

To duplicate the active sheet, right-click the sheet tab (control-click on Mac) and select

Duplicate.

Note: When you duplicate a dashboard, a new version of the dashboard is created, but
it still references the original worksheets that were used to create the dashboard.

Duplicate as Crosstab

A crosstab (sometimes referred to as a Pivot Table) is a table that summarizes data in rows
and columns of text. It is a convenient way to display the numbers associated with the data
view.
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To create a new cross-tab sheet based on the data in the current sheet, right-click the sheet tab
(control-click on Mac) and select Duplicate as Crosstab. Or select Worksheet > Duplicate
as Crosstab.

This command inserts a new worksheet into your workbook and populates the sheet with a
cross-tab view of the data from the original worksheet. Dashboards and stories cannot be
duplicated as crosstabs.

Rename sheets

To rename the active sheet, right-click (control-click on Mac) the sheet in the sheet tab along
the bottom of the workbook, and then click Rename Sheet .

Or, double-click the name of the sheet in a sheet tab, type a new name, and then click Enter.

See the underlying data in a sheet
To see the numbers behind the marks in your view

Hover over or click a mark to display the associated data in a tooltip. With the tooltip open, click

the View Data command at the top of the tooltip to view underlying data.
Right-click the view (with no marks selected), and then click View Data.

You can copy and paste the data into Excel or another application. To export the underlying
data, click Export All.

Delete sheets

Deleting a sheet removes it from the workbook. There must always be at least one worksheet in
a workbook.

To delete the active sheet, right-click (control-click on Mac) the sheet in the sheet tab along the
bottom of the workbook, and then click Delete .

Worksheets used in a dashboard or story cannot be deleted, but they can be hidden.

A worksheet used as Viz in Tooltip can be hidden or deleted.

Create or Open Workbooks

A workbook contains one or more sheets, each of which can be a worksheet, dashboard, or
story. You can use workbooks to organize, save, share, and publish your results.

» Create or open a workbook on the next page

« Open a workbook that has an unsupported data connection on the Mac on the
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next page

« Open a published workbook from the server on the facing page

Create or open a workbook
When you open Tableau, a new, blank workbook opens automatically.
To create a new workbook, select File > New

To open an existing workbook, click the thumbnail image of the workbook on the start
page.

You can open multiple workbooks simultaneously. Each workbook appears in its own window.

Note: When you open multiple workbooks in Tableau Desktop on the Mac, multiple
instances of the application are created, each with its own icon in the Dock. This differs
from typical Mac application behavior, where one instance of the application handles all
open documents.

Open a workbook that has an unsupported data connection on the Mac

When working in Tableau Desktop on the Mac, you might need to open a Windows workbook
that contains data sources that are not supported in Tableau Desktop on the Mac. To do so,
follow the steps below:

1. In Tableau Desktop on Windows, save the workbook as an extract. To create and save
an extract, on the Data menu, select a data source, and then select Extract Data.
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[Data] worksheet Dashboard story 2

Create Mew Data Source  Ctrl+D
Paste Data Ctrl+V
Refresh All Extracts...

Edit Relationships...

Replace Data Source...

Upgrade Data Sources...

Sales Target L
| ¥ Sample - Superstore £ Edit Data Source...
Refresh F5
T View Data..

Rename...
Duplicate
Close

&

Extract Data...

Use Extract
2. Open the extract file (.hyper) you saved in Tableau Desktop on your Mac.

Open a published workbook from the server

If you have been granted the Download/Web Save As permission for a published workbook,
you can use Tableau Desktop to open the workbook from the server. When you open a
workbook from the server and make changes, you can save it to your computer or, if you have
been allowed the Write/Web Save permission, you can save the changes directly on the
server.

To open a workbook from the server

1. Select Server > Open Workbook.

[Server Window Help

Sign Out

Open Workbook...
Publish Workbook...

s

Create User Filter ¥

Tableau Public r

2. Ifyou are not already signed in to Tableau Server or Tableau Online, do so at the prompt.

If you’re not sure how to sign in to the server you use, see Sign in to Tableau Server or
Tableau Online on page 364.

3. Inthe Open Workbook from Tableau Server dialog box, select the workbook you want to
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open, and then click Open.

Open Workbook from Tableau Server_ u

Eind: [MyWorkbooks "] | v| |’| |
Mame Publisher Project Maodified Size
Book4 adrmin Default Feb 5, 9:53 AM 639 KB
%Earmer BI Magic ... Default Feb 8, 1:43 PM
Nnt all are visible admin Indiana Today, 10:06 AM 3 MB

[#Profits US Map admin Indiana Feb 5, 1:56PM 3 MB

Mame: Gartner BI Magic Quadrant v8

Tip: You can use the Find drop-down list or the Search box to browse or search for the

workbook you want.

You can search all workbooks on the server or find by tags, publisher, project, or

workbooks that you published.
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Open Workbook from Tableauw Server I k !

Find: [My Workbooks 1:1@ 2|
Search L

Mame BY Tags Project Modified Size
_ By Publisher

BtBy Project Default Feb 5, %:53AM  B33KB
Gi_| W Default Feb8, 1:43PM  72KB
N oorkboo Indiana Today, 10:06 AM 3 MB

[l Profits US Map admin Indiana Feb 5, 12:56PM 3 MB

Navigate and Organize Sheets

You can navigate and organize sheets in a workbook using the sheet tabs, the filmstrips, or the
sheet sorter.

Options for navigating, viewing, and organizing sheets
There are three ways to navigate and view the sheets in a workbook:
o Tabs at the bottom of the workbook
o In the filmstrip view
e Inthe sheet sorter view

The tabs are useful when you want to quickly navigate between a small number of sheets. If
your workbook has a large number of sheets, you can use the sheet sorter to easily navigate
them all.

You can also drag and drop to do the following:
o Reorder the sheets
o Create new sheets

o Duplicate or delete existing sheets from any of the views

Navigate with sheet tabs

Each sheet is represented as a tab along the bottom of the workbook. Select any tab to open
the corresponding worksheet.
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Parameters 0% .

# Profit Bin Size CFIirm
# Top Customers =

B Data Source Sheet 1 Sheet 2 H Dashboard1 [} H 03

In the bottom right corner of the application window, there are several controls that you can
use to advance through each sheet or quickly jump to the first or last sheet in the workbook.
These controls are only available when there are too many sheet tabs to show across the
bottom of the application window.

You can also navigate between sheets using the window menu or move through the multiple

worksheets by pressing the left or right arrow keys on your keyboard.

To navigate through multiple worksheets, select a worksheet tab at the bottom of the workbook
first.

Note: Navigating within a story is a different matter—there, you use the Navigator to
move between story points. See Create a Story on page 2852.

Show thumbnails with the filmstrip

Similar to the sheet tabs, the filmstrip displays along the bottom of the workbook. However,
instead of just sheet names, the filmstrip also shows a thumbnail image of each sheet. The
filmstrip is useful when you are using Tableau to present your analysis and works well when
you are working in Presentation mode.

Open the filmstrip by clicking the Filmstrip ™ button on the status bar( bottom right corner) of

the workbook. Just like with the tabs, select the thumbnail image for the sheet you want to
open. You can right-click the images to specify commands that apply to each sheet.

Note: When viewed from a Retina display, workbooks that are created on a standard
resolution device will show only the first thumbnail in the filmstrip in high resolution. To
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display all thumbnails in the filmstrip in high resolution, resave the workbook on a
computer with Retina display.

Sls

Data Source

TR
[l-wqmmpw‘

I

| FIELE B
B Data Source | B Overview B Product B Customers  H Shipping Performance Forecast What If Forec... U

Manage many sheets with sheet sorter

The sheet sorter shows all sheets in a workbook as thumbnailimages on a single page. The
sheet sorter is useful when you have a large number of sheets in a workbook. Open the sheet

sorter by clicking the sheet sorter # button on the status bar (bottom right corner of the

workbook).
. = ==
' .'q_ [ES— S
R \"_.f .
N LT
(el § .
. e, "
e «
Overview Product Customers Shipping
Performance Forecast What If Forecast

Right-click a sheet (Control-click on the Mac) to see these commands. You can also right-click
(Control-click on the Mac) to refresh the thumbnail image of a particular sheet or Refresh All
Thumbnails at once. If you have a large number of sheets, refreshing your view can take some
time.

Sheet commands

Use sheet commands to manage and organize your worksheets. For example you can create
new sheets, duplicate sheets, copy formatting, apply color, or delete the sheet entirely.
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You can access sheet commands on the right-click menu (Control-click on a Mac) in the
worksheet, sheet sorter, or the filmstrip view. To apply commands to multiple sheets at once,
press the Ctrl key (Shift key on a Mac), and then select the sheets.

To make it easier to identify and group sheets, you can assign a color to sheets. You can select
from seven different colors. Selecting None clears the color.

To assign a color to sheets, select one or more sheets, right-click the sheets (Control-click on
the Mac), select Color, and then pick a color.

e B i iom i [ Order Details
B4 MNew Worksheet

0L MNew Story

Copy
Paste

Rename Sheet
Delete

Duplicate
Duplicate as Crosstab
Export..

Copy Formatting
Paste Formatting
Save Default Formats
Load Default Formats

Color L

MNone

Blue
Red
Yellow
Brown
Purple
Green
Teal

ENENECENC

The color strip appears on the bottom of the tab or sheet.

- R — —
Parameters Corporate | — ™
% ChurnRate Home Office | - [l

) $0 $10,000 520,000 SO $10,000 520,000 S

# New iness Growth

0 Data Source BB Overview | 8 Product B8 Customers | B Shipping | Performance | Forecast = What

),

qupy-

Performance Forecast What If Forecast
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Reorganizing the Workspace

Every worksheet contains a variety of cards, shelves, legends, and so on. You can reorganize
the workspace by rearranging cards, hiding and showing specific parts of the workspace, and
hiding everything but the view using Presentation Mode.

Rearranging Cards

A worksheet contains several cards that contain shelves, legends, and other controls. Each
card can be rearranged to create a custom workspace. To move a card, point the cursor at the

title area of the card you want to move. When the cursor becomes the move symbol ‘%’ click

and drag the card to a new position. As you drag the card around the worksheet, the possible
positions for it are highlighted with a black bar.

Pages lii Columns
= Rows SUM(Sales)
Filters Rogian

700,000

Marks
nl Automatic - $600.000
1 & |
Color Size Label $500,000
oda Q
Dotad Teallin
» $400,000
i
Segment & - $300.000
W Consurner
W Corporate
W Home Office $200.000
100,000
0

Central  East South West

Sales

You can restore the worksheet windows to their default state by selecting Reset Cards
on the Show/Hide Cards toolbar control.
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Showing and Hiding Parts of the Workspace

Just about everything in the workspace can be turned on and off so you can avoid cluttering
the worksheet with unnecessary cards, shelves, etc.

o To show and hide the toolbar or status bar, select Window and then select what you
want to hide.

« Toshow and hide the window on the left side, which is either the Data pane (for
worksheets), the Dashboard pane (for dashboards), or the Dashboards and Sheets

pane (for stories); click the Minimize button ¥ in the upper right corner of the pane. The

pane is minimized to the bottom left corner of the workbook. Click the same button again
to restore the pane.

« Toshow orhide a card click Show/Hide Cards &0 - on the toolbar and then select the

card you want to show or hide.

You can restore the worksheet windows to their default state by selecting Reset Cards on the

Show/Hide Cards toolbar control.

Presentation Mode

Sometimes you may want to use Tableau to present your findings. Rather than hiding each
card or shelf one at a time, you can switch to presentation mode. Presentation mode hides
everything on the sheet except for the view and its associated legends, filter cards, parameter
controls, and worksheet tabs.

« Toswitch in and out of presentation mode, click the Presentation Mode = button on

the toolbar or select Window > Presentation Mode.

Use the presentation mode controls in the bottom right corner to move between sheets and
more. Each presentation mode control is described below.

Show Filmstrip - shows the sheets as thumbnails at the bottom of the workspace.

Show Tabs - shows the sheet tabs at the bottom of the workspace.
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+ | Previous/Next Sheet - advances forward or backward through the sheetsin a
workbook.

Enter/Exit Full Screen - switches between expanding the workbook to fill the
entire screen and showing it in a window.

Exit Presentation Mode - returns the workbook to showing the entire workspace
including the menus, toolbar, and the Data pane.

Tableau File Types and Folders

You can save your work using several different Tableau specific file types: workbooks,

bookmarks, packaged data files, data extracts, and data connection files. Each of these file

types are described below. For related details, see Save Your Work on page 3017.

Workbooks (.twb) — Tableau workbook files have the .twb file extension. Workbooks
hold one or more worksheets, plus zero or more dashboards and stories.

Bookmarks (.tbm) — Tableau bookmark files have the .tbm file extension. Bookmarks
contain a single worksheet and are an easy way to quickly share your work. For more
information, see Save a bookmark on page 3019.

Packaged Workbooks (.twbx) — Tableau packaged workbooks have the .twbx file
extension. A packaged workbook is a single zip file that contains a workbook along with
any supporting local file data and background images. This format is the best way to
package your work for sharing with others who don’t have access to the original data. For
more information, see Packaged Workbooks on page 3022.

Extract (.hyper or .tde) — Depending on the version the extract was created in, Tableau
extract files can have either the .hyper or .tde file extension. Extract files are a local copy
of a subset or entire data set that you can use to share data with others, when you need
to work offline, and improve performance. For more information, see Extract Your Data
on page 1014.

Data Source (.tds) — Tableau data source files have the .tds file extension. Data source
files are shortcuts for quickly connecting to the original data that you use often. Data
source files do not contain the actual data but rather the information necessary to
connect to the actual data as well as any modifications you've made on top of the actual
data such as changing default properties, creating calculated fields, adding groups, and
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so on. For more information, see Save Data Sources on page 1075.

o Packaged Data Source (.tdsx) — Tableau packaged data source files have the .tdsx
file extension. A packaged data source is a zip file that contains the data source file (.tds)
described above as well as any local file data such as extract files (.hyper or .tde), text
files, Excelfiles, Access files, and local cube files. Use this format to create a single file
that you can then share with others who may not have access to the original data stored
locally on your computer. For more information, see Save Data Sources on
page 1075.

These files can be saved in the associated folders in the My Tableau Repository directory,
which is automatically created in your My Documents folder when you install Tableau. Your
work files can also be saved in other locations, such as your desktop or a network directory.

Changing the Repository Location

You can specify a new location for the Tableau repository if you are not using the default
location in your Documents folder. For instance, if you are required to have your dataon a
network server instead of on your local machine, you can point Tableau at the remote
repository.

1. SelectFile > Repository Location.

2. Select a new folder that will act as the new repository location in the Select a Repository
dialog box.

3. Restart Tableau so that it uses the new repository.

Changing the repository location does not move the files contained in the original repository.
Instead, Tableau creates a new repository where you can store your files.

Language and Locale

Tableau Desktop is localized into several languages.

When you first run Tableau, it recognizes your computer locale and uses the appropriate
language if it is supported. If you are using an unsupported language, the application defaults
to English.

You can configure Tableau to display the user interface (menus, messages, etc.) by choosing
Help > Choose Language. After you change this setting, you’ll need to restart the application
for the changes to take effect. You do not need to change this setting for every workbook.
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To configure date and number formatting, choose File > Workbook Locale. By default, the
locale is set to Automatic, which means the locale will match the locale when the workbook is
opened. This can be useful if you are authoring a workbook that will be viewed in many different
languages and you want the dates and numbers to update accordingly. When you select a
specific locale, the workbook will not change regardless of who opens it.

Tableau checks the following, in order, to determine the workbook locale:
o Workbook Locale (explicit setting)
o Windows Locale or Mac language
o Tableau Language

If none of the above is set, then the workbook locale defaults to English.

Day of the Week Sorting

If you are working in a language for which Tableau does not provide a local version, set your
workbook locale to assure that Tableau can sort the days of the week in the correct
chronological order. Otherwise, Tableau will sort the names of the days alphabetically. If none
of the supported locales is appropriate, you can sort the days of the week manually. See Sort
Data in a Visualization on page 1447.

Visual Cues and Icons in Tableau Desktop

Tableau provides many visual cues to help you evaluate the type of data that’s displayed in the
Data pane and the state of a data view.

Data sources in the Data pane

The following table explains each of the icons used to describe the type of data sources in the
Data pane. Each icon in the table can be modified by one of two indicators.

o Ablue check mark indicates that the data source is the primary data source in the work-

book. @

« Anorange check mark indicates that the data source is the secondary data source in the

workbook. @
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Visual | Description
Cue
The workbook is directly connected to a relational data source or file.
Bt
]
The workbook is connected to a cube (multidimensional) data source. In
DT Tableau, cube data sources are supported only in Windows.
Te
The workbook is connected to an extract that still references the underlying data.
5
&)
€
The workbook is connected to an Excel table, sub-table, or named range.
B=
(=]

The workbook is connected to a data source that has been published to Tableau
Server.

Fields in the Data Pane

The following table explains each of the icons displayed in the Data pane. Each icon in the
table can be modified by one of four indicators.

« Blue icons indicate that the field is discrete. #bc

. Greenicons indicate that the field is continuous. #

« Icons preceded by the equal sign (=) indicate that the field is a user-defined calculation

or a copy of another field. =Abc
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Visual
Cue

Description

fbc

=Abc

The field contains text values.

The field contains numeric values.

+ =H
The field is a calculation defined on the server.

:#E
The field contains only date values.

B

‘B
The field contains both date and time values.

)

P The field contains geographical data and has been assigned a geographic role.
Use these fields when building map views. See Maps and Geographic Data
Analysis in Tableau on page 1755.

The field contains geographical data from an active custom geocoding file. See

& Geocode Locations Tableau Does Not Recognize and Plot Them on a
Map on page 1818.

- The field contains boolean (true or false) values.

TF =TIF
The field is a calculation that is defined in the database by an administrator. These

i fields are marked with a cylinder icon and are not available for all data sources.

> The field is a user-defined set. See Create Sets on page 1186.
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Visual | Description

Cue
The field is a server named set.

@]
The field is a set that was automatically created as a result of an action.

@3
The field is a user filter, used when publishing to the web. See Restrict Access

% at the Data Row Level on page 3088.
The field is a numeric bin. See Create Bins from a Continuous Measure on

Al

" page 1705.

- The field is a group. See Correct Data Errors or Combine Dimension Mem-
bers by Grouping Your Data on page 1184.

. The field is a cluster group. See Find Clusters in Data on page 2554.

e
The field is a relational hierarchy. See Create Hierarchies on page 1170.

AT
Afolder that contains one or more fields. Folders are used to organize fields in the

=

= Data pane. See Organize the Data Pane on page 1146.

The field is an attribute of a cube (multidimensional) data source. In Tableau,
cube data sources are supported only in Windows.
The field is a varying attribute of a cube (multidimensional) data source.
The field is a level in a multidimensional hierarchy. Levels greater than five are

1

& shown without numbers.

B The field is blended with a field from another data source. See Blend Your Data
on page 910
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Visual | Description
Cue

The field is not blended with a field from another data source. See Blend Your

cla

Data on page 910

Fields on Shelves

Fields placed on shelves use a combination of icons, colors, and text styles as visual cues.

Visual Cue Description

Ablue field on a shelf indicates a discrete field. In most cases,
adding a dimension to a shelf results in a blue field. Blue fields

are discrete—they contain a finite number of values. Adding a
blue field to a shelf creates headers. For details, see Headers
on page 242.

A green field on a shelf indicates a continuous field. In most
cases, adding a measure to a shelf results in a green field.

Green fields are continuous—they contain an infinite number of
values. Adding a green field to a shelf creates an axis. For
details, see Axes on page 246.

The Sort icon indicates a field that has either a computed or
manual sort order applied. See Sort Data in a Visualization
on page 1447.

The sigma icon indicates a slicing filter in a multidimensional
z (cube) data source. See Create Slicing Filters on page 1091.

The Venn diagram icon indicates a set. See Create Sets on

page 1186
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Visual Cue Description

A field name shown in italics indicates a filtered set.

Core Product.. @

A gray field on the Filters shelf indicates a context filter. See
Segment: Corporate Improve View Performance with Context Filters on
page 1439.

The delta icon indicates that the field is a table calculation. See
Transform Values with Table Calculations on page 2406.

The plus and minus controls appear when the field is part of a

j A
hierarchy that you can traverse.

The arrow icon indicates that a forecast is being displayed for

the field. This icon is also used on the Forecast Indicator field,

which is an automatic field used to distinguish between actual
and forecast values. See Forecasting on page 2580.

The field is from a secondary data source. See Blend Your

Data on page 910.

The field is assigned to a specific worksheet.

[ | Last Sale Price

The field is assigned to all worksheets with the same data
O Segment source.

The field is incompatible with one or more other fields in the
Internet Sales Amount ! view.

Fields on the Marks card

Fields placed on the Marks card use specific icons to describe how they appear in the view. For
more details, see Control the Appearance of Marks in the View on page 1356.
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Visual Cue Description

The field is applied to Color on the Marks card.

:: D

The field is applied to Size on the Marks card.

3% SUM(Profit) ~

The field is applied to Label on the Marks card.

AVG(Discou.. ¥

The field is applied to Shape on the Marks card.

2 Sub-Category

The field is applied to Detail on the Marks card.

2 SUM(True Average)

The field is applied to Tooltip on the Marks card.

~ QEETND

The field is applied to Path on the Marks card. Path is only
~ available when the Line or Polygon mark type is selected
from the Marks drop-down menu.

Sheets in the Dashboards and Worksheets pane

The following table explains each of the icons used to describe the type of sheet that can be
placed in a story. A blue check mark indicates that a sheet is being used in one or more story

points. @
Visual Cue Description
The sheet is a worksheet.
[a] L
— The sheetis a dashboard.
L]
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Fields in the Calculation editor

Fields in the calculation editor are color coded by field type.

Visual Cue Description

[ORANGE] The field is a dimension, set, or measure.

[Parameters]. | The field is a parameter. Tableau appends [Parameters] to avoid ambi-
[PURPLE] guity when a parameter has the same name as another field
[ORANGE]. The field is from a secondary data source.

[ORANGE]

BLUE() The field is a calculation function.

Tableau Concepts

What are dimensions and measures? Why are some fields dimensions and others measures?

Why is the background color blue for some fields, and green for others?

How does adding a filter affect my viz?

How does Tableau aggregate data in a view?

The topics in this section cover concepts that answer these questions to help you understand

why Tableau does what it does.

If you're new to Tableau Desktop, also see other topics in Get Started on page 169.

If you're new to Tableau Public, also see Tableau Public Resources.

Watch a video: To see related concepts demonstrated in Tableau, watch the free

training videos listed under \Why is Tableau Doing That? Use your tableau.com account

to signin.

284

Version: 2021.2 Tableau Software


https://public.tableau.com/en-us/s/resources
https://www.tableau.com/learn/training#why
http://www.tableau.com/

Tableau Desktop and Web Authoring Help

Structure Data for Analysis

There are certain concepts that are fundamental to understanding data prep and how to
structure data for analysis. Data can be generated, captured, and stored in a dizzying variety of
formats, but when it comes to analysis, not all data formats are created equal.

Data preparation is the process of getting well formatted data into a single table or multiple
related tables so it can be analyzed in Tableau. This includes both the structure, i.e. rows and
columns, as well as aspects of data cleanliness, such correct data types and correct data
values.

Tip: It may help to go through the following topic with a data set of your own. If you do not
already have a data set you can use, see our tips for finding good data sets.

How structure impacts analysis

The structure of your data may not be something you can control. The rest of this topic assumes
you have access to the raw data and the tools needed to shape it, such as Tableau Prep
Builder. However, there may be situations when you can't pivot or aggregate your data as
desired. It is often still possible to perform the analysis but you may need to change your
calculations or how you approach the data. For an example of how to perform the same
analysis with different data structures, see Tableau Prep Day in the Life Scenarios: Analysis
with the Second Date in Tableau Desktop. But if you can optimize the data structure it will likely
make your analysis much easier.

Data Structure

Tableau Desktop works best with data that is in tables formatted like a spreadsheet. Thatis,
data stored in rows and columns, with column headers in the first row. So what should be a row
or column?

What is a row?

Arow, or record, can be anything from information around a transaction at a retail store, to
weather measurements at a specific location, or stats about a social media post.

It's important to know what a record (row) in the data represents. This is the granularity of the
data.

Here, each record is a day Here, each record is a month
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Date Max TemperatureF Mean Temperatiiret Min Temneraturak |
1{'13’213'15 42 Date Max TemperatureF Mean TemperatureF  Min TemperatureF
1/2/2015 42 January 63 a5
1/3/2015 a1 Febriaw 62 49
1/4/2015 51 Marc 69 51
April 77 52
1/5/2015 24
May 82 39
1/6/2015 54
1{'! June 92 08
72015 a6 July 95 1
1/8/2015 a6 August 9 69
1/9/2015 50 September 81 61
1/10/2015 a6 October 74 58
MNovember 60 44

20
33
31

B&HEELEESL Y

Tip:A best practice is to have a unique identifier, a value that identifies each row as a unique
piece of data. Think of it like the social security number or URL of each record. In Superstore,
that would be Row ID. Note that not all data sets have a UID but it can't hurt to have one.

Try to make sure you can answer the question "What does a row in the data set represent?".
This is the same as answering "What does the TableName(Count) field represent?". If you
can't articulate that, the data might be structured poorly for analysis.

Aggregation and Granularity

A concept related to what makes up a row is the idea of aggregation and granularity, which are
opposite ends of a spectrum.

Aggregation

« refers to how multiple data values are brought together into a single value, such as
counting all the Google searches for Pumpkin Spice or taking the average of all the
temperature readings around Seattle on a given day.

« By default, measures in Tableau are always aggregated. The default aggregation is
SUM. You can change the aggregation to options like Average, Median, Count Distinct,
Minimum, etc.

Granularity
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« refersto how detailed the data is. What does a row or record in the data set represent? A
person with malaria? A provinces' total cases of malaria for the month? That's the
granularity.

« Knowing the granularity of the data is crucial to working with level of detail (LOD)
expressions.

Understanding aggregation and granularity is a critical concept for many reasons; it impacts
things like finding useful data sets, building the visualization you want, relating or joining data
correctly, and using LOD expressions.

Tip: For more information, see the training video Aggregation and Granularity or Data
Aggregation in Tableau in the Help

What is a field or column?

A column of data in a table comes into Tableau Desktop as a field in the data pane, but they are
essentially interchangeable terms. (We save the term column in Tableau Desktop for use in the
columns and rows shelf and to describe certain visualizations.) A field of data should contain
items that can be grouped into a larger relationship. The items themselves are called values or
members (only discrete dimensions contain members).

What values are allowed in a given field are determined by the domain of the field (see the note
below). For example, a column for "grocery store departments" might contain the members
"deli" "bakery", "produce", etc., but it wouldn'tinclude "bread" or "salami" because those are
items, not departments. Phrased another way, the domain of the department field is limited to

just the possible grocery store departments.

Additionally, a well-structured data set would have a column for "Sales" and a column for
"Profit", not a single column for "Money", because profit is a separate concept from sales.

o The domain of the Sales field would be values = 0, since sales cannot be negative.

o The domain of the Profit field, however, would be all values, since profit can be negative.

Note: Domain can also mean the values present in the data. If the column "grocery store
department" erroneously contained "salami", by this definition, that value would be in the
domain of the column. The definitions are slightly contradictory. One is the values that
could or should be there, the other is values that actually are there
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Categorizing fields

Each column in the data table comes into Tableau Desktop as a field, which appears in the

Data pane. Fields in Tableau Desktop must be either a dimension or measure (separated by a

line within tables in the Data pane) and either discrete or continuous (color coded: blue fields

are discrete and green fields are continuous).

Dimensions are qualitative, meaning they can't be measured but are instead described.
Dimensions are often things like city or country, eye color, category, team name, etc.
Dimensions are usually discrete.

Measures are quantitative, meaning they can be measured and recorded with numbers.
Measures can be things like sales, height, clicks, etc. In Tableau Desktop, measures are
automatically aggregated; the default aggregation is SUM. Measures are usually
continuous.

Discrete means individually separate or distinct. Toyota is distinct from Mazda. In
Tableau Desktop, discrete values come into the view as a label and they create panes.

Continuous means forming an unbroken, continuous whole. 7 is followed by 8 and then
it's the same distance to 9, and 7.5 would fall midway between 7 and 8. In Tableau
Desktop, continuous values come into the view as an axis.

Dimensions are usually discrete, and measures are usually continuous. However, this is
not always the case. Dates can be either discrete or continuous.

« Dates are dimensions and automatically come into the view as discrete (aka date
parts, such as "August", which considers the month of August without considering
other information like the year). Atrend line applied to a timeline with discrete
dates will be broken into multiple trend lines, one per pane.

« We can chose to use continuous dates if preferred (aka date truncations, such as
"August 2017", which is different than "August 2018"). Atrend line applied to a
timeline with continuous dates will have a single trend line for the entire date axis.

Tip: For more information, see the training video Understanding Pill Types or Dimensions and

Measures, Blue and Green in the Help.

In Tableau Prep, no distinction is made for dimensions or measures. Understanding the

concepts behind discrete or continuous are important, however, for things like understanding

the detail versus summary presentation of data in the profile pane.
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o Detail: the detail view shows every domain element as a discrete label and has a visual
scrollbar to provide a visual overview of all the data.

o Summary: the summary view shows the values as binned on a continuous axis as a
histogram.

Binning & Histograms

Afield like age or salary is considered continuous. There is a relationship between the age 34
and 35, and 34 is as far from 35 as 35 is from 36. However, once we're past age 10 or so, we
usually stop saying things like we're "9 and a half" or "7 and %". We’re already binning our age
to neat year-sized increments. Someone who is 12,850 days old is older than someone who is
12,790 days old, but we draw a line and say they're both 35. Similarly, age groupings are often
used in place of actual ages. Child prices for movie tickets might be for kids 12 and under, or a
survey may ask you to select your age group, such as 20-24, 25-30, etc.

Histograms are used to visualize the distribution of numerical data using binning. A histogram is
similar to a bar chart, but rather than being discrete categories per bar, the rectangles making
up the histogram span a bin of a continuous axis, such as range of the number of blossoms (0-
4,5-9, 10-14, etc.). The height of the rectangles is determined by frequency or count of those
values. Here, the y-axis is the count of plants that fall into each bin. Seven plants have 0-4
blossoms, two plants have 5-9 blossoms, and 43 plants have 20-24 blossoms.
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Distribution of Blossoms

Number of blossoms
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In Tableau Prep, the summary view is a histogram of binned values. The detail view shows the
frequency for every value and has a visual scrollbar off to the side that shows the overall
distribution of the data.

Summary view Detail view
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Distributions and outliers

Seeing the distribution of a data set can help with outlier detection.

 Distribution: the shape of the data in a histogram, though this depends on the size of the
bins. Being able to see all your data in a histogram view can help identify if the data
seems correct and complete. The shape of the distribution will only be of use if you know
the data and can interpret whether or not the distribution makes sense.

o Forexample, if we were to look at a data set of the number of homes with
broadband internet from 1940-2017, we'd expect to see a very skewed
distribution. However, if we were to look at the number of homes with broadband
internet from January 2017 to December 2017 we'd expect a fairly uniform
distribution.

« Ifwe were to look at a data set of Google searches for "Pumpkin Spice Latte", we'd

expect to see a fairly sharp peak in the fall, whereas searches for “"convert Celsius

to Fahrenheit" would likely be fairly stable.

o Outlier: a value that is extreme compared to other values. Outliers may be correct values
or they may be indicative of an error.
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« Some outliers are correct and indicate actual anomalies; these should not be
removed or modified.

« Some outliers indicate issues with data cleanliness, such as a salary of $50
instead of $50,000 because a period was typed instead of the comma.

Visual outlier detection with distributions

If you were to see a list like this:

+
Field =

11
24
33
58

atfirst glance it doesn't look odd. But if, instead of a list of labels, this was plotted on a
continuous binned axis, it would look like this:
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Eis
Field =

20
40
60

a0

1040

And it's much more obvious that the last observation is farther away from the first and may be
an outlier due to error.

Data Types

Databases, unlike spreadsheets, usually enforce strict rules on data types. Data types classify
the data in a given field and provide information about how the data should be formatted,
interpreted, and what operations can be done to that data. For example, numerical fields can
have mathematical operations applied to them and geographic fields can be mapped.

Tableau Desktop assigns whether a field is a dimension or measure, but fields have other
characteristics that depend on their data type. These are indicated by the icon each field has
(though some types share anicon). Tableau Prep uses the same data types. If data type is
enforced on a column and an existing value doesn't match its assigned data type, it may be
displayed as null (because "purple" doesn't mean anything as a number).

Some functions require specific data types. For example, you cannot use CONTAINS with a
numerical field. Type functions are used to change the data type of a field. For example,
DATEPARSE can take a text date in a specific format and make it a date, thus enabling things
like automatic drill down in the view.
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Icon | Data type
Text (string) values
Abc
Date values
B
Date & Time values
i
Numerical values
3+
| Boolean values (relational only)
TIF
P Geographic values (used with maps)

Tip: For more information, refer to the Help article on Data Types.

Pivot and Unpivot Data

People-friendly data is often captured and recorded in a wide format, with many columns.

Machine-readable data, like Tableau prefers, is better in a tall format, with fewer columns and

more rows.

Note: Traditionally, pivoting data means going from tall to wide (columns to rows), and

unpivoting means going from wide to tall (rows to columns). However, Tableau uses the

word pivot to mean going from wide (people-friendly) to tall (machine-readable) by

turning rows into columns. In this document, pivot will be refer to the Tableau sense of

the word. For clarity, it can help to specify "pivot columns to rows" or "pivot rows to

columns".

For more information, refer to the Help articles Pivot Your Data and Tips for Working

with your Data.
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Wide data

In the WHO malaria data set, there is a column for country, then a column per year. Each cell

represents the number of cases of malaria for that country and year. In this format we have 108

rows and 16 columns.

A B c

1 Country 2014 am3
2 Afghanistan 61362 39263
i Algeria 1] o
4 Angola 2298975 1995868
5 Argentina 0 0
& Armenia

7 Arerbaijan ] o
4 Bahamas

9 Bangladesh 10216 3864
10 Balize 13 0
11 Benin 1044235 1078334
12 Bhutan % i3
13 Bolivia (Plurinatic Ta01 742
14 Botswana 1346 456
15 Braxil 133415 177767
16 Burkina Fasa 428653 3765051
17 st A%59RITI ARz

o
01z
54840
55
1496824

F301
5839
7415
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242758
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E
11
TT5a8
1
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o
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13769
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63580
0
1573422

H

81578

EF]
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315746
36514
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| ] K

09 008 00T 0 W06 X005 200

92202 86129 116444 242022

7 1 2 3
1533485 1082398 283672

387 1z 252 115

) o 7 47

108 143 242 386

] 48 1 2

59866 3Z85T 45121 58534
4% a1 1545 1066

] 1868 1825 Fon]
las10 19735 21442 la310
280 &1 198
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44246 265 1335 18256
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&40

1526
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It's easy for a person to read and understand this format. However, if we were to bring this data

into Tableau Desktop, we get a field per column. We have a field for 2000, a field for 2001, a

field for 2002, etc.

To think of it another way, there are 15 fields that all represent the same basic thing—number of

reported cases of malaria—and no single field for time. This makes it very hard to do analysis

across time as the data is stored in separate fields.

Example: working with wide data

Q: How would we create a map that shows the total number of malaria cases per country from

2000to0 20147

A: Create a calculated field to sum all the years.
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Note: this image has not been updated to reflect the most current Ul. The Data pane no longer shows
Dimensions and Measures as labels.

Another indication that this format isn't ideal for analysis can be seen in the fact that nowhere
do we have information about what the actual values mean. For Algeria in 2012, we have the
value 55. Fifty five what? It's not clear from the structure of the data.

A E C D E
1 | Country 2014 2013 2012 2011
2 |Afghanistan 61362 39263 54840 77549
3 |Algeria 0 ﬂl 55_' 1
4 |Angola 2298979 1999868 1496834 1632282

If the name of the column isn't describing what the values are but rather conveys additional
information, this is a sign the data needs to be pivoted.

Tall data

If we pivot the data, we reshape the data from wide to tall. Now, rather than having a column for
each year, we have a single column, Year, and a new column, Reported Cases. In this format
we have 1,606 rows and 3 columns. This data format is taller rather than wider.
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A B C

1 |Country Year Reported Cases
2 |Afghanistan 2000 94,475
3 |Afghanistan 2001

4 |Afghanistan 2002 415,356
5 |Afghanistan 2003 360,940
& |Afghanistan 2004 242,022
7 |Afghanistan 2005 116,444
g |Afghanistan 2006 86,129
§ |Afghanistan 2007 92,202
10 |Afghanistan 2008 81,574
11 |Afghanistan 2009 54,880
12 |Afghanistan 2010 69,397
13 |Afghanistan 2011 77,549
14 |Afghanistan 2012 54,840
15 |Afghanistan 2013 39,263
A= | A Ferl i A [t B 1= |

Now in Tableau Desktop, we have a field for Year and a field for Reported Cases as well as the
original Country field. It's much easier to do analysis because each field represents a unique
quality about the data set—location, time, and value.

4k

Data Analytics

H Malaria - WHO (Malaria ...

Dimensions E D | -
@ Country
H#  Year

Abe  Measure Names

Measures

+# HReported Cases

& Lafifude (generated)
@ Longifude (generated)
= Numberof Records

H#  Measure Values

Note: this image has not been updated to reflect the most current Ul. The Data pane no longer shows
Dimensions and Measures as labels.

Example: working with tall data
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Q: How would we create a map that shows the total number of malaria cases per country from
2000 to 20147

A: Use the Reported Cases field.

N g G- - P ER- B ! £~ T & P ER=R = ShowMe
Data  Analylics  *  Pages il Cohumns

Dimensions e«

@ Country o Sheat 2

# Wear

Ave  Measure Names

Measures. Marks

Note: this image has not been updated to reflect the most current Ul. The Data pane no longer shows
Dimensions and Measures as labels.

Now it's easy to see that for Algeria in 2012, the 55 refers to the number of reported cases

(because we could label this new column).

A E C
1 |Country Year Reported Cases
28 |Algeria 2011 1
29 |algeria 2012 55
30 | Algeria 2013 o

Note: In this example, the wide data consisted of a single record per country. With the
tall data format, there are now 15 rows for each country (one for each of the 15 years in
the data). It's important to keep in mind that there are now multiple rows per country.

If there was a column for Land Area, that value would be repeated for each of the 15

rows for each country in a tall data structure. If you created a bar chart by bringing out
Country to Rows and Land Area to Columns, by default the view would sum the land
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area for all 15 rows per country.

For some fields it may be necessary to compensate for double counting values by
aggregating with an average or minimum rather than sum or filtering.

Normalization

Relational databases are made up of multiple tables that can be related or linked together in
some way. Each table contains a unique identifier, or key, per record. By relating or joining on
the keys, records can be linked to provide more information than is contained in a single table.
What information goes into each table is dependent on the data model used, but the general
principle is around reducing duplication.

For example, consider event planning for an event like a wedding. We need to keep track of
information at the level of groups (such as families or couples) as well as the level of individuals.

Atable could be created that combines all the information together:

ID Name Group Dietary Seating Attending Address Invitation Gift Bride
10 Cedar Tree Omnivare 1 yes B7 Forest Ave  sent pebble  yes
11 Redwood Tree Omnivore 1 yes 87 Forest Ave  sent pebble  yes
12 Fir Tree Vegan 1 yes B7 Forest Ave  sent pebble  yes
13 Madrona Tree Omnivore no 87 Forest Ave  sent pebble  yes
14 Chanterelle Mushroom Omnivare 2 yes 3 Troll 5t sent leaf no

15 Cremini Mushroom  Kosher 2 yes 3 Troll 5t sent leaf no

16 Portobello  Mushroom Omnivore 2 yes 3 Troll 5t sent leaf no

17 Hydrangea  Flower 652 Meadow Ln undeliverable yes
18 Dahlia Flower 652 Meadow Ln undeliverable yes

However, if an address is incorrect and needs to be fixed, it must be fixed across multiple rows,
potentially leading to errors or conflicts. A better structure is to create two tables, one for
information that pertains to the group (such as address and if the invitation was sent) and one
for information pertaining to the individuals (for things like seating assignments and dietary
restrictions).

Group table Individual table
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ID Group Address Invitation Gift Rride

34 Tree 27 Forest Ave  sent ID Name Group Dietary Seating Attending

35 Mushroom 3 Troll 5t sent 10 Cedar Tree Omnivore 1 ¥es

36 Flower 652 Meadow Ln undeliverable 11 Redwood Tree Omnivore 1 ¥es
12 Fir Tree Vegan 1 yes
13 Madrona Tree Omnivore nao
14 Chanterelle Mushroom Omnivore 2 yes
15 Cremini Mushroom Kosher 2 yes
16 Portobello Mushroom Omnivore 2 yes
17 Hydrangea Flower
18 Dahlia Flower

It's much easier to track and analyze group-level information in the group table and individual-
level information in the individual table. For example, the number of chairs needed can be
obtained from the number of Attending = Yes records in the individual table, and the number of
stamps needed for thank-yous can be obtained from the number of records in the group table
where Giftisn't null.

The process of breaking up all the data into multiple tables—and figuring out which table
contains which columns—is called normalization. Normalization helps reduce redundant data
and simplifies the organization of the database.

However, there may be times when information is needed that spans multiple tables. For
example, what if we wanted to balance seating arrangements (individuals) such that groups
from the bride's side are intermingled with groups from the groom's side? (The bridge or
groom affiliation is tracked at the group level.) To achieve this, we need to relate the tables
back together so the individuals are associated with information about their group. Proper
normalization isn't just breaking up tables, it also requires the presence of a shared, related
field or unique identifier than can be used to combine the data back together again. Here, that
related field is Group. That field is present in both tables, so we can join on this field and return
to our original, single table format. This is a denormalized structure.

So why didn't we just keep the original denormalized table? It is harder to maintain and was
storing redundant information. At scale, the level of data duplication can be come massive.
Storing the same information over and over isn't efficient.

Normalized tables have a few key properties:

« Each row needs a unique identifier

o Each table needs a column or columns that can be used to connect it back to other
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tables (key).

These shared (key) columns are used for relating or joining tables back together. For our data,

the relationship or join clause would be on the Group field in each table.

Join Types

Although the default method for combing data in Tableau Desktop is relating, there are cases
when you may want to join tables in Tableau Desktop or Tableau Prep Builder. For a basic

overview of joins and join types, see

Mame # of Sibling=s
Taular 2
Alex 3
Shannon ]
Tracy 1
Inner Join

Mame # of Siblings| Ewe Color
Taular 2 Blue
Blex 3 Brown
Left Join

Mame # of Siblings | Ewe Color
Taulor zZ Elue
Blex 3 Brown
Shannon 1] el
Tracy 1 el
Right Join

Mame Eye Color | # of Siblings
Taulor Elus Z
Blex Brown 3
Margan Brown el
Outer Join

Name # of Siblings | Eye Color
Taulor 2 Elue
Alex 3 Brown
Shannon ] el
Tracy 1 el
Morgan ol Brown

"Tidy" Data

Hadley Wickham published an article in 2014 in the Journal of Statistical Software called "Tidy
Data" (August 2014, Volume 59, Issue 10). This article does an excellent job of laying out a

Tableau Software

Name Eye Color
Taular Blue
Bl Erown
Margan Erown
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framework for data that is well-structured for analysis. The article can be found here (Hadley
Wickham's Academic Portfolio) or here (hosted by r-project.org).

Note: The article is hosted on external websites. Tableau cannot take responsibility for
the accuracy or freshness of pages maintained by external providers. Contact the
owners if you have questions regarding their content.

Find Good Data Sets

A good way to learn how to use Tableau Desktop (or build sample or proof-of-concept content)
is to find a data set you find interesting. When you have genuine questions you want to answer
with data, the steps of the analysis becomes easier and more meaningful.

The reality of data sets

There are two unavoidable facts about trying to find a data set that’s not official, business-
sanctioned data.

You won’t find what you’re looking for.

« Tryto avoid an overly specific preconceived notion of what you want.
« Stay flexible and open minded about what you can use for a given project.
« Sometimes the data you want is behind a paywall—decide if it's worth it or not.

You will have to clean up the data.

o Be prepared for basic cleaning and shaping to make sure the data is well structured for
analysis

e You may need to bring in additional data sets.

« Having a data dictionary or metadata can be vital.

o Calculations may be necessary.

What makes a good data set

A good data set is one that suits your purpose. As long as that need is met, it's a good data set.
However, there are some considerations that can help you weed out data sets that are unlikely
to suit your purpose. On the whole, look for data sets that meet the following conditions:

1. Contains the elements you need
2. Isdisaggregated data
3. Has atleast a couple dimensions and a couple measures
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4. Has good metadata or a data dictionary
5. Isuseable (notin a proprietary format, too messy, or too cumbersome)

What makes Superstore super?

Superstore is one of the sample data sources that come with Tableau Desktop. Why is it such a
good data set?

» Necessary elements: Superstore has dates, geographic data, fields with a hierarchy
relationship (Category, Sub-Category, Product), measures that are positive and negative
(Profit), etc. There are very few chart types you can't make with Superstore alone, and
very few features it can't be used to demonstrate.

» Disaggregated: The row-level data is each item in a transaction. Those items can be
rolled up to the order level (via Order ID) or by any of the dimensions (such as date, cus-
tomer, region, etc.)

« Dimensions and measures: Superstore has several dimensions allowing us to "slice
and dice" by things like category or city. There are also multiple measures and dates,
which opens the possibilities for chart types and calculations.

o Metadata: Superstore has well named fields and values. You don’t need to look up what
any values mean.

o Small and clean: Superstore is only a few megabytes so it takes up very little room in
the Tableau installer. It's also very tidy data, with only the correct values in each field and
a good data structure.

1. A good data set has the elements you need for your purposes

If you're looking for a data set to build a specific visualization or to showcase specific
functionalities, make sure the data set has the types of fields you need. For example, maps are
a great visual but require geographic data. Basic demos often involve drilling down into dates,
so the data would need at least one date field (and it would need to be more granular than just
year to show drill down). Not all data sets need all these elements—know what you need for
your purpose and don't waste time with data sets that are missing key elements.

Common elements for analysis:

o Dates
« Geographic data
o Hierarchical data
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« “Interesting” measures—either substantial variation in magnitude or positive and neg-
ative values

Some features or viz types may require specific characteristics of the data such as:

o Clusters

« Forecasting

o Trendlines

o Userfilters

o Spatial calculations
« Certain calculations
o Bulletcharts

« Control charts

2. A good data set is disaggregated (raw) data

If the data is too aggregated, there isn't much you can do for analysis. For example, if you want
to look at trends in people Googling "Pumpkin Spice" but have yearly data, you can only look at
a very high level overview. Ideally you want to get your hands on daily data, so you could see
the huge spike when Starbucks starts offering #PSL.

What counts as disaggregated can vary by analysis. Note that due to privacy or practicality,
some data sets will never be more granular than a certain level. For example, you would be
unlikely to find a data set with case-by-case reporting of malaria cases, so monthly totals by
region might be granular enough.

Aggregation and granularity

Understanding aggregation and granularity is a critical concept for many reasons; itimpacts
things like finding useful data sets, building the visualization you want, combining data
correctly, and using LOD expressions. Aggregation and granularity are opposite ends of a
spectrum.

Aggregation refers to how the data is combined together, such as summing all the searches
for Pumpkin Spice or taking the average of all the temperature readings around Seattle on a
given day.

« By default, measures in Tableau are aggregated. The default aggregation is SUM. You
can change the aggregation to things like Average, Median, Count Distinct, Minimum,
etc.
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Granularity refers to how detailed the data is. What does a row (aka record) in the data set
represent? A person with malaria? A provinces' total cases of malaria for the month? That's the
granularity. Knowing the granularity of the data is crucial to working with LOD (level of detail)
expressions.

For more information, see the Free Training Video on aggregation and granularity or the Help
topic Data Aggregation in Tableau on page 341.

3. A good data set has dimensions and measures

Many visualization types require dimensions and measures

« If you only have dimensions, you're mostly limited to counting, calculating percentages,
or using the Number of Records field.

« Ifyou only have measures, you can't break out the values by anything. You can dis-
aggregate the data entirely or work with the overall SUM or AVG, etc.

Which isn't to say a data set with only dimensions can't be useful. Demographic data is an
example of dimension-heavy data, and much analysis around demographics is counting or
percentage-based. But for a more analytically rich data set, you want at least a few dimensions
and measures.

Dimensions and Measures, Discrete and Continuous
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Dimensions E DL
B Continuous Date ML
B Discrete Date
abc Discrete Dimension O Automatic ®
& Geographic field i: (5_-)
v g Hierarchy Color Size Label
Abe Lewvell
sbe  Level? i ~
- Detail Tooltip
H# MNumeric Dimension
abe  Measure Names a0 YEAR(Continuous Date)
& —— el YEAR(Discrete Date)
3. EonlinuonsMeasure WM Discrete Dimension
4 Discrete Measure BM Geographic field
@ Latitude (generated) ala Level 1
@& Longitude (generated) B8  Mumeric Dimension
=  Number of Records B SUM(Continuous Measure)
#  Measure Values M SUM(Discrete Measure)
B SUM(Number of Records)

In the image above, note that the Numeric Dimension does not have an aggregation on the Marks card,
unlike both the Continuous Measure and Discrete Measure.

Dimensions and Measures

Fields are broken out into dimensions and measures in the data pane. In Tableau, dimensions
come out into the view as themselves, whereas measures are automatically aggregated; the
default aggregation for a measure is SUM.

« Dimensions are qualitative, meaning they are described, not measured.
« Dimensions are often things like city or country, eye color, category, team name,
etc.
« Dimensions are usually discrete.
o Measures are quantitative, meaning they can be measured and recorded (numeric).
« Measures are often things like sales, height, number of clicks, etc.
o Measures are usually continuous.

If you could do math with a field, it should be a measure. If you're ever not sure if a field should
be a measure or a dimension, think about if you can do meaningful math with the values. Is
there any meaning to AVG(RowID), the sum of two Social Security numbers, or dividing a
postal code by 10?7 No. Those are dimensions that happen to be written as numbers. Think

306 Version: 2021.2 Tableau Software



Tableau Desktop and Web Authoring Help

about how many countries have alphanumeric postal codes—they're just labels, even though in
the US they're only numeric. Tableau can recognize many field names that indicate a numeric
field is actually an ID or a postal code and tries to make those dimensions, but it's not perfect.
Use the "could | do math with this?" test to decide if a numeric field should be a measure or
dimension and rearrange the data pane as necessary.

Note: Although you can do math with dates (such as the DATEDIFF calculation), the
standard convention is to categorize dates as dimensions.

Discrete and Continuous

Discrete or Continuous fields are somewhat aligned with the concepts of dimension and
measure, but they’re not identical.

» Discrete fields contain distinct values. They make headers or labels in the view and the
pills are blue

o Continuous fields “form an unbroken whole”. They make an axis in the view and the pills
are green

A good way of understanding discrete and continuous is to look at a date field. Dates can be
either discrete OR continuous.

o Looking at average temperatures in August across a decade or century means “August”
is being used as a discrete, qualitative date part.

o Looking at the overall trend in reported malaria cases since 1960 would take a single,
unbroken axis, meaning the date is being used as a continuous, quantitative value.

For more information, see the Free Training Video on Understanding Pill Types, or the Help
topic Dimensions and Measures, Blue and Green on page 314.

Fields Created by Tableau

Tableau will automatically create three fields, no matter what the data set is:

o Measure Names (a dimension)
o Measure Values (a measure)
o Number of Records (a measure)

And if there are geographic fields in the data set, Tableau will also create Latitude
(generated) and Longitude (generated) fields.
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Measure Names and Measure Values are two extremely useful fields. For more
information, see the Free Training Video or the Help topic Measure Values and Measure
Names on page 1310.

Number of Records is a field that basically assigns a “1” to every row in the data set. This
enables you to have at least one measure in your data set and can help with some analysis.
You must understand the granularity of your data (what a row represents) to be able to define
what the number of records means.

Here, each row is a day, so the number of records would be the number of days:

Date Max TemperatureF Mean TemperatureF Min TemperatureF
1/1/2015 42 34 26
1/2/2015 42 37 32
1/3/2015 41 38 35
1/4/2015 51 45 38
1/5/2015 54 52 49
1/6/2015 54 49 43
1/7/2015 46 44 42
1/8/2015 46 41 35
1/9/2015 50 L 38

1/10/2015 46 45 43

Here, each row is a month, so the number of records would be the number of months:

Date Max TemperatureF  Mean TemperatureF  Min TemperatureF

January 63 45 26
February 62 49 33
March 69 51 31
April 77 52 37
May 82 59 43
June 92 68 43
July 95 71 54
August 92 69 54
September 81 61 45
October 74 58 45
Movember 60 44 25

308 Version: 2021.2 Tableau Software


https://www.tableau.com/learn/tutorials/on-demand/measure-names-and-measure-values

Tableau Desktop and Web Authoring Help

4. A good data set has metadata or a data dictionary

A data set can only be useful if you know what the data is. There are few things more frustrating
in the hunt for good data than opening a file that looks like this:

Diet Source Donor Collection Sex oTuo OTUl oTu2 oTu3 oTu4a

4 ] 7.38E-14 9.05E-11 8.22E-11 3.86E-11 B8.25E-11
12 1.54E-13 5.67E-11 3.12E-11 B8.52E-11 1.73E-11
4 5.52E-13 3.46E-11 0.00077 4.76E-11 9.80E-11
4 5.69E-13 2.73E-11 B.0BE-11 9.94E-11 5.90E-12
4 897E-13 B.33E-11 0.000274 B3.49E-11 5.38E-11
4 943E-13 6.21FE-11 1.41F-11 6.32E-11 9.17E-11
11 1.13E-12 1.85E-11 9S.04E-11 4.09E-11 5.31E-11
4 1.49E-12 7.86E-12 B.87E-11 3.4BE-11 B8.16E-11
] 1.63E-12 4.42E-11 9.12E-11 B8.53E-11 9.40E-12

e = = R R =]
[ TR o T e R o TR U Y o B U P o
= o o0 o oo oo
oo Do o ok o o o

What does a Source of 4 or 12 mean? And what information is in the fields OTU0-OTU47?

A good data set is one that has either well-labeled fields and members or a data dictionary so
you can relabel the data yourself. Think of Superstore—it's immediately obvious what the fields
and their values are, such as Category and its members Technology, Furniture, and Office
Supplies. Or, for the microbiome data set in the image above, there is a data dictionary which
explains each Source (4 is feces and 12 is stomach) and the taxonomy of each OTU (OTU3 is a
bacterium of the genus Parabacteroides).

Data dictionaries can also be called metadata, indicators, variable definitions, glossaries, or any
number of other things. At the end of the day, a data dictionary provides information about
column names and members in a column. That information can be brought into the data source
or viz in several ways, including:

« Rename the columns so they are easier to understand (this can be done in the data set
itself or in Tableau).

« Re-alias the members of the field (this can be done in the data set itself or in Tableau).

o Create calculations to add the data dictionary information.

« Commenton the field in Tableau (comments do not appear on published vizzes, only in
the authoring environment).

o Use the data dictionary as another data source and combine the two data sources.

Losing a data dictionary can render a data set useless. If you're bookmarking a data set,
bookmark the data dictionary, too. If you're downloading, download both and keep them in the
same place.
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5. A good data set is one you can use

As long as you can understand the data set and it has the information you need, even a small
data set can pack a punch for analysis. Smaller data sets are also easy to store, share, and
publish, and are likely to perform well.

Similarly, even if you find the “perfect” data set for your needs, if it requires an unrealistic
amount of effort to clean up, it's not perfect after all. Knowing when to walk away from a data
set thatis too messy is important.

For example, this data set is from a Wikipedia article on relative letter frequencies. It started as
84 rows and 16 columns (pivoted to be 1,245 rows and 3 columns). The Excel file is 16KB. But
with some groups, sets, calculations, and other manipulations, it enables robust analysis and
interesting visuals.

B Ui o a ingle Baegunge

Click the image to download the workbook.
Relabel your data

Once you find a good data set, you'll often need to relabel it. Relabeling data can be useful to
either create fake data for samples or proof-of-concepts, or to make the data more readable.

Renaming a field changes how that field appears in Tableau, such as renaming “Sales” to
“Pipeline Sales” or “State” to “Province”.

Re-aliasing changes how the members of a field are displayed, such as re-aliasing values in a
Country field so that CHN becomes China and RUS becomes Russia.
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e The values in a discrete dimension field are called members. Only members can be re-
aliased. Consider a measure field for temperature. A value of 54°F can’t be changed
without changing data itself. But re-aliasing the member “CHN” as “China” in a Country
field is the same information, just labeled in another way.

Renaming and re-aliasing mean almost the same thing. It’s the convention in Tableau that fields
are named and members are aliased. For more information, see Organize and Customize
Fields in the Data Pane on page 1146 and Create Aliases to Rename Members in the
View on page 1161.

Note: Renaming or re-aliasing only changes the appearance in Tableau Desktop; no
changes are written back to the underlying data.

Relabel to make fake data

Relabeling existing data sets is a great way to make samples or proof-of-concept content more
compelling.

1. Use an easy data set (like Superstore) to build what you want (a specific chart type, show-
ing off certain functionality, etc.)

2. Rename the relevant fields, change tooltips, and otherwise change the textual aspects to
mask what the data actually represents.

Important: Only do this when it’s clear the information is fake. Be careful that people don’t think
it's real data and try to use it for analysis. For example, use silly names or meaningless field
names like colors or animals.

Re-alias to make the data easier to use

It's more efficient to store the data as numeric values rather than string values, though numeric
encoding can make the data harder to understand. For small data sets it probably won't make a
performance impact, so prioritize being able to understand the data easily.

A downside to re-aliasing is that you no longer have access to those numeric values (making it
harder to do things like sort, assign color gradients, etc.). Consider duplicating the field and re-
aliasing the copy. Alternatively, a calculation in Tableau can be a good way to preserve the
original information while also making it more easily understandable.
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Re-alias with the CASE function

Calculations can be very powerful for re-aliasing. For example, CASE functions allow you to
say, essentially, "when this field has a value of A, give me X. When the value is B, give me Y".

Here, the CASE function looks at the F-scale in a tornado data set and provides the written
description associated with each numeric value:

CASE [F-scale]

WHEN "O" THEN "Some damage to chimneys; branches broken off
trees; shallow-rooted trees pushed over; sign boards damaged."
WHEN "1" THEN "The lower limit is the beginning of hurricane wind
speed; peels surface off roofs; mobile homes pushed off
foundations or overturned; moving autos pushed off the roads..."
WHEN "2" THEN "Roofs torn off frame houses; mobile homes
demolished; boxcars overturned; large trees snapped or uprooted;
highrise windows broken and blown in; light-object missiles
generated."

WHEN "3" THEN "Roofs and some walls torn off well-constructed
houses; trains overturned; most trees in forest uprooted; heavy
cars lifted off the ground and thrown."

WHEN "4" THEN "Well-constructed houses leveled; structures with
weak foundations blown away some distance; cars thrown and large
missiles generated."

WHEN "5" THEN "Strong frame houses lifted off foundations and
carried considerable distances to disintegrate; ... trees
debarked; steel reinforced concrete structures badly damaged."
END

Now we can chose to use either the original "F-scale" field (0-5) or the "F-scale damage
description” field in the viz.

Tips when looking for data sets

Note: Try to make sure you can answer the question "What does a row (aka record) in
the data set represent?" If you can't articulate that, you might not understand the data
well enough to be able to use it or it might be structured poorly for analysis.
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o Keep track of where the data came from.
« Keep the data dictionary information with the data itself.
« Avoid stale data if you need the content to stay evergreen. Look for:
o updatable data (stocks, weather, regularly published reports, etc.)
« timeless data (the average mass of various animals isn’t going to change from
year to year)
« data you can future-proof by artificially changing to historical or future dates
o Trysimply Googling what you're looking for, you might be surprised.
« Don’t be afraid to give up on a data set if it's too much work to prep.

Places to look for data

Where can you look for data? There are a potentially overwhelming number of places to find
data sets. Here are some options to get you started. Note that the reality of data sets does apply
to these sites—you probably won’t find what you’re thinking of right now, and you will most likely
need to do some cleaning to get the data ready for analysis.

Disclaimer: Although we make every effort to ensure these links to external websites are
accurate, up to date, and relevant, Tableau cannot take responsibility for the accuracy or
freshness of pages maintained by external providers. Listing a site here is not an
endorsement of any content or organization. Contact the external site for answers to
qguestions regarding its content.

Tableau Public: Tableau Public is an amazing resource for Tableau-friendly data sets. Search
for workbooks that are on a topic you’re interested in, browse for inspiration, then download the
workbook to access the data. Or check out the curated Sample Data.

Wikipedia tables: Get data out of Wikipedia tables by: copying and pasting into a spreadsheet,
copying and pasting directly into Tableau, or using Google sheets and the IMPORTHTML
function to create a Google spreadsheet of the data.

Google Dataset Search: "A search engine to unite the fragmented world of online datasets."
Data is Plural : Subscribe for a weekly newsletter with data sets, or browse the archive.

Makeover Monday: “Join us every Monday to work with a given data set and create better, more
effective visualizations and help us make information more accessible.” You can see what other
people have done with the same data set, kickstarting your analysis or giving inspiration. Use
#makeovermonday on Twitter to participate.

Other sites
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o Tableau Web Data Connectors

« Data.world and its WDC for Tableau
o Github Open Data

» Kaggle

o datahub.io

« r/datasets

« WHO

» Data.UN.org

+ WorldBank

» data.gov, data.gov.au, data.gov.za, data.gov.uk, etc.
o Airbnb

e Yelp

e Zillow

Dimensions and Measures, Blue and Green

When you connect to a new data source, Tableau assigns each field in the data source as
dimension or measure in the Data pane, depending on the type of data the field contains. You
use these fields to build views of your data.

Watch a Video: To see related concepts demonstrated in Tableau, watch
Understanding Pill Types, a 5-minute free training video. Use your tableau.com account
to signin.

About data field roles and types

Data fields are made from the columns in your data source. Each field is automatically
assigned a data type (such as integer, string, date), and a role: Discrete Dimension or
Continuous Measure (more common), or Continuous Dimension or Discrete Measure (less
common).

o Dimensions contain qualitative values (such as names, dates, or geographical data).
You can use dimensions to categorize, segment, and reveal the details in your data.
Dimensions affect the level of detail in the view.

o Measures contain numeric, quantitative values that you can measure. Measures can be
aggregated. When you drag a measure into the view, Tableau applies an aggregation to
that measure (by default).
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Blue versus green fields

Tableau represents data differently in the view depending on whether the field is discrete (blue),
or continuous (green). Continuous and discrete are mathematical terms. Continuous means
"forming an unbroken whole, without interruption"; discrete means "individually separate and
distinct."

. Green measures SUM(Profit) and dimensions YEAR(Order Date) are

continuous. Continuous field values are treated as an infinite range. Generally,
continuous fields add axes to the view.

. Blue measures i) and dimensions kb are

discrete. Discrete values are treated as finite. Generally, discrete fields add headers to
the view.

Possible combinations of fields in Tableau

This table shows examples of what the different fields look like in the view. People sometimes
call these fields "pills", but we refer to them as "fields" in Tableau help documentation.

Discrete Dimensions
Product Name

Continuous Dimensions (dimensions with a data type of String

or Boolean cannot be continuous) He by S|

Discrete Measures
SUM(Profit)

Continuous Measures
SUM(Profit)

Note: With a cube (multidimensional) data source, the options for changing data roles
are limited. In Tableau Desktop, cubes are supported only on Windows.) You can change
some measures from continuous to discrete, but in general, you cannot change data
roles for fields in cube data sources. For related details, see Cube Data Sources on
page 1085.
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A visual cue that helps you know when a field is a measure is that the field is aggregated with a
function, which is indicated with an abbreviation for the aggregation in the field name, such as:

. To learn more about aggregation, see List of Predefined

Aggregations in Tableau on page 345 and Aggregate Functions in Tableau on
page 2192.

But there are exceptions:

« Ifthe entire view is disaggregated, then by definition no field in the view is aggregated.
For details, see How to Disaggregate Data on page 350.

« Ifyou are using a multidimensional data source, fields are aggregated in the data source
and measures fields in the view do not show that aggregation.

Note: You can set the default aggregation and other properties and settings for fields.
For details on the many ways you can customize the fields in the Data pane, see
Organize and Customize Fields in the Data Pane on page 1146, Edit Default
Settings for Fields on page 1157, and Work with Data Fields in the Data Pane on
page 203.

Examples of continuous and discrete fields used in a view

In the example on the left (below), because the Quantity field is set to Continuous, it creates
a horizontal axis along the bottom of the view. The green background and the axis help you to
see thatit's a continuous field.

In the example on the right, the Quantity field has been set to Discrete. It creates horizontal
headers instead of an axis. The blue background and the horizontal headers help you to see
thatit's discrete.

Continuous Discrete
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i Columns Quantity

= il Columns
= Rows SUM(Sales) QU
= Rows SUM(Sales)
$400,000 Quantity
$350,000 $400,000
$300,000 $350.000
$250,000 $300,000
w
=
i:‘ﬁt
$200,000 $250,000
L' ]
£
o
PR LA
$150.000 $200,000
$100,000 $150,000
$50,000 $100,000
30
} + _, - + . $50,000
0 2 6 8 10 12 1
Quantity 30 l..l.
2 4 65 & 10 12 14

In both examples, the Sales field is set to Continuous. It creates a vertical axis because it
continuous and it's been added to the Rows shelf. If it was on the Columns shelf, it would create
a horizontal axis. The green background and aggregation function (in this case, SUM) help to
indicate that it's a measure.

The absence of an aggregation function in the Quantity field name help to indicate thatit's a
dimension.
Dimension fields in the view

When you drag a discrete dimension field to Rows or Columns, Tableau creates column or
row headers.
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Pages il Columns B Category
= Rows
Filters Category
Furniture Office Supplies Technology <= Column Headers
Abe Abc Abe

Marks

@ Autematic -

$ O O

Color Saze Text

!) (|

In many cases, fields from the Dimension area will initially be discrete when you add them to a
view, with a blue background. Date dimensions and numeric dimensions can be discrete or
continuous, and all measures can be discrete or continuous.

After you drag a dimension to Rows or Columns, you can change the field to a measure just
by clicking the field and choosing Measure. Now the view will contain a continuous axis instead
of column or row headers, and the field's background will become green:

Pages il Columns CNTD{Category)
= Rows
Filters ]
[ Distinct count of Category
IR Continuous Axis
nl Automatic -
i & i
Color Size Labed
ofa L:

Detail | Tooltip

Date dimensions can be discrete or continuous. Dimensions containing strings or Boolean
values cannot be continuous.

Tableau does not aggregate dimensions. For a discussion of the different types of aggregation
Tableau can perform, see List of Predefined Aggregations in Tableau on page 345.

In Tableau queries, dimensions in the view are expressed in SQL as "Group By" clauses.

For details on converting fields between continuous and discrete, see Convert Fields
between Discrete and Continuous on page 1164.
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How dimensions affect the level of detail in the view

The level of detail in a view refers to how granular the data is given the dimension and measure
data in the view.

As you add dimensions to Rows or Columns, the number of marks in the view increases.

To understand why adding dimensions increases the number of marks in the view, do the
following:

1. Drag Segment to Columns.

The status bar at the bottom of the Tableau window shows you that there are now three
marks in the view:

8 Data Source Sheet1

3marks 1row by 3 columns

Those marks just contain placeholder text, Abc, because you are only building the view's
structure at this point.

2. Drag Region to Columns.

Now there are 12 marks. Three values in Segment multiplied by four values in Region is
12.

3. Drag [Ship Date] to Rows.

The total is now 57 marks (three segments by four regions by five years is 60, but there
are three combinations of the dimensions in the view for which there is no data in the data
source).

We could continue adding dimensions to Rows and Columns and observe as the
number of total marks continues to increase. Dragging a dimension to a location on the
Marks card such as Color or Size will also increase the number of marks, though it will not
increase the number of headings in the view. The process of adding dimensions to the
view to increase the number of marks is known as setting the level of detail.

Adding a dimension to any of the following locations in Tableau affects the level of detail:
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FPages jii Columns I I
= Rows I I
Filters
Sheet 1
Drop fie ere
Marks
E Polygon -
.
.
Calor Size Labe
aha Q ~ Orop
etail | | Tooltip| | Path field Drop fie sre

4. The view now contains 57 separate instances of Abc—the view is all structure and no

content. Rectify this by dragging Sales to Text. The view can now be considered

complete:
Pages i Columns
Filters Segment / Region
Consumer Corporate 1
YearofS..  Central East South West| Central East South West | (
2012 $67,133 $75,825 $32,272 $88,207 $19,156 $32.654 $34,163 $34,291
2013 $49,640 $85,683 $49,245 380,654 $29,454 $49,703 $18,033 $38771
Marks 2014 $65,971 $90,947 $52,958 $86,452 $60,234 $53,018 $27,250 $64,290
& Automatic . 2015 $68,976 $97,846 $59,291 $105655 $48,801 $65034 $42440 $87,293
2016 $311 $607  $1,815  $1,913 $352 $1.211
1 & | i 3
Color Size Text
c;a Q

Detail | Tooltip

SUM(Sales)

Notes

« In some cases, adding a measure to the view can increase the number of marks in the
view. For example, if you dropped Sales on Rows in the view above, the number of
marks would be 57. But if you then also dropped Profit on Rows, the number of marks
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would increase to 114. But this is not the same as changing the view's level of detail.

o The number of marks in the view is not guaranteed to correspond to the number you

would get by multiplying the number of dimension values in each of the dimensions that

make up the level of detail. There are multiple reasons why the number of marks could be

lower. To increase the number of marks in this view from 57 to 60 in the view above, right-

click (Control-click on a Mac) on one of the Date headers in the view and the date or bin

headers and choose Show Missing Values. For more information about how to show

missing values, see Show or Hide Missing Values or Empty Rows and Columns

on page 1321.

Year of Ship .. Region

20

20

ACCESSON..

Cantral 23 (118
Keep Only 758
Exclude B11
Hide 765
Crrill Down
Format...
Fotate Label
Show Header
Show Missing Values %'

West

Measure fields in the view

Appl
5
5

When you drag a measure to the view, it is aggregated by default. The type of aggregation will

vary depending on the type of view. You should always check the aggregation and change it if

necessary. For details, see "Change the default aggregation" in Edit Default Settings for

Fields on page 1157. For more details about aggregation, see Data Aggregation in Tableau

on page 341.

When you drag a continuous field from the Data pane to Rows or Columns, Tableau creates a

continuous axis for that field.
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Pages il Columns SUM(Sales)
= Rows E Category
Filters Category

Furniture I
Office Supplies NG
Technology I

Marks 20 £200,000 $400,000 $600,000 $800,000
Sales
nl Automatic -
H- &
Coocll [ REeeBR it Continuous Axis
3o ]
Detal | Toship

If you click the field and change it to Discrete, the values become column headers.

= -/ cotumns
Filters Sales
Category $719,047 $742,000 $836,154 +— Column headers
Furniture $742,000
Office Supplies $719,047
Technolo $836,154
Marks i
Automatic -
tH &
Color Size Text
080 Q
Detail  Tooltip

Tableau continues to aggregate values for the field, because even though the field is now
discrete, itis stilla measure, and Tableau aggregates measures by default.

In cases where Tableau has misclassified a field as a dimension or a measure, possibly
because of the data type, you can convert it and change its role. If a measure contains
numbers that don't need to be aggregated (such as a field that contains date values), you may
want to convert it to be a dimension.

For related details, see Convert a Measure to a Dimension on page 1165.

For details on converting fields between continuous and discrete, see Convert Fields
between Discrete and Continuous on page 1164.
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How continuous and discrete fields change the view

Continuous and discrete are mathematical terms. Continuous means "forming an unbroken
whole, without interruption"; discrete means "individually separate and distinct.”

In Tableau, fields can be either continuous or discrete. When you drag a field from the Data
pane to Columns or Rows, the values are continuous by default and Tableau creates an axis.
When you drag a field from the Data pane to Columns or Rows, the values are discrete by
default and Tableau creates column or row headers.

Continuous fields produce axes

If a field has values that are numbers that can be added, averaged, or otherwise aggregated, it
is added as a measure field in the Data pane when you first connect to a data source. Tableau
is assuming that the values are continuous.

Tableau displays an axis when you drag a continuous field to Rows or Columns. An axis is a
measuring line that shows values between a minimum and a maximum. Rulers and analog
thermometers are examples of physical objects that display axes.

Tableau must be able to show a range of actual and potential values, because in addition to the
initial values in the data source, it is always possible that new values will emerge as you work
with a continuous field in the view.

While there are value labels on a continuous axis (0, 0.5, ... 3.0 in the following image), actual
marks don't have to align with these labels as they would with column headers. For example, in
the following image, the blue bar actually extends to a value of 6.940 on the horizontal axis, not

7.0 exactly.
= Rows
Filters |
Avg. IMDb Rating
Marks. . )
s = Continuous Axis
i & @
Color Size Label
- ]

Detail | Tooltip
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The number of potential values for continuous fields is impossible to anticipate. For example, if
you have a field named Ratings and the initial values are 1, 3, 3.5, 3.6, and 4, that's five
distinct values. But if you drop Ratings on Rows, Tableau automatically aggregates that value
as SUM (which you would then immediately change to AVG, because it's more logical to
average grades than to add them), and that would then create a sixth value (3.02) that didn't
exist until you added the field to the view. And if you then applied a filter that eliminated two of
the initial values, the average would change as well, so that would be yet another value. And
then if you changed the aggregation, ... You get the idea. The number of potential values is, if
not infinite, then certainly immense.

The fact that a field contains numbers does not automatically indicate that those values are
continuous. Postal codes are the classic example: though they are often composed entirely of
numbers, they are actually string values which shouldn't be added or averaged. If Tableau
assigns such a field as a measure to the Data pane, you should drag it to a dimensions area to
change it to a dimension field.

Discrete fields create headers

If a field contains values that are names, dates, or geographical locations—anything other than
numbers—it is added as a dimension field in the Data pane when you first connect to a data
source. Tableau treats the values as discrete.

Tableau creates headers when you drag a discrete field to Columns or Rows. The individual
values for a discrete field become the row or column headings. Because these types of values
are never aggregated, no new field values are created as you work with your view, so there is

no need for an axis.

Discrete versus continuous fields on filters

» When you drop a discrete dimension field on the Filters shelf, Tableau prompts you to
choose which "members" of the discrete field to include in the view.
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Filter [Categ_ E

| General | Wildcard | Condition I Top |

(@ Select from list () Custom wvalue list ) Use all

Enter search text

|| Furniture

Office Supplies

|| Technology

LA || hone | I Exclude

o When you drop a Date field on Filters, the result can be a discrete filter or a continuous
filter. For more information, see Filter dates on page 1417.

« When you drop a continuous measure on Filters, Tableau first prompts you to choose an
aggregation for the filter, and then prompts you to specify how to filter the continuous
range of values.

o When you drop a continuous dimension on Filters (other than a Date), Tableau prompts
you to specify how to filter the continuous range of values.

For more on filtering various types of fields, see Drag dimensions, measures, and date
fields to the Filters shelf on page 1413.

Discrete versus continuous fields on color

When you drop a discrete field on Color in the Marks card, Tableau displays a categorical
palette and assigns a color to each value of the field.

When you drop a continuous field on Color, Tableau displays a quantitative legend with a
continuous range of colors.

For more information about color palettes, see Color Palettes and Effects on page 1394.

Data Types

All fields in a data source have a data type. The data type reflects the kind of information stored
in that field, for example integers (410), dates (1/23/2015) and strings (“Wisconsin”). The data
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type of a field is identified in the Data pane by one of the icons shown below.

Data type icons in Tableau

Icon | Data type
Text (string) values
Abc
Date values
B
Date & Time values
Es
Numerical values
2
| Boolean values (relational only)
TIF
@ Geographic values (used with maps)
- Cluster Group (used with Find Clusters in Data on page 2554)

You can change the data type for a field either on the Data Source page or in the Data pane.

Change the data type for a field in the Data Source page

Sometimes Tableau incorrectly interprets the data type of a field. For example, Tableau might
interpret a field that contains dates as an integer data type, rather than a date data type.

You can change the data type for a field that was part of the original data source (as opposed
to a calculated field created in Tableau) on the Data Source page.
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1. Click the data type icon for the field (as shown in the table above).

2. Choose a new data type from the drop-down list:

Abc -

Mumber (decimal)

Mumber fwhole)

Date & Time
Date
@  String
Boolean
v | Default

Geographic Role  #

Tip: Be sure to change data types before you create an extract. Otherwise, your data
may not be accurate. For example, if a floating-point field in the original data source is
interpreted as an integer by Tableau, and you create your extract before you change the
field's data type, the resulting floating-point field in Tableau will have some of its precision
truncated.

For information on changing data types on the Data Source page, see Data Source Page on
page 188.

Change the data type for a field in the Data pane

To change the data type of a field in the Data pane, click the icon to the left of the field name,
and then choose a new data type from the drop-down list.
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et

State

City

Postal Code

Metro A

@8 el

Mumber (Decimal)
Mumber (Whole)
Date & Time

Date 1

@ String

Geographic Role

Change the data type for a field in the view

To change a field's data type in a view, right-click (control-click on a Mac) the field in the Data
pane, choose Change Data Type, and then select the appropriate data type from the drop-
down list.

Add to Sheet

Duplicate
Rename...

Hide

Aliases...
Create r

Transform k

Convert to Measure

Change Data Type | ¥ Mumber (Decimal)
Geographic Role 4 Mumber (Whole)
Default Properties  * Date & time
Group by * Date

Folders b | @] String

Hierarchy 4 crIlen

Replace References... v Default

Describe...
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Note: Sometimes the data in your database is more precise then Tableau can model.
When you add these values to the view, a precision warning appears in the right corner of
the status bar. See Status Bar Information on page 200.

Mixed data types in data from files

Most columns in a Microsoft Excel, Microsoft Access, or CSV (comma-separated value) file
contain values that are all of the same data type (Booleans, dates, numbers, or text). When you
connect to the file, Tableau creates a field in the appropriate area of the Data pane for each
column. Dates and text values are dimensions, and numbers are measures.

However, files that you connect to might include columns that have a mixture of data types,
such as numbers and text, or numbers and dates. When you connect to the file, the mixed-
value column is mapped to a field with a single data type in Tableau. Therefore, a column that
contains numbers and dates might be mapped as a number data type (making it a measure) or
it might be mapped as a date data type (in which case Tableau treats it as a dimension.)

Tableau determines how to map mixed-value columns to data types by the data types of the
first 10,000 rows in an Excel data source, and the first 1,024 rows in a CSV data source. For
example, if most of the first 10,000 rows are text values, the entire column is mapped to use the
text data type.

Note: Empty cells also create mixed-value columns because their formatting is different
from text, dates, or numbers.

When Tableau determines a data type for each field, if the values in a field don't match that data
type, Tableau handles the field in one of several different ways, depending on the data type. For
example, sometimes Tableau populates those fields with Null values, as shown in the following

table:
Mapped data Treatment of other data types in the field.
type
Text Dates and numbers are treated as text. Nulls are not created.
Dates Textis treated as Null. Anumber is treated as the day in numeric order
from 1/1/1900.
Numbers Textis treated as Null. A date is treated as the number of days since
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Mapped data Treatment of other data types in the field.
type

1/1/1900.
Boolean Text, dates, and numbers are treated as Null.

If using fields that are based on mixed-value columns introduces difficulties when analyzing
your data, you can do one of the following:

o Format empty cells in your underlying data source so that they match the data type of
the column.

o Create a new column that does not contain the mixed values.

Tableau's Order of Operations

The order of operations in Tableau, sometimes called the query pipeline, is the order in which
Tableau performs various actions. Actions are also known as operations. Many operations
apply filters, which means that as you build a view and add filters, those filters always execute
in the order established by the order of operations.

Watch a Video: To see related concepts demonstrated in Tableau, watch
Understanding Tableau's Order of Operations, a 1-hour, free video presentation.

This article includes two scenarios for updating a view to correct problems resulting from the
order of operations: converting a dimension filter to a context filter, and converting a table
calculation to a FIXED level of detail expression.

About the order of operations (aka query pipeline)

Sometimes, you might expect Tableau to execute filters in one order, but the order of
operations dictates that they be executed in a different order, which gives you unexpected
results. When this happens, you can sometimes change the order in which operations are
executed in the pipeline.

The Tableau order of operations includes the following, from top to bottom.
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Extract Filters

A

Data Source Filters

Y

Context Filters

Y

Dimension Filters

Y

Measure Filters

v

Table Calc Filters
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Sets, conditional filters, top N, Fixed LOD

Include/Exclude LOD, data blending

Forecasts, table calcs, clusters, totals

Trend lines, reference lines

Note: In the order of operations, the |atest date filter is global to the workbook, while

context filters apply per worksheet. The latest date is determined just after the workbook

opens for first use, after data source filters, but before context filters. At that point the

date is set, and the latest date preset is used as a dimension filter.

Example 1: Convert a Dimension Filter to a Context Filter

This and the following example use the Sample — Superstore data source provided with

Tableau Desktop.

In this example, the view addresses the following question: Who are the top 10 customers, by

total sales, in New York City?

The view contains two dimension filters, one that you create on the General tab in the Filters

dialog box, and the other on the Top N tab. The problem is that these filters are executing

simultaneously, whereas you would like to general filter to be applied before the top n filter, so

that the top n filter can act on the results as previously filtered by the general filter. The solution

is to redefine one of the filters as a context filter so that a clear order of precedence is

established.

Here are the steps for building this view.
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1. Drag Sales to Columns.
2. Drag City and [Customer Name] to Rows.

3. Drag City from the Data pane again, this time to Filters. On the General tab in the
Filter dialog box, set the filter to show just a single value: New York City. Do this by
clicking None and then choosing New York City.

This creates a general dimension filter.

4. Click the Sort Descending button ( IF ) on the toolbar. Your view now looks like this:

Hig- | & 3 ¢'= Abc [E+ No